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Introduction and Setup

Before we get started learning about Media Composer | First, you might need to download the software and the exercise files. This lesson will walk you through the steps to do that, as well as guiding you through setting up a new Avid Master account.

Duration: 35 Minutes


GOALS


	Get to know more about Media Composer | First

	Understand the format of the checklists in this book

	Learn more information about Avid Link

	Understand the steps it takes to get a Media Composer certification






Course Introduction

Welcome to Media Composer and the Avid Learning Series. This book will introduce you to the power of the Media Composer family and marks your first step toward developing core editing skills. The material in this book covers the basic principles you’ll need to complete a Media Composer | First project, from initial setup to final output.

This course is designed for those who are new to professional video editing. The lessons focus on how Media Composer | First works, making it a perfect introduction to the software for novices. Although this book is not aimed at teaching the theory behind film and television production, the content of this course does provide some background on the craft of editing, making it appropriate for students and others new to the art.

For those interested in gaining official Avid certification, this book is also a valuable introduction for further learning through the Avid Learning Series curriculum.




Becoming Avid Certified

Avid certification is a tangible, industry-recognized credential that can help you advance your career and provide measurable benefits to your employer. When you are Avid certified, you not only accelerate and validate your professional development, but you also improve your productivity and project success. Avid offers programs supporting certification in dedicated focus areas including Media Composer, Sibelius, Pro Tools, Worksurface Operation, and Live Sound. To become certified in Media Composer, you must enroll in a program at an Avid Learning Partner, where you can complete additional Media Composer coursework if needed and take your certification exam. To locate an Avid Learning Partner, visit www.avid.com/education.


Media Composer Certification

Avid offers two levels of Media Composer certification:


	Avid Media Composer User Certification

	Avid Media Composer Professional Certification






User Certification

Certification requires you to display a firm grasp of the core operational skills, workflows, and concepts of non-linear editing on a Media Composer system. To achieve certification, you must take and pass both the MC101 and MC110 courses and corresponding exams.

Courses and books associated with Avid Media Composer User Certification include:


	Media Composer Fundamentals I (MC101)

	Media Composer Fundamentals II (MC110)
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These Avid Media Composer User Certification courses can be complemented with MC239, Color Grading with Media Composer and Symphony.

Media Composer | First courses develop similar skills and competencies as those taught in the Fundamentals I course. Users who pass the exam associated with this course become an Avid Certified Associate | Media Composer First. First-certified users can achieve Avid Certified User status by going on to take the Fundamentals II course at an Avid Learning Partner location.




Professional Certification

The Avid Media Composer Professional Certification builds on Avid Media Composer User Certification and prepares editors to competently operate a Media Composer system in a professional production environment. Professional certification requires a more advanced understanding of Media Composer, including advanced tools and workflows involved in creating professional programs.

Courses and books associated with Avid Media Composer Professional Certification include:


	Media Composer Professional Editing I (MC201)

	Media Composer Professional Editing II (MC210)
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These Avid Media Composer Professional Certification courses can be complemented with MC239, Color Grading with Media Composer and Symphony.

For more information about Avid certification programs, please visit

www.avid.com/en/education/certification.






Avid Certified. Real Skills. Proven.

Avid user and professional certifications help professionals attain and demonstrate the skills and credentials they need to increase their value, competency, and efficiency in the highly competitive media industry.

Avid certification programs cover the broad range of Avid products, as well as other professional roles, including Avid Certified Instructor, Avid Certified Support Representative, and Avid Certified Administrator.

If you want to learn more about Avid training, please check out our official online resource by going to www.avid.com/education. There you will find information about our training partners, specifics on the various certification options available, and detailed course descriptions for each course offered through our programs.




How to Use This Book

This book has been designed to help you with techniques you will use to complete a Media Composer | First project. Each lesson and exercise will focus on a phase of the editing process, starting with organizing media, assembling a sequence, refining a sequence, creating titles and effects, and outputting your work so that others can view it.

For reference, steps “To Do” in this book will have a square next to the task—meant for you to check off the steps as you complete them. Subsequent bullet points offer more information about the task you performed. Some bullet points will be an alternate way to perform the task. For example:


	□ This is a task for you to perform.

	This is additional information about the task you just performed, or an alternate way to

	perform the task.






Each lesson of the book is followed by review questions and an exercise. While you are going through the lesson, follow along with the to-do steps (square bullet points). The work you do in the lesson prepares you for the exercise. If you don’t follow along with the steps in the lesson, some of the exercises might not make sense.

At the end of each exercise there is something for you to turn in to your instructor (if you are working along with an instructor). Always ask your instructor for guidance on labeling and instructions for how to turn in the screenshot or file. If you are not working with an instructor, then the files due at the end of each exercise are suggested as checkpoints and a way for you to admire all of the hard work you’ve done in each lesson.




Course Media

The course media designed to accompany this book can be downloaded from EditStock.com. Once the media is downloaded, you will then need to place the media files in the correct locations on your system (these steps are covered later in this lesson).




Recommended System Setup

With Media Composer, you don’t need a lot to be successful. So, whether you are editing on a laptop or a desktop computer, the recommended system setup is the same.


	Internal or external speakers, or good quality headphones.

	An internal or external card reader (or port) compatible with the type of media storage in your camera.

	[Optional] An external hard drive for storing media files. A project can often use large amounts of media, so it is important to have enough storage.






System Requirements

This book assumes that you have a system configuration suitable to run the Media Composer | First software. To verify the most current system requirements, visit:

www.avid.secure.force.com/pkb/articles/enUS/Compatibility/Media-Composer-First-System-Requirements




Avid Link

When you install Media Composer, Avid Link is also installed. It’s a free application that gives you direct online access for managing your Avid account and software licenses. Additionally, it provides a convenient way to find, connect, and collaborate with other creative people, promote your work, get discovered, and purchase and manage products—all in the one place.

You can open Avid Link from the applications list (macOS), or from the Start menu (Windows). The Avid Link icon is always available, so even if you close Avid Link with the window close button, you can easily reopen it.

There is also a mobile version of Avid Link that you can download from the Apple App Store or from Google Play. It will keep you connected with your editing community even when you are not sitting at your desktop computer.




About the Media Composer | First Software

Media Composer | First is a limited yet feature-rich version of the industry-standard Media Composer family of applications. This version is freely available to anyone interested in learning the craft of film editing and becoming proficient at using non-linear editing software. By learning how to use Media Composer | First, you will be able to transition to the more fully featured versions with ease, making it a great start on the road to a career in film, television, or video production.

Projects created in Media Composer | First cannot be opened in other Media Composer applications like Media Composer Standard, Ultimate, or Enterprise.




Media Composer Setup

To complete the lessons and exercises in this book, you’ll first need to set up an Avid Account, install Media Composer | First, and pull the media from EditStock. If you are working in a classroom setting, your instructor may have already completed these steps for you. If you’re unsure, ask your instructor for additional guidance. If you are working on this course independently, you’ll need to follow these steps carefully before moving forward.


Step 1: Create an Avid Account

If this is your first time downloading an Avid product, you’ll need to create an Avid account. To do this:


	□ Go to www.my.avid.com/get/media-composer-first

	□ Click the Create an Account button
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	□ Fill in the required fields and click Submit
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	□ Answer the questions on the next page and click the Email my download links button

	The answers in the screenshot below are sample answers. Your answers may vary.
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That’s it. Avid will send you an email with a Media Composer | First download link.




Step 2: Download, Install, and Open the Avid Applications

Once you receive an email from Avid with the subject line, Your Media Composer | First Download, you’re ready to download and install the app. To do this:


	□ Open the email and click the blue button for your operating system—Mac or Windows

	□ Open the downloaded.zip (Windows) or .dmg (Mac) file and follow the installation prompts for your OS

	The screenshot below shows you what this will look like if you’re working on a Mac.
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Once install finishes, you can find the Avid and Avid Media Composer folder you’ll use next in one of the following locations:

	

	Windows: drive:\Program Files\Avid\Avid Link and Avid Media Composer folders

	MacOS: Macintosh HD/Applications/Avid and Avid Media Composer folders






	□ Open and set up the apps located in these folders.

	You can find the Avid Link app inside the Avid > Avid Link folder (Or through the start menu on Windows). When you open this the first time, you’ll sign into your Avid account (Profile tab).

	Once logged in you can customize Avid Link and use it to access resources and manage your Avid products in one location.
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You have two options for opening the Media Composer | First app. You can double-click the Media Composer app icon inside the Avid Media Composer folder. Or you can access it from the Products tab in Avid Link.


	□ When you open it the first time, select the Media Composer | First option in the Media Composer Activation dialog box.
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If you run into issues while setting up your Avid account or installing Media Composer | First, you can find help from links below.


	www.avid.secure.force.com/pkb/articles/enUS/faq/How-to-download-re-download-Media-Composer-First

	www.avid.com/media-composer/learn-and-support






Step 3: Download the Course Media Kit:

Once you’ve installed and opened Media Composer | First, you’re ready to download the project and media used throughout this course. To do this:


	□ Go to https://editstock.com/products/media-composer-first

	□ Click on the Download Project Files image

	The MC1_MediaKit.zip will download to your system.









Step 4: Install the Course Materials:

To prepare for this installation:


	□ Make sure you’ve opened Media Composer | First at least once. When you first launch the app, Media Composer automatically creates important folders you’ll use in upcoming steps.

	□ Unzip MC1_MediaKit.zip

	□ Open the MC1_MediaKit folder, which contains the following 5 sub-folders:

	Avid MediaFiles

	Avid Projects_Student

	Music

	Rock Climber QTs

	Ski Field_Footage
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Where you place these 5 folders depends on your system setup. If you’re working with an instructor, ask them where you should put these sub-folders.

This section includes instructions to accommodate 2 installation scenarios:


	Storing the video and audio files on an external drive that’s plugged into your computer

	Storing all the downloaded files on your computer’s internal system drive



To set yourself up for a successful installation, please read through all the instructions before performing the steps. Then follow the installation instructions that align with your system setup or instructor’s guidance.




Scenario 1 - External Media Drive Setup:

First, you’ll move the Avid MediaFiles folder to the correct location based on your external drive’s setup. To do this either:


	□ Move the Avid MediaFiles folder to the top (root) level of your external drive.

	□ If an Avid MediaFiles folder already exists on your external drive, locate the 10 folder (inside the unzipped Avid MediaFiles folder). Then drag this folder into your external drive’s MXF folder.
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Second, you’ll find a place for the following folders:


	

	Rock Climber QTs

	Ski Field_Footage

	Music







	□ For simplicity’s sake, drag these to the top (root) level of the external drive (but not inside the Avid MediaFiles folder).



Finally, you’ll place the projects in the location referred to throughout this course. To do this:


	□ Open the Avid Projects_Student folder (inside the folder you unzipped)

	□ Copy the Jacuzzi and Rock Climber Demo folders into the Shared Avid Projects folder on your internal hard drive:

	Windows: drive:\Users\Public\Public Documents\Shared Avid Projects

	MacOS (pictured below): Users/Shared/AvidMediaComposer/Shared Avid Projects
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Scenario 2 - Internal Media Drive Setup:

First, you’ll place the projects in the location referred to throughout this course. To do this:


	□ Open the Avid Projects_Student folder (inside the folder you unzipped)

	□ Copy the Jacuzzi and Rock Climber Demo folders into the Shared Avid Projects folder on your internal hard drive:

	Windows: drive:\Users\Public\Public Documents\Shared Avid Projects

	MacOS (pictured above): Users/Shared/AvidMediaComposer/Shared Avid Projects






Second, you’ll find a place for the following folders:


	

	Rock Climber QTs

	Ski Field_Footage

	Music




	□ For simplicity’s sake, drag these to your system’s desktop.



Finally, you’ll place the Avid MediaFiles folder in the correct location. To do this either:


	□ Move the Avid MediaFiles folder to one of the following locations:

	Windows: drive:\Users\Public\Documents\Avid Media Composer

	MacOS (pictured below): Users/Shared/AvidMediaComposer







	□ If an Avid MediaFiles folder already exists on your internal hard drive, locate the 10 folder (inside the unzipped Avid MediaFiles folder). Then drag this folder into your internal drive’s MXF folder.

	Windows: drive:\Users\Public\Documents\Avid Media Composer\Avid MediaFiles\MXF

	MacOS: Users/Shared/AvidMediaComposer/Avid MediaFiles/MXF







[image: chpt_fig_014.jpg]







Screenshots

At the end of each exercise either a screenshot or an exported file will be due. The process of taking a screenshot is different depending on whether you’re working on a Windows or Mac computer. The process of exporting a file is explained in a later lesson.

It’s good practice to save all of your screenshots in one folder and relabel them. If you’re not sure where to save your screenshots, or what to label them, ask your instructor.


Taking a screenshot on a macOS:


	□ Press the following keys on your keyboard at the same time: Command+Shift+4

	Your mouse pointer will turn into a crosshair.







	□ Click and drag your mouse pointer around the area of your screen that you want to capture.

	The screenshot will be saved to your desktop.









Taking a screenshot on a Windows OS:


	□ Press the following keys on your keyboard at the same time: Windows+Shift+S

	Your mouse pointer will turn into a crosshair.







	□ Click and drag your mouse pointer around the area of your screen that you want to capture.

	In the lower right-hand corner of your screen, a thumbnail image of your screenshot will be shown.







	□ Click on the thumbnail image in the lower right-hand corner of your screen.

	□ Click on the save icon in the upper right-hand corner.

	□ Save your screenshot in a designated area on your computer.








EXERCISE 1

[image: chpt_fig_015.jpg] Setup and Installation

Project: None

Duration: 5 Minutes


GOALS


	Practice taking a screenshot






Goal #1: Practice Taking a Screenshot

In this book, at the end of each exercise, you are asked to turn in a screenshot of your work. You may be asked to take a screenshot of your entire screen, or a portion of your screen. Using the steps outlined in the lesson, take a screenshot of your computer desktop.

If you are on a personal computer and don’t feel comfortable sharing a screenshot of your desktop, you can ask your instructor for an alternative.






Screenshots Due:


	□ A screenshot of your computer’s desktop (or alternative screenshot)










[image: chpt_fig_001.jpg] LESSON 2

Opening, Playing, and Exiting

In this lesson, you will learn the quickest way to open and play through clips and sequences a project. You don’t need a lot of knowledge to begin with—this lesson will just give you a taste of how Media Composer | First works. Later lessons will help fill in the blanks.

Project: Rock Climber Demo

Duration: 40 Minutes


GOALS


	Launch Media Composer | First

	Create a project

	Get to know the basic interface of Media Composer | First

	View clips and sequences in bins

	Play clips and sequences

	Save and exit Media Composer | First






Launching Media Composer | First

Launching Media Composer | First is like launching any other application on your computer. Once you download Media Composer | First, the application will be installed on your computer. To open Media Composer | First quickly, you’ll want to do the following steps.


To Pin Media Composer | First to the Taskbar in Windows:


	□ Click on the Windows button in the lower left-hand corner of your screen.

	□ Find the Media Composer | First application.

	□ Click on “Pin to taskbar”.






To Add Media Composer | First to the Dock in MacOS:


	□ Go to the Applications folder of your hard drive.

	□ Find the Media Composer | First application.

	□ Drag the Media Composer | First icon down to your Dock.



The Media Composer | First icon appears as shown in Figure 2.1.


[image: Figure 2.1 The Media Composer | First application icon looks identical in Windows and macOS (in this example, the Windows taskbar is on the left, and macOS Dock is on the right).]
Figure 2.1 The Media Composer | First application icon looks identical in Windows and macOS (in this example, the Windows taskbar is on the left, and macOS Dock is on the right).






To Launch Media Composer | First in Windows:


	□ Click the Media Composer | First icon on the taskbar.






To Launch Media Composer | First in MacOS:


	□ Click the Avid Media Composer icon in the Dock.

	While launching, the Media Composer | First splash screen appears as your computer loads the application. (See Figure 2.2.)







[image: Figure 2.2 The Media Composer | First splash screen during the initialization process.]
Figure 2.2 The Media Composer | First splash screen during the initialization process.





[image: chpt_fig_279.jpg]


DID YOU KNOW ABOUT SPLASH SCREENS?

The Media Composer splash screen shows you the specific version of Media Composer that you are running and identifies various components as they are loaded. Knowing the current version of Media Composer that you’re using is helpful, and if you ever encounter a problem, like the application crashing when it opens, this information will be helpful to the Avid Customer Support representative assisting you.



After Media Composer | First has loaded, you will see the window shown in Figure 2.3.


[image: Figure 2.3 The Media Composer | First window is used to locate and open existing projects, and to create new ones.]
Figure 2.3 The Media Composer | First window is used to locate and open existing projects, and to create new ones.



The window consists of several useful sections:


	□ Avid Content Area: When connected to the internet, this section of the window provides direct access to additional content and/or tools available from Avid. For example, you can access Quick Start videos if you want to learn more about using the application.

	□ Avid Account User: The name you use to log into your Avid account appears here.

	□ Create Project Field: Click this field and type a new project name.

	□ Project Location: The location where Media Composer | First will save a new project or is currently looking to open existing projects.

	□ Browse Folder Icon: Click this to set a custom location for accessing or saving your projects. Media Composer | First creates a default folder for saving projects when you launch the application for the first time.

	□ Open Section: This section lists projects located in the Project Location directory. Click the name of an existing project to select it.

	□ Create/Open Button: This button changes its name and function depending on whether you have clicked in the Create Project field or selected an existing project in the Open section.

	□ Quit Button: This button exits Media Composer | First.








Opening a Project

Opening an existing project in Media Composer is easy. Projects are displayed in the Media Composer | First window according to the Project Location setting:


	□ If your desired project is in the folder indicated in the Project Location setting, it will appear in the Open section (if it is not, click Browse Folder to the left of the field to choose the location for your projects). If you followed along with Exercise 1, you’ll find your projects here:

	Windows: drive:\Users\Public\Public Documents\Shared Avid Projects

	MacOS: Users/Shared/AvidMediaComposer/Shared Avid Projects/Avid Projects_Student







	□ Double-click the desired project in the Open section. For this lesson, choose Rock Climber Demo.

	The project will open.









The Interface

The Media Composer interface has three primary windows, shown in Figure 2.4. When a new project opens, these windows are set up and ready to start. They are:


	Bin Container - where you save clips and sequences (you’ll learn more about clips and sequences in the next section).

	Composer Window - where you watch and listen to your clips and sequences.

	Timeline - where you arrange your video and audio clips to tell your story.




[image: Figure 2.4 The Media Composer | First interface.]
Figure 2.4 The Media Composer | First interface.






The Menu Bar

The menu bar (Figure 2.5) is at the very top of your computer screen. Technically, it is not a part of the Media Composer interface, because the menu bar is always open. Whether you are working on a Mac or PC, the menu bar is a big part of Media Composer. You’ll be using it a lot in this book.


[image: Figure 2.5 The menu bar.]
Figure 2.5 The menu bar.






The Bin Container

You will spend most of your time using the Bin Container to access your clips from open bins. Sometimes we refer to the clips as your source material.


To Open the Bins from the Bin Container Sidebar:


	□ Double-click the icon to the left of the bin named Clips.

	□ Double-click the icon to the left of the bin named Sequences.



Both bins’ contents will then appear as tabs in the right panel. To see the contents of an open bin, click the tab for that bin at the top of the right panel.


[image: Figure 2.6 Icons in a bin.]
Figure 2.6 Icons in a bin.



There are two types of clips in the Clips bin of the Rock Climber Demo project, as seen in Figure 2.6. Each type can be identified by the clip icon to the left of the clip name:

[image: chpt_fig_283.jpg] This icon represents a video clip. A video clip will contain images with or without audio. For the m purposes of this lesson, double-click any video clip. The clip will appear in the left side of the Composer window.



[image: chpt_fig_284.jpg] This icon represents an audio only clip. It does not contain any images.



[image: chpt_fig_285.jpg] The Sequences bin contains a single sequence, identified by this sequence icon. For the purposes of this lesson, double-click the Rock Climbing sequence. The video and audio clips that have been edited together will appear in the Timeline and in the right ride of the Composer window.






The Composer Window

By default, the Composer window, shown in Figure 2.7, displays two monitors. The left one, called the Source monitor, is used to preview and select the parts of source clips that you will edit into the Timeline. The right monitor, called the Record monitor, displays the sequence that you create.

Across the top of the Composer window are displays that show you names and other information relating to your clips and sequences. (Each info window contains a menu with additional info and options.) On top of both the Source and Record monitors, you’ll see the Timecode values.


[image: Figure 2.7 The Composer window]
Figure 2.7 The Composer window





[image: chpt_fig_279.jpg]


DID YOU KNOW ABOUT TIMECODE?

Each frame in a film is assigned a number. This number is called Timecode. Timecode is 8 digits long, and represents the frame in Hours, Minutes, Seconds and Frames. If a film’s final timecode is 01:03:04:20, then that film might be 1 Hour, 3 Minutes, 4 Seconds, and 20 Frames long.

Using timecode helps editors and computers track which frame is which in a project that might have millions of different frames.






Buttons and Tools in the Composer Window

Buttons are arranged in a single row across the bottom of the Composer window.

Some buttons appear under both monitors, and each set acts differently depending on what monitor they’re under. For example, the Play button under the Source monitor plays the source clip, while the Play button under the Record monitor will play the sequence.

To play a clip in the Source monitor, you can either click the Play button, or use the space bar on your keyboard.




The Timeline

The Timeline is where you arrange your video and audio clips to tell your story, and it’s organized into tracks. Figure 2.8 shows a basic sequence, which is watchable when you play the Timeline. It contains one video track and three audio tracks. Sequences can have more tracks depending on the need. The Timeline will be empty until a sequence is loaded into the Record monitor.


[image: Figure 2.8 The Timeline.]
Figure 2.8 The Timeline.





[image: chpt_fig_279.jpg]


DID YOU KNOW ABOUT SEQUENCES?

Everything you’ve ever watched on television or in the theater has been edited. That means that an editor has made at least one cut to footage.

Maybe the editor decides to make a clip shorter, then cut to another clip. This process of “cutting” is called editing.

A sequence is a series of video and audio clips that have been edited together to tell your story. It’s the thing that you are creating.

The timeline is the window that you build it in.



In the Timeline, a sequence is played from left to right. The position indicator is the vertical blue line that marks the current frame of video and audio being shown in the Record monitor. The blue position indicator is commonly referred to as the “playhead”.


To Play or Move through a Sequence:


	□ Open the Rock Climbing sequence by double clicking the sequence icon in the bin.

	Your sequence will open in the Timeline.







	□ Click the Play button again under the Record monitor, or

	Press the Spacebar on your computer keyboard, or

	Press the 5 key on the QWERTY section your computer keyboard (not the numeric keypad, if your computer has one), or







	□ Scrub through the sequence by clicking and dragging the blue position indicator in the Timeline from within either the timecode ruler or the timecode track (Figure 2.8), or

	□ Scrub through the sequence by clicking and dragging the blue position indicator under the Record monitor (Figure 2.8).

	Notice that the position indicator in the Record monitor and the Timeline move together.






The Track Selector panel, shown in Figure 2.8, displays two columns of Track buttons. The left green column refers to the tracks that are in the clip loaded in the Source monitor.

The right blue column refers to the tracks in your sequence. The Track Selector buttons allow you to turn on and off the source and record tracks when editing. You will use the Track Selector buttons extensively while editing in Media Composer and will learn more about them in later exercises.






Working with Windows

As you learned so far in this chapter, when you open a Media Composer project, you’ll see a basic workspace containing the Bin Container, Composer window, and Timeline. These windows initially open as connected panels. Each window has a purple vertical title bar on the left side, which includes the name of the window.

Each of these windows can exist in one of two ways:


	□ A Docked Window is a window that is connected within the paneled user interface.

	□ A Floating Window is a window that is undocked.



This means that you have a lot of different ways to arrange your windows to suit your workflow.

Any window (docked or floating) can be docked into a section of the paneled user interface. Figure 2.9 shows the Effect Editor tool (which you’ll learn about in a later lesson), as a floating window, being dragged (by clicking on the vertical title bar for the window) into the paneled user interface.

The green drop zones indicate all the locations that the window could be dragged to, with a highlighted section indicating where the window would be dropped when the mouse is released. A docked window can be moved by clicking on the window’s title bar and dragging it to a new location within the paneled user interface.


[image: Figure 2.9 Docking a floating tool.]
Figure 2.9 Docking a floating tool.



Before getting started in this next section, a quick tip. If you accidentally close a window or misplace a tool, you can restore the workspace.


To Reset the Windows in the Interface:


	□ In the menu bar at the top of the screen choose Windows > Workspaces > Restore Current to Default…

	□ Click OK.






To Float a Window or Tool that is Docked:


	□ Click on the window’s purple title bar and drag it a short distance away. Don’t drag the window to the green drop zones. You could also:

	Click the pop-up menu button at the top of the title bar and choose Float This Panel, as shown in figure 2.10.







[image: Figure 2.10 Floating the Composer window.]
Figure 2.10 Floating the Composer window.




	□ A window (either docked or floating) can be vertically tabbed that allows you to manage screen space in multiple ways.

	For example, you might decide that you rarely need the Source Browser (a window you’ll learn more about in the next lesson) and the Timeline at the same time.

	You can have both occupy the same space by tabbing them.









To Tab a Floating Window:


	□ Hold the Option key (Mac), or Alt key (Windows), and drag the purple title bar next to another windows’ purple title bar with which you want to create a tab.

	□ When you’re done, you’ll see both names indicated in the vertical title bar (Figure 2.11)—just click the name of the window that you want to view.




[image: Figure 2.11 Creating a tabbed window by clicking and dragging a tab while holding down the Option key (Mac), or Alt key (Windows).]
Figure 2.11 Creating a tabbed window by clicking and dragging a tab while holding down the Option key (Mac), or Alt key (Windows).




[image: Figure 2.12 Choosing the desired window, from a tabbed window by clicking on the purple tab.]
Figure 2.12 Choosing the desired window, from a tabbed window by clicking on the purple tab.






To Dock a Window or Tool:


	□ Click on the window’s purple title bar and drag it out of the paneled user interface.

	□ A green drop zone will indicate the destination window (Figure 2.11). Drag the title bar to one of those.






To Close a Window or Bin:


	□ Click the “x” in the window’s purple title bar, or

	If the window is floating, on macOS, click the small red “x” next to the orange [-] square in the top left-hand corner of the floating window.

	On Windows, click the small red “x” next to the orange [-] square in the top right-hand corner of the floating window.











Playing Media

If you’ve been following the steps so far in this lesson, you’ve opened a project named Rock Climber Demo, double clicked a clip in the Bin Container (putting the clip into the Source monitor) and opened (again by double-clicking) a sequence named Rock Climbing. Now let’s look at the different ways that you can play your media.

All created bins are displayed as a list on the left side of the Bin Container, in an area called the Bin Container sidebar (Figure 2.13).

An open bin’s content is displayed in the Bin Container’s Right Panel. By default, Media Composer stores the Clips and Sequences bins’ contents in the right panel. You can view the contents of each bin by selecting the corresponding tab at the top of the right panel.


[image: Figure 2.13 The Bin Container sidebar (left) shows all bins and the right panel displays an open bin’s contents.]
Figure 2.13 The Bin Container sidebar (left) shows all bins and the right panel displays an open bin’s contents.




Scrubbing Through Clips or Sequences:

You can quickly scrub through a clip by clicking and dragging the green position indicator in the green position bar under the Source monitor. You can also scrub through a sequence by clicking and dragging the blue position indicator in the blue position bar under the Record monitor, or by clicking and dragging the blue position indicator in the timecode ruler or timecode track in the Timeline as shown in Figure 2.7.




To Play a Clip in the Composer Window


	□ In the bin, double click the clip icon from inside the bin, or

	□ Click and drag the thumbnail or clip icon onto the left-hand screen in the Composer window

	The left-hand screen is called the Source monitor and is shown in Figure 2.7. You cannot open a clip in the right-hand screen of the Composer window because that’s the Record monitor, and the Record monitor displays what video and audio clips are in your sequence. To play the clip, select the Source monitor by clicking anywhere on the monitor and do one of the following:




	□ Click the Play button under the Source monitor

	□ Press the Spacebar on your computer keyboard

	□ Press the number 5 key on the QWERTY section your computer keyboard (not the numeric keypad, if your keyboard has one)




[image: Figure 2.14 The Media Composer interface with a sequence open and a clip loaded in the Source monitor.]
Figure 2.14 The Media Composer interface with a sequence open and a clip loaded in the Source monitor.






Playing a Sequence

In Figure 2.14, you will see that both the Source monitor and Record monitors have position indicators, shown as green and blue lines respectively. In Figure 2.14 you will also see that in the Timeline, there is a blue position indicator located in the sequence. The blue position indicators show the location of the current frame being displayed in the Record monitor.




To Go to the Beginning of the Sequence:


	□ If it’s not already open, open the Rock Climbing sequence by double clicking the sequence icon in the Sequences bin.

	□ Press the Home key on your computer’s keyboard (if your computer has a Home key), or

	□ Click and drag the blue position indicator under the Record monitor to the left, back to the start of the sequence, or

	□ In the Timeline, click and drag the blue position indicator in either the timecode ruler (at the top of the timeline section) or the TC1 timecode track (between the A1 and V1 tracks) to the left, back to the start of the sequence.



As you drag a position indicator, you navigate through time, or scrub through the video and audio in the sequence. (The Source monitor also has a position indicator that allows you to scrub through a clip.)






The J-K-L Keys

A very useful set of controls on the keyboard are the J-K-L keys. They can help you to quickly navigate backwards and forwards through a source clip or sequence. Many editors use these keys because they are grouped together in a convenient location on the keyboard, and with practice they make searching through clips and sequences very efficient. The J-K-L keys in Media Composer work as follows:


	□ Depending on what you want to navigate through, select the Source monitor, Record monitor or Timeline.

	□ To play a clip or sequence forward at real-time speed, press the L key once.

	□ To stop, press the K key.

	□ To play backward at normal speed, press the J key once.

	□ To play forward faster than real-time, press the L key repeatedly. Every time you press the L key, the clip or sequence will play faster, at 1x, 2x, 3x, 5x, and 8x normal speed.

	□ To play backward faster than real-time, press the J key repeatedly. The clip or sequence will play in reverse by the same increments: 1x, 2x, 3x, 5x, and 8x normal speed.

	□ To play backward in slow motion at 1/4 speed, press and hold the K+J keys.

	□ To play forward using fast forward at 1/4 speed, press and hold the K+L keys.

	□ To move just one frame at a time, hold down the K key, and then quickly tap either J or L.






Saving and Closing a Project

Media Composer automatically saves a project at regular intervals as you work and when you close the project.

To close a project:


	□ From the menu bar, select File > Close Project.

	□ To exit Media Composer, click the Quit button in the Media Composer window.

	□ A dialog box appears, asking you to confirm that you want to leave the application, as shown in Figure 2.15. Click the Leave button to exit Media Composer.







[image: Figure 2.15 The confirmation dialog box when quitting Media Composer | First. Remember, your work will automatically save whenever you close a project.]
Figure 2.15 The confirmation dialog box when quitting Media Composer | First. Remember, your work will automatically save whenever you close a project.






Lesson 2 Review & Discussion Questions


	When Media Composer | First launches, what is the name of the window that allows you to create a project or open an existing project?

	What are the names of the 3 primary windows in the Media Composer | First interface?

	Where are clips and sequences saved?

	What does the Source monitor in the Composer window display?

	What does the Record monitor in the Composer window display?

	What does the Timeline display?

	How can you scrub through a sequence?

	What are the buttons you can press to play a clip or sequence?

	How does the function of the L key differ from the Spacebar when playing a clip or sequence?

	What is the difference between the blue and green position indicators?






EXERCISE 2

[image: chpt_fig_015.jpg] Opening, Playing, and Exiting

Project: Rock Climber Demo

Duration: 15 Minutes


GOALS


	Open and setup Media Composer | First

	Play media

	Sub-divide a floating window

	Save and quit Media Composer






Goal #1: Open and Setup Media Composer


	□ Launch Media Composer | First.

	□ Open the Rock Climber Demo project.

	□ Open the Clips and Sequences bins by double-clicking the bin icons in the Bin Container sidebar.

	□ From the Clips bin, double-click the R04_156 Matt Climbing-Editstock clip to open the clip in the Source monitor.






Goal #2: Play Media


	□ Play and watch the entire clip in the Source monitor.

	□ From the Sequences bin, double-click the Rock Climbing sequence.

	□ Play and watch the entire sequence in the Record monitor.






Goal #3: Subdivide a Floating Window


	□ In the menu bar, choose Tools > Audio Mixer. This window opens as a floating tool.

	□ Dock the tool by placing it between the Bin Container and the Composer window.

	□ Take the screenshot for this exercise.






Goal #3: Save and Quit


	□ Save your project.

	□ Close Media Composer | First.








Screenshots Due:


	□ Take a screenshot of the entire screen with both bins and the Rock Climbing sequence open.










[image: chpt_fig_001.jpg]LESSON 3

Setting Up Your Project

In Lesson 2 you learned how to quickly open and play a project. In this lesson you will become more familiar with the Media Composer | First interface and learn how to create a new project, import media, and organize everything in your project.

Project: Rock Climber Demo

Duration: 45 Minutes


GOALS


	Creating a new project

	Understanding bin views

	Playing clips

	Creating new bins and folders

	Deleting bins and folders






About the Projects in This Book

Now that we are starting to edit, let’s learn a little bit about the projects you’ll be working with throughout the book. We started working with a project called Rock Climber Demo, an unscripted documentary. In future lessons, you’ll work with Jacuzzi, which is a scripted drama. Let’s take a look at the difference between the two.


The Unscripted Documentary

The Rock Climber Demo project is from a longer film about an enthusiastic climber, Matt Rodgers. The film is a style called an ‘unscripted documentary’. Prior to filming, the producer/director researched the subject and spent time talking with Matt to understand the ‘ins’ and ‘outs’ of the sport. When it came to filming, the filmmaker followed Matt as he scaled the rock face, and as you have seen, the camera crew did a good job of capturing a range of interesting shots. The producer/director then sat down with Matt and filmed an interview so he could explain his passion for climbing.

Before handing the film over to the editor, the producer/director will typically produce a ‘paper edit’—a road map outlining the story and the order in which the filmed elements should be told. Depending on the producer/director, the paper edit can be anything from a very detailed document to a basic sketch.

Of all crew members, the editor will probably spend more one-on-one time with the filmmaker than anyone else. Once a good working relationship has been established, it is likely that they will work together on many projects throughout their careers. Armed with the paper edit, the editor will start looking through all the footage to identify the various story elements that are needed. Then, the editor would listen to the interview and find the shots that best tell the story.

What makes a film engaging is tapping into the emotion, the risk, the energy, the sense of achievement or failure so the audience can relate to the subject in the story. So, in addition to making obvious shot choices that support the story, the editor is building an emotional connection with the audience. You’ll learn that cutting according to rhythm and pace is one of the ways editors can convey a sense of quiet meditation or hectic energy. In an unscripted documentary, an editor might work through hundreds of hours of footage in order to achieve those goals.




The Scripted Drama

At its core, the scripted drama has the same goals as the unscripted documentary. The editor tries to engage the audience in both the narrative and the human emotion. The big difference is that in scripted drama the intention is clear from the start, with a well written screenplay guiding the way. The entire effort of the cast and production crew is to capture that story and the emotions that come with it. The editor’s job is to put together a puzzle of shots, so the audience experiences the story as a whole and not just the individual pieces.

Telling a dramatic story is much more than just putting together the puzzle of shots. Sometimes emotion is better expressed in what wasn’t said or done. For instance, the look on a character’s face might speak louder than their words. And, like cutting together the shots of the rock climber, a dramatic sequence often works best when action flows smoothly from one shot to the next. It helps convey a sense that this is a natural performance rather than a series of separate shots joined together. The goal is to immerse the viewer in the story and not to distract them with your editing.

For this reason, editing is often referred to as an “invisible art”. The more unnoticed the editing is, the more engaged the audience can be in the story, and the better the editor.

Whether we work on an unscripted documentary, or a scripted drama, our job is to tell the story and convey emotions through our invisible art. But just like you can’t play a video game without understanding what the buttons on your controller do, you cannot begin editing without first understanding the buttons and windows in Media Composer.






Creating a New Project

As you learned in lesson 2, after Media Composer | First has launched, you will see the Media Composer | First window shown in Figure 3.1. This is where you can create a new project.


[image: Figure 3.1 The Media Composer | First window is used to locate and open existing projects, and create new ones.]
Figure 3.1 The Media Composer | First window is used to locate and open existing projects, and create new ones.




To Create a New Project:


	□ In the Project Location section, click on the Browse Folder icon and navigate to the destination where you want to save your project. If you don’t already have one, create an Avid Projects folder on your destination drive. It is important to take a note of the file path so you can easily locate your project the next time you launch Media Composer | First.

	□ Click in the Create Project field of the Media Composer | First window and type a name for your project.

	□ Click the Create button at the bottom of the window.



The Media Composer | First window will close, and the Media Composer | First interface opens.






The Bin Container

The Bin Container is the central hub of Media Composer. The Bin Container includes two sections. The left section is the Bin Container sidebar which allows you to organize everything in your project into bins and folders, while the right section shows open bins in the Bin Container’s right panel. Open bins appear as a series of tabs across the top of the right panel.


[image: Figure 3.2 The Bin Container is the central hub of your project.]
Figure 3.2 The Bin Container is the central hub of your project.



You can change the size of the sidebar and the right panel within the Bin Container.


To Change the Relative Sizes of the Sections:


	□ Position the mouse over the border between the sidebar and the right panel. The mouse pointer changes to a left/right arrow.

	□ Click and drag the border to change the relative sizes of the two sections.




[image: Figure 3.3 Changing sizes of the sections in the Bin Container.]
Figure 3.3 Changing sizes of the sections in the Bin Container.








The Bin Container Sidebar

When a new project is created, Media Composer | First automatically creates two new bins. One of the bins has the word “Sequences” on the end of its name, and the other has the word “Clips” on the end.

The Sequences bin is one of the most important bins needed in a project. When you save all your sequences into the Sequences bin, you will never struggle to find where you have saved your work.

No footage can be saved directly within the sidebar itself. All assets you use in a project must be saved in bins. Bins can hold assets such as audio and video clips, subclips, sequences, titles, effects, graphics…everything! You can also put bins into folders to further organize a project.


	You can rename a bin by clicking the text in the sidebar and typing the new name. (Both bins in Figure 3.2 have been renamed from the default names.)





[image: chpt_fig_279.jpg]


DID YOU KNOW ABOUT THE FAST MENU?

In every tool or window there is a button called the Fast menu. The Fast menu in each location provides different options, but the icon is always the same.


[image: The Fast Menu Button]
The Fast Menu Button



It’s called the Fast menu because it allows quick access to features and controls that you’ll use in each tool or window. In older versions or Media Composer, the Fast menu looked more like a hamburger, and some editors called it the ‘hamburger menu.’






Bin View Buttons

A bin is far more than just a container. There are three different options for viewing a clip in the clip bin—Text view, Frame view and Script view. Each can be selected by clicking on their respective Bin View button. Depending on how wide the right panel, the Bin View buttons can be selected from a row of buttons or a drop menu at the top of the section, as shown in Figure 3.4. Notice that when the right panel is opened wide, you can see all of the display buttons. When the right panel is smaller, the buttons become a drop-down menu.


[image: Figure 3.4 Bin View buttons.]
Figure 3.4 Bin View buttons.



Figure 3.5 shows a clip displayed in Text view as a row of text in columns of information and in Frame view as a thumbnail image known as a representative frame.


[image: Figure 3.5 A clip displayed in Text view (left) and Frame view (right).]
Figure 3.5 A clip displayed in Text view (left) and Frame view (right).




Text View

Text view displays all the contents of the selected bin in a list. This is the default view.


[image: Figure 3.6 A Bin in Text View.]
Figure 3.6 A Bin in Text View.



In Text view, you can choose to display additional columns of information associated with each clip.




To Select the Columns of Information to Display:


	□ Open the Fast menu at the top of the right panel.

	□ Click Choose Columns…

	The Bin Column Selection window will open, as shown in Figure 3.7.




	□ Click the columns of information you want to display in the bin. Selected columns are highlighted.

	□ Click the OK button.

	The Bin Column Selection window will close, and the selected columns of information will be displayed in the bin. You may need to use the scroll bar at the bottom of the bin to see all the columns of information.






When in Text view, you open a clip in the Source monitor by double-clicking a clip icon or dragging the icon to the Source monitor.


[image: Figure 3.7 The Bin Column Selection window.]
Figure 3.7 The Bin Column Selection window.






Frame View

Frame view shows you a representative frame or thumbnail for each item in the bin, as shown in Figure 3.8. This can be an easy way to work if you prefer a thumbnail view of a clip.


[image: Figure 3.8 Frame view lets you see a thumbnail image for each item in your bin.]
Figure 3.8 Frame view lets you see a thumbnail image for each item in your bin.



Frame view enables you to easily rearrange your shots just by clicking and dragging them to a new location. You are free to arrange the thumbnails in any way you like. Perhaps you want to group shots together based on what they look like rather than their text descriptions? Or perhaps you might want to arrange a series of shots in an order that could effectively tell a story when edited together in the Timeline? Frame view gives you the ability to organize your clips in any way that suits your workflow.

When in Frame view, you open a clip in the Source monitor by double-clicking a thumbnail or dragging it to the Source monitor.




Script View

The third way of viewing items in a bin is Script view. It is a combination of Text view and Frame view with an added Comments field. You can type anything you like in the Comments field, but it is typically used for logging notes and keywords to help you manage your footage and easily search for clips.


[image: Figure 3.9 Script view combines the visual thumbnail of Frame view and the statistical info of Text view with a handy area to type in comments.]
Figure 3.9 Script view combines the visual thumbnail of Frame view and the statistical info of Text view with a handy area to type in comments.



The comments you enter within Script view also automatically appear in the Comments column of Text view.

When in Script view, you open a clip in the Source monitor by either double-clicking a thumbnail or the clip icon or by dragging the thumbnail or icon to the Source monitor.






Playing a Clip from Inside the Bin

Did you know that you can play a clip without opening it up in the composer window? To play a clip in a bin, select Frame view from the Bin View buttons.


	□ Click on a clip you want to play and either:

	Press the Spacebar on your computer keyboard, or

	Press the 5 key on QWERTY section your computer keyboard (not the numeric keypad, if your computer has one)

	Use your J-K-L keys to play through your clip









Creating Bins and Folders


To Create a Bin, Do One of the Following:


	Click the Fast menu at the top of the Bin Container sidebar and select New Bin.

	Right click in the Bin Container sidebar and select New Bin.

	From the menu bar on the top of your screen, select File > New > New Bin.

	Use the keyboard shortcut Ctrl+N (Windows) or Command+N (Mac).



When a new bin appears in the sidebar, the text is highlighted ready for you to type a new name.


	□ Create and name a bin Music. See Figure 3.10.

	□ Create and name a second bin Sound effects.






To Create a Folder, Do One of the Following:


	From the Fast menu in the sidebar, select New Folder.

	Right click in the sidebar and select New Folder.



A new folder will appear in the sidebar with the text highlighted ready to be renamed.


	□ Create and name a folder Audio.






To Move Bins into a Folder:


	□ Click and drag the newly created bins into the folder. To view the bins in the folder, click the disclosure triangle to the left of the folder icon as shown in Figure 3.10.




[image: Figure 3.10 Folder with bins inside.]
Figure 3.10 Folder with bins inside.






To Delete Bins and Folders:


	□ Select the folder in the Bin Container sidebar and reopen the Fast menu. Click Delete Selected Items. A red trash icon will appear in the sidebar with the folder inside it. Figure 3.11.




[image: Figure 3.11 The trash icon and recently deleted contents.]
Figure 3.11 The trash icon and recently deleted contents.






To Empty the Trash:


	□ From the Fast menu, click Empty Trash. A window will appear asking you to confirm that you do in fact wish to permanently delete the bins from your drive.

	□ Click the Empty Trash button to delete the bins.

	Once you empty the trash, it cannot be undone.











Lesson 3 Review & Discussion Questions


	Which section serves as the central hub of your project—holding video and audio clips, as well as sequences—even if you don’t use them in the final film?

	What is a bin?

	How do you change the sizes of the sections in the Media Composer interface?

	What button, menu, or tool allows quick access to features that you’ll frequently use—but has different options depending on what window it is in?

	What are the 3 different ways in which you can view the contents of a bin?

	Which bin view allows you to select the columns of information to display?

	Which bin view allows you to see representative frames (thumbnails) and move those frames around inside the bin?

	Which bin view is best for leaving comments or notes on clips?

	True or False: You must open a clip in the Source monitor in order to play it.

	What are the different ways to create a bin or folder?






EXERCISE 3

[image: chpt_fig_015.jpg] Setting Up Your Project

Project: Sample Project & Rock Climber Demo

Duration: 20 Minutes


GOALS


	Create a new project and set up bins

	Switch projects

	Create a folder and organize the project

	Leave a comment on a clip






Goal #1: Create a New Project and Set Up Bins


	□ Launch Media Composer | First

	□ Create a new project named Sample Project_(Student ID)

	□ Click the Create button

	□ Create new bins so that you have 3 bins in your project

	□ Click on the text for each bin and rename them: Sequences, Clips, Music

	□ Take a screenshot for the end of this goal.






Goal #2: Switch Projects


	□ Close the Sample Project_(Student ID)

	□ Open the Rock Climber Demo project

	□ Open the Clips bin






Goal #3: Create a Folder and Organize the Project


	□ Create a new folder

	□ Name the folder “Sequences”

	□ Move the Sequences bin inside of the Sequences folder

	□ Click the disclosure triangle next to the Sequences folder so you can see the bin inside






Goal #4: Leave a Comment on a Clip


	□ In the Clips bin, find clip R05_46 Matt Bouldering-EditStock.mov

	□ Switch to Script view

	□ Leave the comment: “Rock climber falls off of the rock!”








Screenshots Due:


	□ Take a screenshot of your entire screen in the Sample Project with the 3 renamed bins.

	□ Take a screenshot of your entire screen in the Rock Climber Demo project with the Sequences bin inside the Sequences folder. Have the clips bin open in Script view with the comment you left visible.











[image: chpt_fig_001.jpg] LESSON 4

Ingesting Media

In this lesson, we will be creating another project, called Ski Field. We will learn how to find video and audio clips on your computer and bring them into Media Composer | First for you to edit. This process is also known as ingesting media.

Once we ingest our media, it’s time to rename our clips and further organize our project to prepare for editing.

Project: Ski Field and Rock Climber Demo

Duration: 45 Minutes


GOALS


	Understanding different ways to ingest media

	Ingest using drag and drop

	Use the Source Browser to locate and import media files

	Delete clips






Getting Started

To follow along with the steps of this lesson, you’ll need to create a new project and organize your bins. Look back to lesson 3 if you need a full list of steps.


	□ Launch Media Composer | First and create a new project named Ski Field_(Student ID).

	□ You will need three bins in this project. Create and name the three bins: Clips, Sequences, and Music.






Ingesting Media

Before you can begin ingesting, you will need to understand some basic editing terms.


	Media Files - The video and audio files you will work with.

	Clips - When you ingest media files, you create clips. You’ll edit clips together, put effects on them, and even stack them on top of each other in a sequence. Your clips edited together makes your final product.

	Sequences - This is what’s created when you edit your clips together.

	Bins - Clips and sequences are saved in container files called bins.






How to Ingest Video Clips

In video production workflows, the process of bringing media into a project is commonly called ingest. There are two ways to ingest media into a Media Composer project:


	Import: Importing makes copies of the original media files. The copies are different in two ways from the original files: Firstly, the copying process produces files that are a different format from the originals. Secondly, those copies are saved in a hidden location (hidden for now—in lesson 18 you’ll learn where the files are located) determined by Media Composer.

	Link: Linking connects original media files on your computer directly to the project in Media Composer. Unlike importing, it does not copy the media files or move them to a specific location. Media Composer will access the files from their current location and in their current formats.



There are two ways to ingest media. You can use the Source Browser, or you can drag-and-drop.


Using the Source Browser to Ingest Media

The Source Browser is one way of ingesting media, giving you control over the settings of the clip you create. When you use the Source Browser to add clips to a bin, you must choose whether you want to link or import your clips. It is shown in Figure 4.1


[image: Figure 4.1 This is the Source Browser. Use it to find, and then link or import clips into your project.]
Figure 4.1 This is the Source Browser. Use it to find, and then link or import clips into your project.



Before using the Source Browser, open the bins you want to add your clips to.




To Open the Source Browser:


	□ Select File > Input > Source Browser or,

	• Click the Fast Menu in an open bin and select Input > Source Browser or,

	• Right-click in an open bin and select Input > Source Browser






Linking to a Media File Using the Source Browser

In the Source Browser, the Navigation pane allows you to search your computer to find the media you want to link.


	□ In the Navigation pane, navigate through the drives and folders until you find the folder Ski Field_Footage. Double-click the folder.

	The File/Folder Contents pane will show you the files contained in that folder. Like a bin, the File/Folder Contents pane allows you to view its contents in either Text or Frame view. You can change the view by clicking the appropriate icon in the lower left of the File/Folder Contents pane.




	□ Select all the files by doing one of the following:

	Click the first file, then Shift+click the last one you want to select. All files in between are selected.

	Ctrl+click (Windows) or Command+click (Mac) each file you want. This selects multiple files individually.

	Ctrl+A (Windows) or Command+A (Mac) to select all files.




	□ Activate the Link button near the bottom-left edge of the Source Browser.



You’ll need to decide which bin to add your clips to. At the bottom-right side of the Source Browser, use the Target Bin menu to choose the Clips bin from the list, as shown in Figure 4.2. If you had already opened the Clips and Music bins, they should both appear in the Target Bin drop-down list. You also have the choice of creating a new bin.


[image: Figure 4.2 This is the Target Bin menu. When you link or import, you need to decide which bin to save your clips.]
Figure 4.2 This is the Target Bin menu. When you link or import, you need to decide which bin to save your clips.






Importing a Media File Using the Source Browser

Because the process of importing (as opposed to linking) makes a new copy of a media file and saves it in a folder determined by Media Composer, it is important that you understand why and when to link vs. import. If you do decide that importing your media is needed, then you can follow the steps below.




To Import a Media File:


	□ At the bottom right corner of the Source Browser click the Import button.

	□ Drag and drop the media file from the File/Folder Contents pane to the desired bin (in this case, the Clips bin).

	If there is a difference between the video resolution of the original media file and the video resolution of your project, an alert appears as shown in Figure 4.3.

	For more information on why this occurs and Media Creation settings, look ahead to Lesson 18.







[image: Figure 4.3 The Import Resolution Conflict window]
Figure 4.3 The Import Resolution Conflict window




	□ When you click OK, the system offers you the option to link and consolidate/transcode the media. Click Yes to proceed with the import.




[image: Figure 4.4 The Import progress bar]
Figure 4.4 The Import progress bar



When the import is complete, the target bin will now contain a clip for the imported media file. Notice in Figure 4.5 that the video clip icon resembles a linked clip icon, but the icon lacks the 2 links of a chain on the right side.

This tells you that the project has imported the media file, not linked to it. And like a linked file, the imported clip has also adopted the name of the source media file.


[image: Figure 4.5 The imported clip vs a linked clip]
Figure 4.5 The imported clip vs a linked clip




	□ At the bottom right corner of the Source Browser click the Link button or,

	Drag and drop the media files from the File/Folder Contents pane to the open Clips bin.






The Clips bin now contains clips linked to the media files you had selected. Each clip icon displays 2 chain links on the right side, telling you that the project has linked to the media files, and not imported them.

Notice in Figure 4.6 that the clip names in the bin are the same as the clips on your computer.


[image: Figure 4.6 The linked clips inside of the clips bin.]
Figure 4.6 The linked clips inside of the clips bin.



Close the Source Browser by clicking the red X in the top corner, or click the purple X in the side bar, shown in Figure 4.7


[image: Figure 4.7 There are two ways to close the Source Browser.]
Figure 4.7 There are two ways to close the Source Browser.






Ingesting Media Using Drag-and-Drop

At the top of the Bin Container’s right panel, select the tab for the open bin where you want to add clips. Any new bin you create in a project will be empty.

Using your computer’s operating system, navigate to the media file that you want to add to your bin. Align the size and position of the folder in your operating system’s browser, so you can see both it and the open bin in Media Composer. From the folder, select one of the files and do one the following:


	In a Windows computer, hold the Alt key and click and drag the file into the open bin in the Bins Pane. Your clip will be linked into the bin.

	In a Macintosh computer, hold the Option key and click and drag the file into the open bin. Your clip will be linked into the bin.






[image: chpt_fig_278.jpg]


STOP & THINK

Before you link or import, you have to Stop and Think:


	Which bin do 1 want my clips to go into?

	If you do not open any bins in your project before opening the Source Browser, the Target Bin selection drop down will only display “New Bin…” You will need to open the bin you want your clips to go into before you see it in the Target Bin selection menu. This could be a big waste of time—if you didn’t Stop and Think!










Changing Clip Names

File names created in a camera are often poor descriptions of the media they represent. In the example above, to know what clip C0001 is, you will need to open it in the Source monitor and play it or switch the bin to Frame view. Once you have viewed the clip, you can change its name in the bin. Perhaps House snowing 01 is an appropriate description. There are more shots of snowing on the house, so all other shots could be renamed and numbered, e.g. House snowing 02, House snowing 02 etc. After you have ingested the media files, renaming clips is an important part of setting up a project for editing. It makes sorting and locating clips much easier as you work in a project.


To Rename an Imported or Linked Clip:


	□ Open clip C0001 in the Source monitor

	It’s the green house being snowed on.




	□ In the bin, click the clip’s name, not the icon.

	□ Type a new name for the clip.

	□ Press the Enter key (Windows) or Return key (Mac).

	The cursor will jump down to the next clip and is ready for you to rename the next clip.











Deleting Unwanted Clips from a Bin


To Delete a Clip:


	□ Select the clip C0002 in the bin by clicking once on the clip icon.

	□ Press the Delete key on the keyboard.

	A window will appear, asking you what you want to delete. As shown in Figure 4.8, linked clips provide no option for deleting the original media files while imported clips will allow you to delete the copies of the original media files that were created during the import process. Both linked and imported media master clips can be deleted from the bin.




	□ Click cancel to close the window without deleting any clips.




[image: Figure 4.8 The Delete windows differ for imported clips vs linked clips.]
Figure 4.8 The Delete windows differ for imported clips vs linked clips.





[image: chpt_fig_278.jpg]


STOP & THINK

Before you delete clips, you have to Stop and Think:


	Do you actually want to delete clips? Why are you deleting them?

	When you delete media, it’s permanent. This cannot be undone. Anytime you are deleting media, it is best to double-check that it’s what you really want to do.










Lesson 4 Review & Discussion Questions


	What is the difference between linking and importing media?

	When you link to or import a media file, what is saved in a bin?

	How can you easily move a clip to a bin from a media file on your computer?

	When dragging media files from your computer to a Media Composer bin, in order to link to the files (rather than import them), which modifier key must you press?

	Why would you use the Source Browser instead of dragging and dropping to get clips into your bin?

	What are three ways to open the Source Browser?

	What is the Target Bin menu?

	How do you change the name of the clip in a bin?

	True or False: While deleting a linked clip, you only have the option to delete the clip (not the media file). Explain.

	True or False: When deleting an imported clip, you have the option of deleting both the clip and the media file. Explain.






EXERCISE 4

[image: chpt_fig_015.jpg] Ingesting Media

Project: Rock Climber Documentary_(student ID)

Duration: 15 Minutes


GOALS


	Create a new project

	Create new bins

	Link video clips

	Import music clips

	View clips in a bin in Frame view






Goal #1: Create a New Project


	□ Launch Media Composer | First and create a new project named Rock Climber Documentary_(student ID).






Goal #2: Create New Bins


	□ Create three new bins.

	□ Name the bins Sequences, Clips, and Music.

	□ Open the Clips and Music bins.






Goal #3: Link Video Clips


	□ Open the Source Browser and click the Link button near the bottom left side of the Source Browser.

	□ In the Navigation pane, locate and select the Rock Climber QTs folder on your computer.

	□ In the File/Folder Contents pane, select all the .mov video files - but do not include the 3 music .wav files (named 179_short_we-are-young-we-are-free).

	□ Link to all the .mov video files.

	Make sure the linked clips are saved in the Clips bin.




	□ Open the Source Browser again if it closed.






Goal #4: Import Music Clips


	□ Import the three .wav music files to the Music bin.

	The music files all begin with “179_”




	□ Close the Source Browser.






Goal #5: View the Clips in Frame View


	□ Open the Clips bin so you can see all the clips in the bin.

	□ Switch the bin view to Frame view.








Screenshots Due:


	□ Take a screenshot of your entire screen with the clips bin in Frame view—adjust the size of the bin so the screenshot shows everything in the bin.

	□ Take a screenshot of your Music bin—adjust the size of the window so the screenshot shows everything in the bin.











[image: chpt_fig_001.jpg] LESSON 5

Getting Started Editing

Now you know how to create a project, ingest clips, and organize and prepare your project for editing. Finally, it’s time to start editing. In this lesson you will put clips into a new sequence and build on that sequence to create a short series of clips. Then, you’ll learn how to replace a shot in the Timeline.

Project: Rock Climber Documentary_(student ID)

Duration: 45 Minutes


GOALS


	Adding IN and OUT marks to clips

	Creating a new sequence from a clip

	Adding clips to a sequence

	Replacing a shot in the sequence

	Removing IN and OUT marks on clips and sequences






Deciding Which Part of a Clip to Use

For any given moment in a film, the editor decides what the audience needs to see and hear, when they need to see and hear it, and for how long. The camera supplies all the raw material from which they select the best shot, and then the best part of that shot. They then decide where in the sequence the shot best serves the needs of the story.

But a first choice won’t always be the right choice. Editors will often try different approaches and see if one clip works better than another. Media Composer provides many tools to make the creative editing process simple and straight forward.




Getting Started

In order to follow the steps in this lesson, launch Media Composer | First and open the Rock Climber Documentary_(student ID) project. You have already set up the bins and ingested media files, so you’re ready to start editing.


Selecting Your First Shot

Open the Clips and Sequences bins. From the Clips bin, locate the following clips and play through them in the Source monitor. (Remember, to do this, double click the clip icon.)


	R05_55 Rock-EditStock

	R8_114 SLOW Wall Fingers-EditStock

	R8_117 SLOW Wall Fingers Reverse-EditStock

	R8_105 SLOW Wall Stare-EditStock



Think about how the four shots might be used to create a short sequence. In each of the two wide shots of the climber walking towards the rock face, he slides his right hand across the boulder. There is also the close-up of his hand moving across the rock. There are a few ways you could edit these four shots together—the steps outlined in this lesson are only one approach you might take.

Now that you have watched all the clips, you don’t need to search for them again in the bin. At the top of the Source monitor, click on the Clip Name menu displaying the clip name that is highlighted in green, as show in figure 5.1.


[image: Figure 5.1 The Clip Name menu shows your recently viewed clips.]
Figure 5.1 The Clip Name menu shows your recently viewed clips.



All the clips that you have viewed are listed in the drop-down list. From the drop-down list, select the clip R8_117 SLOW Wall Finger Reverse to open in the Source monitor.


[image: Figure 5.2 In the Source monitor, clip R8_117 SLOW Wall Finger Reverse is loaded.]
Figure 5.2 In the Source monitor, clip R8_117 SLOW Wall Finger Reverse is loaded.






To Mark an IN Point:


	□ Play the clip and place the position indicator on the frame just before the climber begins to put his hand on the rock face.

	□ Click the Mark IN button under the Source monitor, or

	Press the I key on the keyboard. (It is easy to remember ‘I’ for ‘In’.)









To Mark an OUT Point:


	□ Play the clip and count 2 ½ of his steps along the wall. It is a slow motion shot so it will run about 6 seconds. Place the position indicator where you plan to leave the OUT mark.

	□ Click the Mark OUT button under the Source monitor, or

	Press the O key on the keyboard. (It is easy to remember ‘O’ for ‘Out’.)






Notice that the green position bar under the Source monitor shows you the IN and OUT mark symbols, which match the buttons below the position bar, as shown in Figure 5.3.


[image: Figure 5.3 IN and OUT Marks in the position bar of the Source monitor.]
Figure 5.3 IN and OUT Marks in the position bar of the Source monitor.



When the Source monitor is the active window, the Center Duration display at the top of the Composer window is an easy way to see the duration between the IN and OUT marks. This display shows you, in timecode format, the duration between the IN and OUT marks.


[image: Figure 5.4 The Center Duration display shows a marked clip that is 5 seconds and 16 frames long.]
Figure 5.4 The Center Duration display shows a marked clip that is 5 seconds and 16 frames long.






To Play a Clip from IN to OUT:


	□ Press the 6 key on the QWERTY section of your keyboard.



If you change your mind about the IN point or the OUT point, just redo the marks where you want them. The marks in the green position bar, as well as the Center Duration value, will be updated.






Adding a Clip to the Timeline


To Add a Clip to the Timeline:


	□ Click and drag the image in the Source monitor into the Timeline, or

	Click and drag the thumbnail or clip icon from the bin into the Timeline






The Select window might open, asking you to choose which bin to save the new sequence in, as shown in figure 5.5. The window will only show you the bins that are open. If you want, you could click on New Bin and create a bin to put your sequence in.


[image: Figure 5.5 Select the bin where you want to save the sequence.]
Figure 5.5 Select the bin where you want to save the sequence.



When you drag a clip into an empty Timeline, the Project Properties dialog box will open, as shown in Figure 5.6. This dialog box gives you the option of either matching the project’s Raster (frame size) and Edit Rate (frame rate) to those of the clip or allowing you to select another combination of settings from the dropdown menu lists in the window. Unless you have a good reason to change from the default settings, press the OK button.


[image: Figure 5.6 The Project Properties window.]
Figure 5.6 The Project Properties window.



The clip will be added to the Timeline. If you have used any other video editing software in the past, you will be familiar with the concept of a timeline. The Media Composer Timeline shows you the clips that you’re editing. In the example shown in Figure 5.7 the sequence has two horizontal tracks—V1 for the video and A1 for the audio.


[image: Figure 5.7 A clip edited into the Timeline.]
Figure 5.7 A clip edited into the Timeline.



The sequence also appears in the right-hand screen of the Composer window (this area of the Composer window is called the Record monitor).

The Timeline will now show you the video and audio of the section of the clip that you marked (or if you drag an entire clip without IN and OUT marks, it will show the entire clip). Go back to the start of the sequence by dragging the blue position indicator (in either the Timeline or under the Record monitor) to the start. Play the sequence to check the result.






Adding More Clips to Your Sequence

Now you have one segment in your sequence—but you’ll need to add more.



[image: chpt_fig_279.jpg]


DID YOU KNOW ABOUT SEGMENTS?

In Media Composer, once your clips are put into a timeline, they are referred to as “Segments”. This helps with clarity when working. When you hear the word “Clip” you should think of clips in a bin. When you hear the word “Segment” you should think of edited media in the sequence.

The Timeline holds our Sequences.

The Sequences hold our Segments.

The Segments hold Segment Effects, like Color Correction, Resize, and so much more!




To Add Two More Clips into the Timeline Using Drag and Drop:


	□ Go back into your bin and find R8_112 SLOW Fingers Wall-EditStock.

	□ Create IN and OUT marks around a portion of the clip where his fingers are moving against the wall, and then he pulls them away. It’s the end of the clip.

	Mark the OUT point right after his hand leaves the frame.




	□ Click and drag your clip from the Source monitor to the Timeline. Drag the clip to the end of the segment so the new clip is added after the first one.

	□ In the bin, find the clip R8_105 SLOW Wall Stare-EditStock.

	□ Create IN and OUT marks for 4 seconds around a portion of the clip where he isn’t talking, and the camera isn’t moving a lot.

	□ Click and drag your clip from the Source monitor to the Timeline. Try to drop the clip at the end of your second clip.

	You should now have three clips in your timeline. Your sequence should resemble Figure 5.8. Play your sequence back to watch your work.







[image: Figure 5.8 A second and third segment has been added in the sequence.]
Figure 5.8 A second and third segment has been added in the sequence.





[image: chpt_fig_278.jpg]


STOP & THINK

Before you continue editing, Stop and Think:


	What happened to the new sequence you created? Where did it go? What was it named?

	When you dragged and dropped the clip into the empty timeline, you created a new sequence. By default, it was called “Untitled Sequence.01”. It’s never a good idea to leave something “Untitled”. Always go back to the sequence you created and give the sequence a name that makes sense.








To Rename a Sequence:


	□ Find the sequence.

	If you can’t find it, look in all of the bins for the sequence icon.




	□ Click on the name of the sequence and rename it Rock Climber Version 1








Replacing a Shot in the Timeline

Let’s assume that you decide that you don’t like the third shot in the sequence—the close-up shot of the rock climber. You can easily drag-and-drop a new clip on top of the existing clip to replace that shot. But that might not be very precise, and it would affect the timing in your sequence. Instead, let’s mark the segment in the Timeline to help us replace the shot.

You can use marks anywhere in the Timeline to overwrite shots. For instance, you could add an IN mark halfway through one shot and add an OUT mark halfway through another. If the duration of the replacement shot is at least as long as the marks in the Timeline, the shot will be replaced.


To Replace the Third Shot in the Sequence:


	□ Turn off track A2 (by clicking on the record track selector) on the sequence side so only the V1 and A1 tracks are active. They will be highlighted blue while the A2 track selector will be grey, as shown in figure 5.9.




[image: Figure 5.9 The Track Selector panel for the sequence, with track A2 turned off.]
Figure 5.9 The Track Selector panel for the sequence, with track A2 turned off.




	□ In the Timeline, park the blue position indicator anywhere within the third segment.

	□ At the top of the Timeline, click the Mark Clip button. [image: chpt_fig_059.jpg] The entire segment in the Timeline is marked from in to out.

	You can also press the T key on the keyboard.

	Notice that only the segments on the V1 and A1 tracks are highlighted between the IN and OUT marks. If the track selector for A2 had been turned on, then it would have forced the entire timeline to be marked. You only need to activate the tracks that you want to work on.

	Ignore the Timecode Ruler track selector, because you cannot add video or audio into the Timecode Ruler.




	□ In the Clips bin, locate the R8_117 SLOW Wall Fingers Reverse-EditStock clip again and open it in the Source monitor.

	If you scrub through the clip by dragging the position indicator at the bottom of the Source monitor, you see his hand come off the rock and he looks up.




	□ Mark an IN point around the time his hand is coming off of the wall. You do not need to mark an OUT point.

	Media Composer will only use 3 marks to create the edit. If you add an OUT mark, it will be ignored.




	□ Drag-and-drop the new clip on top of the clip you want to replace. When you drag it next to the IN point on the Timeline, it snaps to the IN mark, and fits itself into the existing segment. You’ve successfully replaced that shot in the Timeline.

	□ Play your sequence to review your work.








Removing Marks from the Timeline


To Remove Marks from the Timeline:

Click the Clear Marks button. [image: chpt_fig_060.jpg] This button appears to the right of the Mark Clip button at the top of the Timeline. The keyboard shortcut to clear IN and OUT marks is the G key.






Lesson 5 Review & Discussion Questions


	What is the Clip Name menu and why would you use it?

	What does adding an IN mark and an OUT mark to a source clip allow you to do?

	What keyboard shortcuts allow you to add IN and OUT marks?

	How can you move a clip from the Source monitor into the Timeline?

	What is a segment?

	What is the fastest way to mark a clip from IN to OUT in the Timeline?

	How do you rename a sequence?

	True or False: When you have IN and OUT marks on the Timeline you only need to add an IN mark to the source clip.

	What do the track selectors in the Track Selector panel allow you to do?

	What’s the keyboard shortcut to clear all IN and OUT marks?






EXERCISE 5

[image: chpt_fig_015.jpg] Getting Started Editing

Project: Rock Climber Documentary_(student ID)

Duration: 25 Minutes


GOALS


	Open a project and sequence that’s already been created

	Replace a shot in the timeline

	Add two new clips to the sequence






Goal #1: Open a Project and Sequence that’s Already Created


	□ Launch Media Composer | First and open the Rock Climber Documentary_(student ID) project.

	□ Open the Rock Climber Version 1 sequence.






Goal #2: Replace a Shot in the Timeline

The third shot in your sequence is of the rock climbers hand coming off of the rock while he walks forward. Let’s replace it.


	□ Follow the steps in this lesson to replace the last clip in the Timeline with clip R05_55 Rock-EditStock.

	□ Clear your IN and OUT marks when you’re finished.






Goal #3: Add Two New Clips to the Sequence


	□ Find Clip R9_19 Fingers CU-EditStock in the bin

	□ Place IN and OUT marks around the portion of the clip where his hand grabs the rock and gets his hand settled—it should be about 3 seconds long.

	Use the left and right arrow keys to go frame by frame on the clip in the source monitor to get your in and out marks as precise as possible.




	□ Drag-and-drop that clip into the end of your Timeline

	□ Find Clip R05_57 Matt Climbing-EditStock

	□ Place IN and OUT marks around the portion of the clip where the rock climber pulls himself up in one big heave, then reaches for the next part of the rock to grab—it should be about 2 seconds long.

	□ Drag-and-drop that clip into the end of your Timeline

	□ Watch back your sequence and recognize that you’re really editing now! If you’ve followed along, you should have 5 clips in your sequence.

	□ Leave or move the position indicator to the last frame of the sequence








Screenshots Due:


	□ Take a screenshot of your entire screen—showing every clip you edited in the Timeline.











[image: chpt_fig_001.jpg] LESSON 6

Getting Deeper into the Edit

In this lesson, you’ll go a little deeper into audio editing techniques, like learning about waveforms. You don’t know it yet, but audio waveforms are a big deal. You’ll learn about what they are, why they’re helpful, and how to use them efficiently. Then, we will fine tune our edit by adding voiceover to our short montage and cutting out some bothersome audio.

Project: Rock Climber Documentary_(Student ID)

Duration: 45 Minutes


GOALS


	Understanding audio waveforms

	Turning audio waveforms on and off

	Improving visibility of waveforms

	Add a clip’s audio to a sequence

	Using the Add Edit button

	Removing segments from the timeline






Audio Waveforms

An audio waveform is a visual representation of sound. When a sound is loud, the peak of the waveform is large. When the sound is silent, the waveform appears to be a straight line. When you’re editing clips, it’s good practice to always work with waveforms on. Figure 6.1 shows audio segments in a sequence with the waveforms visible.


[image: Figure 6.1 The audio waveforms displayed in two separate segments in the sequence.]
Figure 6.1 The audio waveforms displayed in two separate segments in the sequence.



Knowing how to use the audio waveform can be very helpful when trying to identify sounds that you want to remove from a sequence. For example, it’s normal for people to say ‘um’ or ‘ah’ when they are talking. Editors spend a lot of time and effort removing the ‘ums’ and ‘ahs’ in interviews. Working with audio waveforms also helps editors to remove unnecessary gaps of silence when people are talking.

The height of the waveform shows how loud a sound is at a moment in time. The taller the waveform, the louder the sound. With a little experience, you will be able to identify different sounds by just by looking at the waveform. This is very useful when trying to locate when someone is speaking. Each word can look like a small bundle of ripples with gaps in between.




Displaying Audio Waveforms

By default, Media Composer | First automatically displays waveforms for all tracks. You can turn waveforms on or off on all tracks from the Track Control panel.


To Turn Waveforms On or Off:


	□ At the top left of the Timeline, click the small disclosure triangle to the right of the timecode display, shown in figure 6.2.

	A set of additional tools called the Track Control panel opens beside the Track Selector panel




	□ Click the waveform buttons for the tracks you want to see.

	□ To turn waveforms on or off on all tracks, hold down Alt (Windows) or Option (Mac) while clicking the waveform button in the Track Control panel.




[image: Figure 6.2 The Track Control panel contains useful per-track audio controls, like making waveforms visible.]
Figure 6.2 The Track Control panel contains useful per-track audio controls, like making waveforms visible.



To help you see the waveform more clearly, you can zoom into the Timeline so the gaps between words become easier to see. At the bottom of the Timeline, click and drag the slider in the Scale Bar, as shown in figure 6.3. As you drag to the right, you zoom into your Timeline. Drag to the left, and you’ll zoom out. The default keyboard shortcuts to zoom in are Ctrl+] (Windows) or Command+] (Mac). To zoom out, it’s Ctrl+[ (Windows) or Command+[ (Mac).


[image: Figure 6.3 The Scale Bar.]
Figure 6.3 The Scale Bar.



Another useful way to identify sounds in the Timeline is to solo a track so that it is the only track you can hear. In the Track Control panel, click the S button beside the track that you want to isolate, and you will hear only that track. The other audio tracks will automatically be muted so you cannot hear them.

To mute a track, click the M button beside the track you want to mute.


[image: Figure 6.4 The Solo and Mute buttons selected in the Track Control panel.]
Figure 6.4 The Solo and Mute buttons selected in the Track Control panel.








Improving the Visibility of the Waveform

Zooming in and out of the Timeline and using Solo and Mute is incredibly useful. However, depending on the recorded volume of the audio, the height of the waveform may be too small or too large to see. Music clips, for instance, often appear as solid black waveforms that fill the track from top to bottom. That is because they are generally very loud. To fix this, you can adjust the height of the waveforms so that you will be able to see them better.


To Increase the Height of a Waveform:


	□ Turn on the audio track you want to adjust (To turn on or off a track, click its track selector. If the track selector is gray, the track is “off”. If the track selector is blue or green, the track is “on”)

	□ Press Ctrl+Alt+L (Windows) or Command+Option+L (Mac).

	Tap the L key multiple times to continue to make the waveforms larger.









To Decrease the Height of a Waveform:


	□ Turn on the audio track you want to adjust.

	□ Press Ctrl+Alt+K (Windows) or Command+Option+K (Mac).








Adding Only a Clip’s Audio

You already learned how to drag and drop clips onto the Timeline… but what if you want to add a clip’s audio to the Timeline, and not its video? You can do that too. This type of editing decision is sometimes made to add additional context to a visual through an interview clip or narration.

To avoid overwriting video when you only want to add audio, you again need to use the Track Selector panel to turn on (enable) and turn off (disable) your tracks.

There are two different track selectors.


	Source track selectors are the green track selectors on the left side of the panel. These are the tracks for the source clip that is opened in the Composer window.

	Record track selectors are the blue track selectors on the right side of the panel. These are the tracks that are in your sequence.




[image: Figure 6.5 The source and record track selectors]
Figure 6.5 The source and record track selectors



Let’s add some audio to our Rock Climber Version 1 sequence.


To Add Only Audio to a Sequence:


	□ Open the “Rock Climber Documentary_(Student ID)”

	□ Open your Rock Climber Version 1 sequence.

	□ In the Clips bin, locate the clip R02_02(b) Interview-EditStock and open it in the Source monitor. At the beginning of the clip, mark IN and OUT around the words, ‘The approach to the rock is one of the bigger things that, ah, captured me into rock climbing.’





[image: chpt_fig_278.jpg]


STOP & THINK

Before you drag and drop your clip down into the Timeline, you have to Stop and Think:


	Check your tracks - What do 1 want to move into the Timeline—just the video? (Then only turn on the V1 track) Just the audio? (Then only turn on the A1 track) Or both? (Turn on both the V1 and A1 track selectors)






	□ Because you only want to add audio, turn off the V1 source track selectors (they will turn grey).

	Don’t turn off the A1 source track selector since that contains the audio we want to add in.




	□ In the Timeline, park the position indicator towards the end of the first clip in your sequence. Drag-and-drop the clip from the Source monitor to A2 of the Timeline so it snaps to the position indicator.

	If you’ve completed these steps correctly, you should hear the audio while watching your 3 clips that you put together in a previous lesson. The audio is now included in your sequence. Play your sequence back and admire your hard work!











Using the Add Edit Button

The Add Edit button can be found in the toolbar at the top of the Timeline.


[image: Figure 6.6 The Add Edit button.]
Figure 6.6 The Add Edit button.



The Add Edit button allows you to divide a segment in the Timeline. When you press it, you slice a clip into two pieces at the point where you park the blue position indicator. You can use it to remove unwanted parts of a segment, instead of the whole clip.

If you’re working along with the lesson, listen to the segment R02_02b Interview-EditStock and watch the audio waveform as it plays back.

Figure 6.7 shows the waveform of the audio clip where the climber says, ‘The approach to the rock is one of the bigger, ah, things that capture me into rock climbing.’ In this line you want to remove the sound ‘ah’.


[image: Figure 6.7 A2 in the Timeline showing the audio waveform while the rock climber talks.]
Figure 6.7 A2 in the Timeline showing the audio waveform while the rock climber talks.



You only want to clean up the audio which is on track A2, so turn off all the record track selectors except for A2.


To Clean up the Audio:


	□ Use your Solo and Mute buttons to help you in these next few steps.

	□ In the Timeline, park the blue position indicator just in front of the word, ‘…ah.’

	□ Make sure that only the A2 record track selector is on.

	□ Click the Add Edit button in the tool bar at the top of the Timeline window (or alternatively press the H key on the keyboard). An edit has now been applied to the segment on A2 at that position in the Timeline, and the single audio clip has been split in two.



Figure 6.8 shows what happens when you add an edit. This small white ‘=’ sign on the cut shows that the frames on each side of the edit are contiguous, meaning they are sequential frames in the clip.


[image: Figure 6.8 After you use the Add Edit button in the audio segment.]
Figure 6.8 After you use the Add Edit button in the audio segment.




	□ Reposition the blue position indicator just in front of the words, ‘…things that capture me into rock climbing.’

	It is a very narrow gap in the waveform so be careful where you park the position indicator. Remember, you can use the Scale Bar or keyboard shortcuts to zoom into your Timeline and be more precise.




	□ Click the Add Edit button again and the segment will be divided at the frame where you are parked.

	□ Hold Alt (Windows) or Option (Mac) and click the arrow icon [image: chpt_fig_069.jpg] it the top-left of the Timeline until it turns red to turn on Lift/Overwrite. (The i between red/yellow split, yellow, and red). This is the Segment Mode tool an it in greater detail in Lesson 7.

	□ With red the Lift/Overwrite tool active, click the segment between the two edits (where he says ‘ah’) Figure 6.9 shows the selected segment is highlighted in grey.




[image: Figure 6.9 Selected ‘ah’ audio segment.]
Figure 6.9 Selected ‘ah’ audio segment.




	□ With the segment in the Timeline selected, press the Delete or Backspace key on the keyboard. Figure 6.10 shows the result - the segment is removed from the Timeline. Because Lift/Overwrite lifts material out of the Timeline, it leaves a gap, and the other segments remain where they are.




[image: Figure 6.10 The selected segment is gone after pressing delete or backspace.]
Figure 6.10 The selected segment is gone after pressing delete or backspace.




	□ Use the Lift/Overwrite tool to drag the second part of the audio clip to the left until it snaps to the first part, as shown in figure 6.11.




[image: Figure 6.11 The selected segment slides to the left to close the gap.]
Figure 6.11 The selected segment slides to the left to close the gap.




	□ Play the sequence to hear how much better the sentence sounds.

	Remember, if you don’t like the result, you can always undo the edit by pressing Ctrl+Z (Windows) and Command+Z (Mac) and try again.











Lesson 6 Review & Discussion Questions


	Before dragging and dropping your clip onto the Timeline, what should you stop and think about?

	How do you open and close the Track Control panel?

	How can you change the size of an audio waveform in the Timeline and make it larger?

	How can you change the size of an audio waveform in the Timeline and make it smaller?

	How can you quickly turn on or off waveforms on all audio tracks?

	How can you listen to a single audio track?

	How can you turn off an audio track so you cannot hear it?

	How can you remove a shot from the sequence and leave a gap (or filler)?

	What does this button do? [image: chpt_fig_073.jpg]

	What is the keyboard shortcut for Undo?






EXERCISE 6

[image: chpt_fig_015.jpg] Getting Deeper into the Edit

Project: Rock Climber Documentary_(student ID)

Duration: 45 Minutes


GOALS


	Replace a shot to match the audio

	Add only a clip’s audio

	Add music to a sequence

	Add in multiple shots to create a small montage






Goal #1: Replace a Shot to Match the Audio

In your Rock Climber 1 sequence, the third clip in the sequence is a shot of trees. When you first edited it into the sequence it looked OK. But since you added the voiceover, it obviously doesn’t work as well.


Why?

When there was no voiceover, the sequence shows the rock climber walking, then you cut to the shot of the trees and the audience will understand that time is passing, since in the next couple shots he is climbing the rock. It’s amazing how our brains work when we are watching edited films—10 seconds of a clip is more than enough to tell our audience that several hours have passed!

But when you added the narration, the audience knows something more about what he is doing. He is approaching the rock to climb it. The shot of the trees is now contradicting what he is saying and as a result the meaning is confused—and we need a shot of him approaching the rock to go with the audio.


	□ In the Rock Climber Documentary_(Student ID) project, open your Rock Climber 1 sequence.

	□ Find the shot, R8_114 SLOW Wall Fingers-EditStock and open it in the Source monitor.

	□ Mark an IN after his fingers slip off the side of the rock.

	□ In the Timeline, use the Mark Clip button or the T key to mark IN to OUT of both V1 and A1 of the tree segment.

	The clip name of the tree segment is R05_55 Rock-EditStock

	If you don’t see this segment in your timeline, you’ll need to go back to Goal #2 of Exercise 5.




	□ Drag and drop the R8_114 SLOW Wall Fingers-EditStock clip to overwrite the tree segment.

	□ Watch through the sequence to see whether the replacement shot is better.








Goal #2: Add Only a Clip’s Audio


	□ Open the clip R02_02(b) Interview-EditStock

	□ Using the timecode at the top of the Source monitor, move your position indicator to about 09:03:00

	□ Mark an IN point before the climber says, ‘It gives me a chance to meditate, um, to think about what I’m about to do as I get, ah, to the rock.’ and mark OUT after he finishes that statement.

	□ In the Timeline, park the blue position indicator or add an IN mark just after the cut to the third video segment in the timeline—after the shot you’ve just replaced.

	□ You don’t want to edit the video from the interview clip into the sequence, so in the Track Panel turn off the V1’s source track selector.

	□ Drag-and-drop the audio onto the Timeline.

	As you continue to edit, try to keep all the audio from the interview on A2 of the Timeline and keep any other audio, like natural sound, on A1 of the Timeline.









Goal #3: Add Music to the Sequence


	□ In your project’s Music bin, you should have three music clips.

	□ View the Music bin in Text view. The clip you need for your sequence is 179_short_we-are-young-we-are-free_0037.

	□ Open the clip in the Source monitor.

	□ Play the music track in the Source monitor. It is a fast paced, high-energy track that will work well as the climber gets started in his journey.

	□ Drag-and-drop the music into your Timeline underneath tracks A1 and A2, so that the song starts at the beginning of your sequence. The music will be placed onto newly created A3 and A4 tracks.

	Even though your sequence didn’t have tracks A3 and A4, when you drag the music down to the timeline past A1 and A2, Media Composer automatically creates the audio tracks for you.

	When you view the audio waveform of the clip in A3 and A4, the waveform is a solid block of grey or black.




	□ Reduce the height of the waveform in A3 and A4 until you can clearly see the shape of the audio waveform, as shown in figure 6.12.




[image: Figure 6.12 Reducing the height of the waveform display so that it is visible.]
Figure 6.12 Reducing the height of the waveform display so that it is visible.




	When you play the sequence, you will not be able to hear the voice or the natural sound because the music overpowers both tracks.

	We will fix this in later lessons.






Goal #4: Add Multiple Shots to Create a Short Montage


	□ Now drag-and-drop at least 5 more climbing shots after the last shot of the sequence to fill it through the end of the music in the Timeline.

	Try your best to use the waveforms as a guide to cut to the rhythm and beat of the music. To do this, you can set IN and OUT marks in the Timeline before you drag and drop a clip.

	Try to find a series of shots that depict a progression of climbing up the rock wall.




	□ After playing back your sequence, leave your position indicator on the last frame of the sequence.








Screenshots Due:


	□ Take a screenshot of your entire sequence, so that all V1 segments, 2 A2 segments, and the music are visible in the Timeline.











[image: chpt_fig_001.jpg] LESSON 7

Segment Mode Tools

Media Composer has something called Segment mode—this is a powerful mode that allows you to do different things by clicking only one button. In this lesson, you’ll learn all about the tools in Segment mode and how they can help you put clips into the Timeline, and move and remove segments from your sequence.

Segment mode includes two tools—a red arrow and yellow arrow, and each has a different function and purpose. The two segment tools will help you edit faster, if you use them properly!

Project: Rock Climber Documentary_(Student ID)

Duration: 60 Minutes


GOALS


	Understand Segment mode

	Duplicate a sequence to create a backup of your work

	Use the Overwrite function to put clips in the Timeline

	Use the Splice-in function to put clips in the Timeline

	Moving segments around in the timeline with segment tools

	Deleting segments using segment tools

	Removing material from the sequence using Lift and Overwrite






Segment Mode Tools

To say it simply, Segment mode includes two tools—the red Lift/Overwrite tool and yellow Extract/Splice-in tool. You can access these tools through the red/yellow button located on the left-side of the Timeline palette.

Segment tools allow you to edit a clip into the Timeline and move segments around in the Timeline—but depending on the color of the tool, your tool will do different things. Before we get into that, let’s learn about the name “Segment mode.”


Why Is It Called Segment Mode?

As a reminder, Media Composer differentiates clips in a bin and clips in a sequence. When a clip is in a bin, it’s called a clip. When a clip is put into a sequence, it’s called a segment. Try to keep that in mind during this lesson.

Segment mode - includes two tools that allow you to select and move segments around in the Timeline.

The two segment tools are:


	Lift/Overwrite (Red): When moving segments around, this tool overwrites other segments, and will leave behind blank space (called filler.) It does not move other clips in the sequence.

	Extract/Splice-In (Yellow): When moving segments around, this tool will move all other segments further down in the sequence to make room. This tool is great for swapping segments in your Timeline.








Automatic Selection of Segment Tools

The Segment Mode button is a menu that lets you turn on one tool at a time (red or yellow) or both (red and yellow split), as you can see in Figure 7.1. If you turn on both tools, Segment mode becomes a Smart tool so you can automatically switch between the two segment tools as you work within the Timeline.

Which tool you’re working with depends on where the cursor is when you’re positioned over a segment. Throughout this lesson, you can choose to work with this automatic selection, or you can manually turn on/off the modes by using the checkboxes. To access the checkboxes, right click on the Segment Mode button in the top left hand corner of the Timeline palette.


[image: Figure 7.1 Segment mode configured as a Smart tool with both segment tools turned on.]
Figure 7.1 Segment mode configured as a Smart tool with both segment tools turned on.



Figure 7.2 illustrates how the position of the cursor determines which segment tool will be active in the Timeline. Positioning the cursor over the top half of a segment will activate the red Lift/Overwrite tool when you click. Positioning the cursor over the bottom half of a segment will activate yellow Extract/Splice-in tool.


[image: Figure 7.2 On the left, the red Lift/Overwrite tool is activated. On the right, the yellow Extract/Splice-in tool.]
Figure 7.2 On the left, the red Lift/Overwrite tool is activated. On the right, the yellow Extract/Splice-in tool.






Duplicating a Sequence

When you are considering making changes to a sequence, it is always a good idea to make a copy of it first and then make any changes to the duplicate. That way, if you don’t like the changes you’ve made, you can always go back to the original version.


To Duplicate a Sequence:


	□ Open your Rock Climber Documentary_(Student ID)

	□ Find your sequence Rock Climber Version 1

	It should be in your Sequences bin




	□ Select the sequence (by clicking once on the sequence icon) and from the menu bar at the top of the screen, click Edit > Duplicate, or

	Select the sequence and press Ctrl+D (Windows) or Command+D (Mac)

	The copy will be saved in the same bin with .Copy.01 added to the end of the name.




	□ With the sequence name selected, type a new name, Rock Climber Version 2.

	□ If your two sequences are in your Clips bin, move them to the Sequences bin by clicking on the sequence icon and dragging it over to a bin tab or bin icon in the Bin Container sidebar.

	□ Open Rock Climber Version 2 by double clicking the Sequence icon.

	The sequence name displayed in the upper right-hand corner will show the active sequence’s name (in this case, it will read Rock Climber Version 2). Any changes you make to this version will not be reflected in the Rock Climber Version 1 sequence—they are two totally separate sequences.











The Lift/Overwrite Tool

You learned while working with audio that the red arrow (Figure 7.3) allows you to move segments in the sequence. When you use the red arrow, you overwrite any other segment in the sequence.


[image: Figure 7.3 The Lift/Overwrite tool.]
Figure 7.3 The Lift/Overwrite tool.



However, the red arrow is better named the Lift/Overwrite tool. When you use this tool to drag-and-drop segments within the Timeline you will be leaving gaps from where you moved the segment—you will have ‘lifted’ the segment, leaving filler behind in the track. When you drop the segment, it overwrites whatever may already be on that track, replacing it with the segment you have moved.

The big advantage of the Lift/Overwrite tool is it doesn’t move other segments around in the Timeline. Apart from the segment that you are moving, all other segments remain exactly where they are.

You had a good example of using Lift/Overwrite when you cleaned up the audio of the rock climber. You used Lift/Overwrite to click on the segment you didn’t want, then you pressed delete and it was deleted.




Overwriting a Clip into the Timeline

Until now, we have been using the drag-and-drop method of getting clips from the Source Browser into the Timeline. While dragging-and-dropping can be quick and easy, it isn’t very precise. Using the Overwrite function is a much more accurate way to work. Let’s practice using it.


	□ Open the R8_105 SLOW Wall Stare-EditStock clip in the Source monitor and mark IN and OUT points around a portion of the clip where he isn’t talking and the camera isn’t shaking too much.

	□ In the Rock Climber Version 2 sequence that you duplicated earlier, move your position indicator the first frame of the sequence (if your keyboard has a home key, you can press it to do this)

	□ Turn on the V1 and A1 tracks on both the source and record track selectors.

	□ Press the Lift/Overwrite button at the bottom of the Source monitor (Figure 7.4) or,

	Press the B key.







[image: Figure 7.4 The red Overwrite button in the Source monitor.]
Figure 7.4 The red Overwrite button in the Source monitor.




	□ The clip overwrites the first clip in the Timeline. Play the sequence and pay attention to what happened.

	The overall duration of your sequence is exactly the same.

	No matter where your position indicator is in the Timeline, when you press the Overwrite button in the Source monitor, the clip will be placed in your sequence and overwrite everything that was there before.

	The clip overwrites everything on all active tracks.




	□ Undo the edit using Ctrl+Z (Windows) or Command+Z (Mac).

	□ In the Timeline, mark an IN point in the middle of your sequence.

	□ Move your position Indicator away from the IN point you just created.

	□ Press the Overwrite button in the Source monitor or press the B key.

	Now that you have an IN point in your sequence, the clip is put into the sequence starting at your IN point, instead of your position indicator.




	□ Undo the overwrite edit.



Let’s try a different method of adding a clip to a sequence.




Splicing a Shot into the Timeline

Instead of editing the shot on top of other clips, you might want to insert a shot between two other clips.

To do this, you will need to use the Splice-in function.


	□ Open the R8_105 SLOW Wall Stare-EditStock clip in the Source monitor and mark IN and OUT points around a portion of the clip where he isn’t talking and the camera isn’t shaking too much.

	You might have IN and OUT marks on your Timeline. If needed, clear the IN and OUT marks on your Timeline by clicking anywhere in your sequence and pressing the G key on your keyboard.




	□ In the Rock Climber Version 2 sequence that you made earlier, move your position indicator in between the second and third clips and mark an IN point. Try to get your position indicator right on the cut point by snapping.

	By default, Media Composer | First keeps snapping on at all times.








[image: chpt_fig_279.jpg]


DID YOU KNOW ABOUT SNAPPING?

Imagine holding two very large magnets in both of your hands. As the two magnets get closer, they want to snap together. Once the two magnets are close enough to each other, they will physically slam together. This is similar to how snapping works.

Snapping snaps your position indicator to an edit point. It will also snap segments to each other as you move them around the timeline.

To toggle snapping, hold down the Ctrl (Windows) or Command (Mac) key on your keyboard as you move your position indicator or segments around the timeline.

When you work with snapping on, your edits will be more precise, and you’I be less prone to “flash frames” - little frames of footage or black holes that are accidentally in your Timeline. When you work with snapping off, you’ll have more control over where you’re putting your segments. It’s up to you to decide what will work best while you’re editing.




	□ Turn off the V2 (if there is a V2), A2, A3, and A4 record track selectors in your Timeline.

	□ Turn on the V1 and A1 tracks on both the source and record track selectors.

	□ Press the yellow Splice-In button at the bottom of the Source monitor (Figure 7.5) or,

	Press the V key.







[image: Figure 7.5 The yellow Splice-in button in the Source monitor.]
Figure 7.5 The yellow Splice-in button in the Source monitor.




	□ Play your sequence back and watch what happened

	The overall duration of your sequence is now longer.

	The clip was inserted between the original two shots in the Timeline. Any segments in the Timeline to the right of the edit moved later to make room for the new shot while any segments to the left remained where they were.




	□ Undo the edit using Ctrl+Z or Command+Z.

	□ In the Timeline, mark an IN point in the middle of your third clip, after the climber begins to look up at the rock.

	□ Move your position indicator away from the IN point you just created.

	□ Press the Splice-in button in the Source monitor, or press the V key.

	Now, you’ve split the third clip into two clips, and inserted the close-up in the middle.

	Your sequence is longer.

	You did not lose any part of the third clip—only inserted your close-up to add some drama.




	□ Undo the edit.




Overwriting a Shot into the Timeline - Using Drag-and-Drop

If you prefer to drag-and-drop your clip from the Source monitor to the Timeline, but want to make sure it’s an Overwrite edit, here’s how.


	□ Right-click the Segment Mode button in the Timeline palette and a menu will appear, as you can see in figure 7.6. Make sure that only the red Lift/Overwrite tool is selected.

	Dragging-and-dropping the clip with these settings will overwrite the shot into the sequence.







[image: Figure 7.6 The Lift/Overwrite tool is active when dragging-and-dropping.]
Figure 7.6 The Lift/Overwrite tool is active when dragging-and-dropping.






Splicing a Shot into the Timeline - Using Drag-and-Drop

If you want to make a Splice-in edit, instead of an Overwrite edit, here’s how.


	□ De-select the red Lift/Overwrite tool and select the yellow Extract/Splice-in tool.

[image: Figure 7.7 The Extract/Splice-in tool is now active for dragging-and-dropping.]
Figure 7.7 The Extract/Splice-in tool is now active for dragging-and-dropping.




	Remember, a Splice-in never replaces any footage already in the Timeline—it simply moves all other clips down the sequence to make room for the clip you want to insert.




	□ Load the R03_04 Walking-EditStock clip into the Source monitor and pick the best 3 seconds of the shot.

	Remember to use your Center Duration display in the Composer window to create a 3 second clip.

	To replace IN and OUT points, simply re-do them by using the Mark IN button in the Source monitor or on your keyboard.




	□ Drag-and-drop the new clip to the very beginning of the sequence.

	The entire sequence moves over, making room for the R03_04 Walking-EditStock clip at the beginning of your sequence.








[image: chpt_fig_278.jpg]


STOP & THINK

Before you drag and drop your clip down into the Timeline, you have to Stop and Think:

Do 1 want to overwrite the footage in my sequence, or splice-in my new clip?

The Lift/Overwrite tool is default, so dragging-and-dropping will always perform an overwrite edit regardless of whether the its segment tool is turned on or off.

If you want to perform a Splice-in edit by dragging and dropping, the Extract/Splice-in tool must be selected and turned on, indicated by the light grey highlight on the Segment mode button. If you have the button selected, but the Extract/Splice-in tool is not turned on, dragging-and-dropping will result in an Overwrite edit.

If you would prefer the Splice-in edit to be the default Segment mode, then you can change it under the edit tab of the Timeline settings. You find it by going to the menu bar and selecting: Avid Media Composer > Preferences… > User tab > Timeline > Edit tab > Default Segment Tool.








Moving Segments in the Timeline

We’ve just learned how Overwrite places clips into the Timeline over the existing footage, and how the Splice-in inserts a new clip between existing clips on the Timeline.

Media Composer’s segment tools function the same way when you’re moving clips around the Timeline.


Lift/Overwrite Tool:

Moving segments with the Lift/Overwrite tool (Figure 7.8) replaces material already in the sequence. Lift/Overwrite is the perfect tool for quickly moving clips around in the Timeline, but be careful! Once you overwrite a clip, unless you undo it quickly, you may not be able to get that clip back because Overwrite leaves filler in the sequence.


[image: Figure 7.8 The Lift/Overwrite tool, is the best tool for reordering segments in the sequence.]
Figure 7.8 The Lift/Overwrite tool, is the best tool for reordering segments in the sequence.





[image: chpt_fig_279.jpg]


DID YOU KNOW ABOUT FILLER?

Filler refers to the empty, editable space in the Timeline.

The term comes from editing with film—filler was the blank celluloid film used to keep picture and soundtracks in sync whenever there was a temporary gap in one or the other during the editing process.

If you’ve used other editing applications, you may be familiar with the term “slug.” Filler and slug serve the same purpose—but filler can be edited.

In Media Composer, you can manipulate filler in the same ways you edit video or audio segments. You can add edits to it, trim it, apply effects to it, and more. This is different from any other editing application, and provides some real advantages, specifically with regard to trimming and working with effects.






To Activate and Move Segments with Lift/Overwrite:


	□ Right-click the Segment Mode button in the Timeline palette.

	□ If needed, deselect the yellow Splice/Extract tool and select the red Lift/Overwrite tool.

	□ Click on segments in the Timeline and move them around in your sequence.

	Notice that other segments are being overwritten with the segment you are moving.

	Once you replace a segment entirely, you will leave behind filler in the Timeline.




	□ Undo any edits you don’t like by holding down Ctrl (Windows) or Command (Mac) and repeatedly tapping the Z key.








Link Selection Toggle

When moving segments around, if you found only the segment on V1 was highlighted (like in Figure 7.9) you can turn on Link Selection Toggle button (Figure 7.10) to ensure both the video and audio will be selected. You’ll find it at the top of the Timeline palette.


[image: Figure 7.9 If when selecting a segment, and only the video is selected, its corresponding audio will not move with it.]
Figure 7.9 If when selecting a segment, and only the video is selected, its corresponding audio will not move with it.




[image: Figure 7.10 The Link Selection Toggle button.]
Figure 7.10 The Link Selection Toggle button.




To Select a Segment’s Video and Audio before Moving Them:


	□ Turn on the Link Selection Toggle button.

	□ Select a clip on your Timeline and move it.

	When the Linked Selection Toggle button is off, you can also Shift+Click separate segments on any track to select and move them together.











Extract/Splice-ln Tool:

When you are editing, especially if you’re editing a montage or music video, it’s common to change the order of shots (also known as swapping shots) as you explore different ways to tell your story. Extract/Splice-in (Figure 7.11) is the tool of choice for doing this kind of work.


[image: Figure 7.11 The Extract/Splice-in tool is the best for swapping shots in the sequence.]
Figure 7.11 The Extract/Splice-in tool is the best for swapping shots in the sequence.



When you click and drag a clip within the Timeline with Extract/Splice-in, this tool extracts the clip from its original position and removes the empty space left behind. When you drop the clip, the tool splices it in at its new position, and all following clips move later in the Timeline to make room.



Moving Segments with Extract/Splice-ln:


	□ In the Rock Climber Version 2 sequence, locate the second shot, the clip R8_112 SLOW Fingers Wall. It is the closeup shot of the hand running along the wall and it should be between the two wider shots of the climber walking beside and touching the rock.

	□ Make sure the Extract/Splice-In tool is selected and active (Figure 7.11).

	□ With the Link Selection Toggle button on, in the Timeline, click the video segment of the clip R8_112 SLOW Fingers Wall, as shown in figure 7.12. Both segments on V1 and A1 should become highlighted to show they have both been selected.




[image: Figure 7.12 Both V1 and A1 segments highlighted.]
Figure 7.12 Both V1 and A1 segments highlighted.




	□ With the segments on V1 and A1 selected, click and drag the shot to the left until it snaps to the beginning of the timeline.

	The shots have now been reordered, since clip R8_112 SLOW Fingers Wall moved to the beginning of the sequence without creating gaps or replacing footage. The duration of the sequence stays the same.

	When you play from the start of the sequence you can decide which version works best.

	You don’t always have to snap segments to edit points. You can move a segment wherever you want in the sequence by temporarily disabling snapping. To do this, hold down Command (Mac) or Alt (Windows) while dragging your clip around in the timeline.

	Using the Extract/Splice-in function to drop a segment within another clip will split the clip in half as the Timeline makes room for the segment you are moving.

	Notice that Media Composer updates the sequence as you drag the segment. This makes it easy to see what is going to happen in the sequence even before you make the final placement.

	By turning off the Link Selection Toggle button, you can move individual video or audio segments around without moving the other segments that are associated with it. But be warned, it can be easy to get your video and audio out of sync. For instance, if you only move a video segment, other video segments will also shift position to accommodate the one you are moving, but the audio segments will remain where they are. The result can be a video track out of sync with its audio.

	To learn more about what sync means, and how to fix it, see lesson 8.











Deleting a Segment Using Segment Tools

You have seen how the Lift/Overwrite and Extract/Splice-in tools allow you to add and move clips around in the Timeline. You can also use these segment tools to delete segments from the Timeline. Depending on what tool is active, when you click on a segment with your arrow and press delete, different things will happen.

Deleting a segment using Lift/Overwrite—This will delete the segment and leave filler in your sequence. The duration stays the same, and no other shots in the Timeline are moved.

Deleting a segment using Extract/Splice-in—This will remove the segment, move downstream clips in the sequence back to the left, removing the gap left behind from by the deleted clip.


To Delete a Segment Using Lift/Overwrite:


	□ Right-click the Segment Mode button in the Timeline palette.

	□ If needed, deselect Extract/Splice-in and select Lift/Overwrite.

	□ Click on a segment you want to delete.

	With the Link Selection Toggle button turned on, all associated segments in the Timeline will be selected.




	□ Press the Delete or Backspace key on the keyboard.

	The segment is removed and in its place is filler in your sequence.









To Delete a Segment Using Extract/Splice-ln:


	□ Select the Extract/Splice-In from the Segment Mode button’s menu.

	□ If needed, first deselect Lift/Overwrite and then select Extract/Splice-in.

	□ Click a segment you want to delete.

	With the Link Selection Toggle button turned on, all associated segments in the Timeline will be selected.




	□ Press the Delete or Backspace key on the keyboard.

	The segment is deleted from the sequence, and there is no gap. All segments to the right of the deleted clip move back to the left to close the deleted clip’s gap.






In Figure 7.13, the R8_112 SLOW Fingers Wall segment has been selected using the Extract/Splice-tool. Both the video and the associated audio segment are highlighted.


[image: Figure 7.13 Both video and audio segments of the R8_112 segment are selected using the Extract/Splice-in tool.]
Figure 7.13 Both video and audio segments of the R8_112 segment are selected using the Extract/Splice-in tool.



Figure 7.14 shows that when the segments are deleted, the gaps created on tracks V1 and A1 are closed, but the segments on A2 remain relative to their corresponding video tracks.


[image: Figure 7.14 The segment’s video and audio are extracted and the gap closed.]
Figure 7.14 The segment’s video and audio are extracted and the gap closed.








Removing Material from a Sequence

Creating a rough cut is not just a constant process of adding material and making the sequence longer and longer. There are plenty of times when you will want to remove large chunks of material from the sequence at once, not just one segment at a time.

Earlier in the lesson, you learned how to remove a single segment from the Timeline. Now, you’ll learn how to remove multiple segments from the Timeline.

You can remove material from your sequence by using two different functions:


	Lift - removes material from the Timeline, leaving filler in its place.

	Extract - removes material from the Timeline and closes the gap by sliding all of the segments to the right over.




Lift Function

Lift removes material from the Timeline, leaving filler in its place. Appropriately, the icon for the Lift button is a strongman lifting a set of weights. The button (Figure 7.15) is located in the Timeline palette.


[image: Figure 7.15 The Lift button.]
Figure 7.15 The Lift button.



Lift is used when you want to remove material but still maintain the rhythm of a sequence or the synchronization of the picture and audio tracks in the rest of your sequence. You can associate this function with overwriting; both lifting and overwriting maintain the duration and placement of segments in the sequence.




To Lift Material from the Timeline:


	□ Before removing material, it’s always a good idea to duplicate your sequence. Duplicate the Rock Climber Version 2 sequence and name it Rock Climber_Removing Material. Be sure to double click the sequence icon to open it in the Timeline.

	Remember, the keyboard shortcut to duplicate is Ctrl+D (Windows) or Command+D (Mac).




	□ In the middle of the Timeline, mark IN and OUT points at the start and end of any material you want to remove.

	Make sure you don’t remove the beginning segments (you’ll need them later), mark IN and OUT points around a big chunk of segments from the middle of the sequence.

	It doesn’t need to be an entire segment. You can mark just a part of a segment or include several segments between the marks.

	You can use the Mark Clip button (or press the T key) to quickly select a whole clip for removal. Based on the record tracks you have selected and the location of your position indicator, the Mark Clip button automatically creates the IN and OUT points around a clip in the sequence.




	□ Turn on only the tracks you want to affect.

	Lift works by removing all material on the tracks that are enabled.

	Since we are working in the sequence, you only need to turn on the record track selectors.




	□ Press the Z key (or click the Lift button in the Timeline palette).



The source clip audio in our sequence is distracting, especially the slow motion segments. Let’s remove all of the audio using the lift tool.




To Remove All of the Audio on a Track:


	□ Mark IN and OUT points around all of the audio in your sequence.

	If you have Home and End keys on your keyboard, you can do this quickly by pressing them. Home will take your position indicator to the beginning of the sequence, where you can mark an IN. End will take your position indicator to the end of the sequence, where you can mark an OUT.




	□ Turn on only the tracks you want to affect—since we do not want to delete the video, make sure V1 is turned off. We also don’t want to delete the narration or the music, so make sure A2 and A3 are also turned off.

	□ Press Z on your keyboard.

	Notice how the IN and OUT marks remain on the Timeline after the segment has been removed.









Extract Function

Extracting removes material from the Timeline and closes the gap by sliding over all the segments to the right of the gap. This action is the inverse of splicing . Both extracting and splicing affect the length of a track and/or the sequence. Extract is represented by a pair of scissors and the button is located next to the Lift button at the top of the Timeline. In other applications, Extract is called a ripple delete.


[image: Figure 7.16 The Extract button.]
Figure 7.16 The Extract button.






To Extract Material from the Timeline:


	□ Open the Rock Climber_Removing Material Sequence.

	□ At the beginning of the Rock Climber_Removing Material sequence, there is a shot of hands touching the rock. In the next shot, the climber is walking to the rock. Here is a perfect opportunity to use the Extract tool. Let’s quickly remove the first shot from your sequence.

	□ In the sequence, mark IN at the start of the first shot. Ctrl-click (Windows) or Command-click (Mac) to snap to the edit point at the end of the first shot.

	□ Mark OUT.

	□ Turn on all tracks except A3 and A4. Our music is on those tracks, and we don’t want to cut the music at all.

	□ Press X on the keyboard (or click the Extract button in the Timeline palette) so that all segments slide over when we extract the first clip.








Lesson 7 Review & Discussion Questions - Part 1


	What tool controls how a clip is edited into the Timeline?

	How can you automatically select the segment tool you want to use in the Timeline?

	How do you duplicate a sequence?

	What is the correct name for the red arrow?

	Red or Yellow, which color tool achieves a Lift/Overwrite?

	What is an Overwrite edit?

	What happens to existing segments in the Timeline when you perform an Overwrite edit earlier in the Timeline?

	What happens to existing segments in the Timeline when you perform an Overwrite edit at the end of the Timeline?

	What key on the keyboard allows you snap the position indicator to an edit point when holding it down and clicking and dragging your mouse?

	What is filler?






Lesson 7 Review & Discussion Questions - Part 2


	What is the correct name for the yellow arrow?

	Red or Yellow, what color tool achieves an Extract/Splice-in?

	What is a Splice-in edit?

	What is the danger in using the Extract/Splice-in tool to add, move or delete segments in the Timeline?

	What does this button do? [image: chpt_fig_091.jpg]

	What happens to existing segments in the Timeline when you Splice-in a segment at a point earlier in the Timeline?

	What happens to existing segments in the Timeline when you Splice-in a segment at the end of the Timeline?

	You clicked on a segment in the Timeline and pressed the Delete key. All of the clips in your sequence shifted to fill in the gap. Which Segment mode arrow was activated?

	What is the difference between Lift and Extract?

	What keys on the keyboard allow you to Splice-In, Overwrite, Extract and Lift?






EXERCISE 7

[image: chpt_fig_015.jpg] Segment Mode Tools

Project: Rock Climber Documentary_(Student ID)

Duration: 40 Minutes


GOALS


	Splice-in an interview clip

	Splice-in a B-roll clip

	Remove ‘Ums’ and ‘Ahs’ from an interview segment

	Covering up a jump cut with B-roll






Goal #1: Splice In an Interview Clip


	□ Open the Rock Climber Documentary_(Student ID) project and the Rock Climber Version 2 sequence. We are using this version of the sequence because it does not have the first segment and the audio removed.

	□ Use your Mute button to mute the music on tracks A3 and A4.

	□ Play the entire sequence and watch your work.

	□ At about 09:31:00 in the R02_02(b) Interview clip, the climber says, ‘I, ah, usually put down all my bags and just look up and really just take in where I am and, ah, I put on my shoes and, ah, start putting all my equipment on and, ah, tie myself to the rock and get going.’ Mark IN and OUT around that statement.

	□ In the Timeline, turn on the V1 and A1 source track selectors because you want to add both video and audio to the sequence.

	□ In your sequence, find a spot after the second audio segment where you want to place your new interview clip. Mark an IN point.

	□ Check to make sure A3 and A4 track selectors are off.

	□ Use the Splice-in button under the Source monitor to splice-in the clip.






Goal #2: Splice-in a B-Roll Clip


	□ Locate and open the R8_112 SLOW Fingers Wall-EditStock clip in the Source monitor.

	□ Mark IN and OUT around the part of the shot in which he is running his hand along the wall. It should be about 3 V 2 seconds long. You need video and audio, so make sure the V1 and A1 source and record track selectors are turned on.

	□ Use Extract/Splice-in to add the clip between the first two shots in the Timeline.

	□ Play the sequence and watch your work.






Goal #3a: Remove’Ums’ and’Ahs’ from an Interview Using Lift/Overwrite


	□ In the second narration segment the rock climber says, ‘It gives me a chance to meditate, um, to think about what I’m about to do as I get, ah, to the rock.’

	□ Use any method to you like from the lesson to delete the ‘um’ and the ‘ah’ from the segment.

	You can use the Add Edit button, then click on a segment with the Lift/Overwrite tool and press delete, or

	You can mark IN and OUT points around what you want to remove, check your track selectors, and lift.

	As a reminder, use the keyboard shortcuts Ctrl+[(Windows) and Command+[(Mac) to zoom into your sequence.




	□ Use the Lift/Overwrite to snap the segments together and close the gap between them.

	If you want to reposition a single segment without snapping, you can hold down the Ctrl (Windows) or Command (Mac) key while using Segment mode.









Goal #3b: Remove’Ums’ and’Ahs’ from an Interview Using Extract

During the last clip in the timeline Matt says, ‘I, ah, usually put down all my bags and just look up and really just take in where I am and, ah, I put on my shoes and, ah, start putting all my equipment on and, ah, tie myself to the rock and get going.’ There are four ‘ahs’ in this statement that you can remove.

Because there are no other segments in the Timeline after this interview, you can safely use the Extract/Splice-in tool to clean up the interview. There is no risk of pulling any following segments out of sync. But because you do want to maintain sync within the interview, you need to extract both video and audio from the Timeline.


	□ Turn on the record track selectors for both V1 and A2 of the Timeline.

	□ Use Add Edits or IN/OUT marks and the Extract/Splice-in function to extract each ‘ah’ from the interview.

	You can click on the segments you’ve cut with Extract/Splice-in and press Delete, or

	You can mark IN and OUT marks around the unwanted part of the segment and press X to extract.






When you play the interview, sync should be maintained between the pictures and sound, but at every edit you will notice a jump-cut in the interview. Typically, you would disguise these jump-cuts, so the audience isn’t distracted by them.

One technique is to overwrite the areas where there are jump cuts with B-roll footage.




Goal #4: Covering up a Jump Cut with B-Roll


	□ Turn on only V1.

	Now that we have interview audio in the sequence, you want to make sure that you’re extra careful with which tracks are on while editing.




	□ In the Timeline, mark IN and OUT points around the first jump cut in the interview.

	□ Grab a clip in the Clips bin that you want to use to cover the jump cut.

	□ Overwrite the best-looking portion of the clip onto the V1 track only.

	Make sure you do not overwrite the interview audio.




	□ Repeat this step to cover up the other interview jump cuts.








Screenshots Due:


	□ Zoom into your timeline so that your sequence is nice and big in the Timeline, but you can still see the entire sequence.

	□ Take a screenshot of your Rock Climber Version 2 sequence.
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Trimming Clips and Keeping Sync

Until now, making changes to a sequence has been adding clips to the Timeline, moving, and removing them. What if you want to make a segment in the Timeline longer?

The Trim tools make that happen…but trimming must be done with caution. If you’re not careful, you could break sync. This lesson covers the basics of trimming and how you can safely trim without breaking sync—and if you do, how to fix it.

Project: Jacuzzi

Duration: 50 Minutes


GOALS


	Understanding trimming

	Understanding the different trim tools

	Entering and exiting Trim mode

	Learn about the Trim Mode interface

	Create split edits using dual-roller trim

	Understanding how to recognize broken sync

	Fixing broken sync using trim tools






The Importance of Trimming

Trimming is one of the most powerful tools in editing. It’s the process of making a segment longer or shorter by adding or removing frames from a segment in a sequence. Editors use trimming to refine the sequence. In Media Composer trim is also a mode with special functions that work similarly to the Segment mode tools we learned about in the last lesson.

Trimming is where the real work of editing is done. For example, by adding or removing frames in just the right places, you can energize a dull conversation, increase (or decrease) the apparent tension between characters or extend a stressful moment for maximum impact. Trimming moves your cut from a rough cut to a great final product.

Regardless of film genre, there are a few things to consider when trimming or cutting someone talking on screen (also called dialogue). Whether it is actors performing scripted dialogue, or the on-camera interview of a documentary, the editor is concerned with the following:


	Pacing a scene for the right emotional impact

	Keeping everything in sync

	Matching action on a cut if necessary

	Keeping audio edits clean



When trimming a segment that has on-screen dialogue (meaning we can see the person who is speaking), you obviously need to keep pictures and sound locked together. And you need to keep the audio edits clean. There shouldn’t be any clicks, pops, or partial words at an edit point. Maintaining a continuity of action between shots can also keep the scene running smoothly without visual jumps distracting the viewer.




Automatic Selection of Trim Tools

Media Composer has different tools for trimming segments. You can access the most frequently used trim modes by using the Trim Type button in the Timeline palette (to the right of the Segment Mode button).


[image: Figure 8.1 The Trim Type button.]
Figure 8.1 The Trim Type button.



The Trim Type button works exactly like the Segment Mode button. A right click will open a submenu where you can select either or both trim tools. When both are turned on, the Trim Type button is split half red and half yellow and it becomes a Smart tool. That means the software will automatically select either tool based on the position of the cursor in the Timeline.

To activate it as a Smart tool, the Trim Type button must be turned on. The button will have a light grey highlight to indicate it is on and active.

Figure 8.2 illustrates how the cursor changes depending on its position close to an edit in the timeline.


[image: Figure 8.2 Trim tools as a Smart tool.]
Figure 8.2 Trim tools as a Smart tool.




	When the cursor hovers over the top half of a segment it changes to the red Overwrite Trim tool.

	When it hovers over the bottom half, it changes to the yellow Ripple Trim tool.

	The tool also changes depending on whether the pointer is on the left outgoing (A) side or right incoming (B) side of an edit.

	Hovering the cursor directly over an edit will change the tool to the white dual-roller trim tool.



The color coding of the Trim tools means they function similarly as the Segment Mode tools you learned about in the last lesson.

Overwrite trim (Red) - Removes frames and leaves filler behind. It can also overwrite frames at the head or tail of a segment. Overwrite trim does not change the position of any segment in the Timeline, and it doesn’t change the duration of your sequence if you make a segment longer.

Ripple trim (Yellow) - Uses the Splice-in function to add frames (pushing all segments down to make room for the added frames) or Extract function to remove frames. Ripple trim makes the duration of your sequence longer (if adding frames to a segment) or shorter (if removing frames from a segment)

Dual-roller trim (White) - Removes frames from the segment on one side of an edit and adds an equal number of frames to the segment on the other side. In other words, it moves an edit point to the left or the right. Dual-roller trim does not change the position of any segment in the Timeline, and it doesn’t change the duration of your sequence if you make a segment longer.




Entering and Exiting Trim Mode

Trim mode is an interface that shows you different tools and functions that you will need when you’re trimming. You can enter Trim mode by clicking on an edit point in the Timeline, but there is also a button in the Timeline palette that enters and exits Trim mode.


[image: Figure 8.3 The Trim Mode button in the Timeline palette.]
Figure 8.3 The Trim Mode button in the Timeline palette.




To Enter Trim Mode Using the Trim Mode Button:


	□ Click the Trim Mode button

	Trim mode will be activated—your interface will change and there will be a grey highlight on the button.









To Enter Trim Mode Using the Cursor:


	□ Make sure that the Trim Type button is activated as a Smart tool.

	□ Position the cursor on either side of an edit, in the upper or lower half of the track. For dual-roller trim, hover the cursor directly on top of the edit. The cursor will change to the respective trim tool. Click the cursor and a set of rollers will appear on the selected side of the edit. Figure 8.4 illustrates the relationships between tool icons and the rollers that appear on edits.

	If the Link Selection Toggle button is turned on, rollers will appear on the edit points of all associated video and audio tracks.

	If Link Selection Toggle button is turned off, rollers will only appear on the track you click.






You can trim segments on any video and audio track.




To Exit Trim Mode


	□ Click in the timecode track or Timecode ruler, or

	Press ESC on your keyboard








[image: Figure 8.4 The various ways to enter Trim mode from edits in the Timeline.]
Figure 8.4 The various ways to enter Trim mode from edits in the Timeline.








The Trim Mode Interface

As soon as you enter Trim mode, the Composer window reconfigures to display the Trim Mode interface, as shown in Figure 8.5.


[image: Figure 8.5 The Trim mode interface.]
Figure 8.5 The Trim mode interface.



A-side Monitor - Shows the last frame of the outgoing shot.

B-side Monitor - Shows the first frame of the incoming shot.

Trim Counters - Displays the active side (in pink) and the number of frames added or removed to either side of the edit. A positive value in the trim counters is a trim to the right while a negative value is a trim to the left. In the image above, the pink counter indicates that the outgoing, A-side (left) is active.


	You can also swap between trimming the A-side or the B-side of the edit by clicking either the left or right monitor image. The pink highlight in the trim counters changes sides accordingly. Clicking on the center edge between the A and B-side monitors selects dual-roller trim. Both trim counters will be highlighted pink as a result.



Trim Buttons - Allow you to trim frames in either direction. The single arrows trim a single frame to the left or right while the double arrows trim 8 or 10 frames to the left or right (depending on the project’s frame rate).


	The equivalent keyboard shortcuts for the Trim buttons are shown in Figure 8.6.





[image: Figure 8.6 The Trim button keyboard shortcuts.]
Figure 8.6 The Trim button keyboard shortcuts.



Play Loop Button - Plays a loop around the edit that you are trimming. The advantage of Play Loop is that you can use the keyboard shortcuts to trim the edit and the Timeline will update to show you the trim as it plays.




Top and Tail

Throughout this lesson you might see the words top and tail. These terms are often defined relative to a position indicator.


	Top - refers to the beginning of a segment. If you have a position indicator on a clip, it’s the portion of the clip to the left of the position indicator.

	Tail - refers to the end of a segment. If you have a position indicator on a clip, it’s the portion of the clip to the right of the position indicator.



If you are directed to trim the top of a clip, you’ll be cutting out everything before the position indicator. If you are directed to trim the tail of a clip, you’ll be cutting out everything after the position indicator.




Sync Locks

Before you learn more about trimming, it’s important to understand Sync Locks, so that you don’t accidentally make your sequence go out of sync. The Sync Lock buttons in your Track Selector panel will force you to not break sync while editing. When they are turned on, all segments in your sequence will move together if you move, remove, or trim multiple segments.


	□ To turn Sync Lock on, in the Track Selector panel, click the Sync Lock buttons, as shown in figure 8.7. The Timeline will now maintain the sync relationships between all tracks even when you only edit new material into some of the tracks. To lock sync on all tracks, click the Sync Lock button next to TC1 (timecode track). To only lock sync between pairs of tracks, you can turn on the individual Sync Lock buttons beside the track selectors.





[image: Figure 8.7 The Sync Lock buttons.]
Figure 8.7 The Sync Lock buttons.






Overwrite Trim

When you are in Overwrite Trim mode, there will be a red roller on either the A-side or the B-side of the edit in the Timeline. Overwrite trim combines Lift and Overwrite functions.


	You can also overwrite trim frames by clicking and dragging the red roller in the direction you want to trim.

	You can select additional edits to trim by holding down the Shift key and clicking on the edit points with the red roller.




When an Overwrite Trim is Done from the A-Side:

Moving the red Overwrite Trim tool to the left of the edit point will lift frames from the end of the A-side and leaves filler, as shown in Figure 8.8.



[image: Figure 8.8 A 10-frame trim on the A-side lifts 10 frames and leaves filler on the left of the original edit point.]
Figure 8.8 A 10-frame trim on the A-side lifts 10 frames and leaves filler on the left of the original edit point.



Moving the red Overwrite Trim tool to the right will add frames to the end of the segment on the A-side and overwrite frames from the beginning of the B-side segment. This trim is the same as using a dual-roller trim.


[image: Figure 8.9 An 8-frame trim towards the right adds 8 frames to the A-side and overwrites 8 frames on the B-side.]
Figure 8.9 An 8-frame trim towards the right adds 8 frames to the A-side and overwrites 8 frames on the B-side.






When an Overwrite Trim is Done from the B-Side:

A trim to the right will lift frames from the beginning of the B-side segment and leave filler, as shown in Figure 8.10.


[image: Figure 8.10 A 5-frame trim to the right lifts 5 frames and leaves filler on the front of the B-side.]
Figure 8.10 A 5-frame trim to the right lifts 5 frames and leaves filler on the front of the B-side.






A trim to the left will add frames to the beginning of the B-side segment and overwrite frames at the end of the A-side segment. This trim is the same as using a dual-roller trim.



[image: Figure 8.11 A 7-frame trim to the left adds 7 frames to the B-side and overwrites 7 frames on the A-side.]
Figure 8.11 A 7-frame trim to the left adds 7 frames to the B-side and overwrites 7 frames on the A-side.








Dual-Roller Trim

Dual-roller trim can produce a very similar outcome to Overwrite trim but with a distinct advantage. Unlike using Overwrite trim, you don’t need to decide which side of the edit to place the roller when you want to add frames to one side and overwrite frames on the other. Dual-roller trim adds rollers to both sides of the edit, so it doesn’t matter which direction you trim. One roller will remove frames from one side while the other roller adds an equal number of frames to the other side.


[image: Figure 8.12 A 4-frame trim to the left adds 4 frames to the B-side and overwrites 4 frames on the A-side.]
Figure 8.12 A 4-frame trim to the left adds 4 frames to the B-side and overwrites 4 frames on the A-side.






Ripple Trim

When you are in Ripple Trim mode, there will be a yellow roller on either the A-side or the B-side of the edit in the Timeline. Ripple trim combines Extract and Splice-in functions.


When a Ripple Trim is Done from the A-Side:

A trim to the left extracts frames from the end of the segment on the A-side and all of the segments to the right of the selected edit point in the Timeline move to the left to fill the gap.



[image: Figure 8.13 A 10-frame trim to the left extracts 10 frames from the A-side and following segments move to fill the gap.]
Figure 8.13 A 10-frame trim to the left extracts 10 frames from the A-side and following segments move to fill the gap.



A trim to the right splices-in frames to the end of the segment on the A-side and all the segments to the right of the edit point move to the right to make room for the extra frames.


[image: Figure 8.14 An 8-frame trim to the right splices-in 8 frames to the A-side and following segments move down the Timeline to make room.]
Figure 8.14 An 8-frame trim to the right splices-in 8 frames to the A-side and following segments move down the Timeline to make room.






When a Ripple Trim is Done from the B-Side:

A trim to the left splices-in frames to the beginning of the B-side segment and all of the segments that follow in the Timeline move to the right to make room for the extra frames.



[image: Figure 8.15 A 6-frame trim to the left splices-in 6 frames to the beginning of the B-side segment and following segments move down the Timeline to make room.]
Figure 8.15 A 6-frame trim to the left splices-in 6 frames to the beginning of the B-side segment and following segments move down the Timeline to make room.



A trim to the right extracts frames from the beginning of the B-side segment and all of the segments that follow move to the left to close the gap.


[image: Figure 8.16 A 9-frame trim to the right extracts 9 frames from the beginning of the B-side segment and following segments move up the timeline to fill the gap.]
Figure 8.16 A 9-frame trim to the right extracts 9 frames from the beginning of the B-side segment and following segments move up the timeline to fill the gap.








Using Overwrite Trim to Clean up Audio

Sometimes a visual cut between shots works well but the audio at the cut needs cleaning up. For instance, the outgoing shot has some sort of sound just before the edit. The Overwrite Trim tool helps clean up audio without changing the timing of the cut. Overwrite trims don’t put you at risk for breaking sync, either.


Get Ready to Perform an Overwrite Trim:


	□ In the Jacuzzi project, open the sequence Scene 9 Rough Cut.

	□ Duplicate this sequence and rename it Scene 9 Rough Cut_Trimming Practice



About halfway through the sequence, Leeroy calls out to Ivan, ‘Boss, let’s go. Want to pick up some frothies.’ Before the cut to Ivan, we catch the start of his response, ‘We are…’. After the cut, Ivan repeats those words and continues, ‘We are talking here




To Clean Up the Audio on the A-Side of the Edit:


	□ Turn off the Link Selection Toggle [image: chpt_fig_120.jpg] button.

	□ Move the cursor close to the A-side of the edit on A1 and hover it over the top half of the segment. Click when the cursor changes to the Overwrite Trim tool. A red roller should appear on the A-side of the edit on the A1 track.

	The Composer window will change to display the Trim Mode interface.




	□ Use the keyboard shortcut - Comma key (,) to trim to the left one frame at a time. Keep trimming until you can no longer hear Ivan. If you trim too far, press the Period key (.) to trim back to the right.



When the trim is complete you will have lifted frames of audio and replaced them with filler.






Using Ripple Trim to Adjust Pacing

The Ripple Trim tool is a very effective way to adjust the pacing of a scene and improve the matching of action between shots. This is done in two ways:

A-side (Outgoing shot) - This trim adjusts the timing as you leave one segment and move on to the next in your sequence. It adjusts how long you want to stay focused on that segment before cutting to the next. In the context of cutting a dialogue scene, this typically refers to how quickly you cut away from an actor after he or she finishes speaking.

B-side (Incoming shot) - This trim adjusts the timing of the segment you cut to in your sequence. This often refers to how long it takes an actor to start speaking after you cut to him or her.


	As a general rule, dialogue scenes are cut tight, meaning there are very few additional frames after a character finishes speaking. A shot shouldn’t hold on to an actor any longer than is necessary to deliver the line or to react. Trimming away the extra frames will increase the pace of the scene.

	On the other hand, if there is reason for the pause, hold the shot. Allowing a pause in the scene can be a powerful technique. Most of us know from experience what it is like to be in a tense conversation. That awkward silence between one person’s statement and the other person’s response is telling of the emotion. But it’s not just the pause that creates the tension; it is a character’s body language. As an editor, you may even be able to create that too, by manipulating when and where the audience sees a certain reaction.




Perform a Ripple Trim

When you play the sequence Scene 9 Rough Cut_Trimming Practice and watch the edit between the first two shots, you’ll notice that some trimming needs to be done. There is a repetition of action and dialogue at the edit point. Pacing also needs to be improved, so Ripple trim is the right tool for the job. To clean up the cut, consider which side of the edit you should trim first. Since the head of the second shot is a repetition of the end of the first shot, perhaps placing the trim rollers on the A-side of the edit is a good place to start. You can always swap to the other side of the edit if you change your mind.


	□ Make sure the Link Selection Toggle button at the top of the Timeline is turned on so the edits on all associated tracks will be selected. This will maintain sync between the video and audio as you trim.

	A little further down the Timeline there is a cutaway shot on V2 that you also want to keep in sync with the other tracks as you trim, so double check that your sync locks are on all tracks.




	□ Click the Trim mode button, or the U button on the default keyboard

	The Composer window changes to show you the Trim Mode interface. Look at the A-side monitor and note the position of the actors in the last frame of the outgoing shot.




	□ Click the left monitor in the Composer window, then use the trim buttons or the keyboard shortcuts to perform single-frame trims to the left. Keep removing frames from the tail of the Aside shot until it looks like the actors are in similar positions in both the outgoing and incoming frames.

	□ Play back your edit and make adjustments if needed.

	□ Exit Trim mode by clicking in the timecode track or timecode ruler.

	The edit between shots 2 and 3 can also benefit from a trim to improve the pace and remove some repetition of action. Use the Ripple Trim tool to adjust either side, or each side in turn. Keep an eye on both foreground and background action.




	□ Finish trimming the sequence for pace and action before coming back to further fine tune the scene.








Split Edits

There is another technique that contributes to achieving seamless, invisible edits. If the video and audio always change at the same time—commonly referred to a straight cut - the edits may become obvious to the viewer. Instead, by having the audio and video change at different moments, called a split edit, you effectively interweave the audio and video into a cohesive whole.



[image: chpt_fig_279.jpg]


DID YOU KNOW ABOUT SPLIT EDITS?

Split edits are also commonly referred to as L-cuts or J-cuts. An experienced editor will typically make almost every edit in the sequence a split edit.

Split edits are the most natural for an audience because it mimics real life: Humans can hear things without seeing them. For example, if you are in your house, you can hear a firework go off in the distance. In film, we might see a character on screen and hear something off screen. Then, using a split edit, we would cut to see the noise we just heard. This is an example of a J-cut. You are hearing something before you are seeing it.

An L-cut works in the other direction. In film, you will continue to hear something even when the editor cuts the visuals away to something else. Think of a dialogue scene: sometimes we hear other people talking while viewing a reaction shot of the person they are talking to.

Either way, using split edits as frequently as possible will make your editing seem, well, seamless!




To Create a Split Edit:


	□ Turn off the Link Selection Toggle button

	□ Use dual-roller trim on the video or audio segments



Dual-roller trimming affects both sides of a segment by adding frames to one side while subtracting the same number of frames from the adjacent side.

If you only trim the video and leave the audio alone, you will move the video edit point earlier or later in the sequence. Because both sides of the transition are equally affected, the trim does not change the position of any segments in the track and sync is maintained.

Figure 8.17 shows what happens when you use dual-roller trim to move an edit point later in the sequence.



[image: Figure 8.17 A dual-roller trim on either the video track or the audio track(s) but not both (here, on the V1 track) creates a split edit.]
Figure 8.17 A dual-roller trim on either the video track or the audio track(s) but not both (here, on the V1 track) creates a split edit.






More Practice with Split Edits

In the Jacuzzi Scene 9 Rough Cut sequence:


	□ Turn off the Link Selection Toggle button.

	□ Move the cursor over the edit on V1 in which Ivan responds to Leeroy’s calling out. This is the same moment in the scene where you earlier cleaned up the audio edit.

	□ Click when the pointer changes to the white dual-rollers. Pink vertical lines will appear on both sides of the video edit.

	□ Drag the edit point or use the trim buttons/keyboard shortcuts to move the edit point to the left.

	□ Play Loop and continue to trim to the best point in the performance.

	□ Trim the video edit to the left so you see Ivan reacting to Leeroy saying, ‘want to pick up some frothies.’ At the end of Leeroy’s line, the shot of Ivan continues as he responds with, We are talking here.’








Maintaining Sync

Media Composer provides a number of tools for editing clips, trimming them and moving them in a sequence. The color coding of the tools is an indication of how they function. Red tools add or remove frames from the Timeline without moving segments either side of them. Yellow tools add or remove frames with the result that ‘downstream’ segments move in the timeline. As a result, the yellow tools are the most likely to cause a break in sync as you edit.

There are several ways that you might break sync. Likewise, there are several easy ways to avoid breaking sync. Here’s a quick review.


Common ways to break sync:


	Trimming only one side of a transition, without selecting all tracks

	Extracting frames from only the video or audio track

	Splicing-in only audio or video

	Moving only audio or video when with a Segment Mode tool






Ways to prevent breaking sync:


	When trimming a single track, always use either dual-roller, or the Overwrite trim.

	Whenever you add frames or subtract frames from an audio or video track, also add or subtract the same number of frames from all the other tracks. It is especially helpful to remember this rule when using any of the yellow tools, for example: trimming, splicing, or extracting.

	Whenever you want to add frames or subtract frames from only one track, use Lift/Overwrite instead of Extract/Splice-in.

	Work with Sync Locks turned on.








Recognizing and Repairing Broken Sync

By default, the Timeline displays white numbers whenever sync is broken during editing. These are small white lines and numbers that are positive or negative - showing the exact number of frames that the clip is out of sync by. Broken sync indicators appear only in the affected track(s), as shown in Figure 8.18.

Broken sync information is not displayed if the audio and video segments originally came from different sources.


[image: Figure 8.18 These segments are out of sync by 8 frames.]
Figure 8.18 These segments are out of sync by 8 frames.




Using Trim Mode to Correct Sync

In Trim mode, you can restore sync by using the Ripple Trim mode on the out-of-sync track(s). To reverse the broken sync, trim the exact number of frames displayed in the Timeline. Dual-roller trims or Overwrite trims do not remove sync breaks.

Open the sequence Scene 9 Sync Breaks. The editor was doing a good job of trimming the sequence to improve the pacing and remove repetitions but made the mistake of not trimming all tracks when performing Ripple trims. The shot where Ivan says, ‘We are talking here’, is now obviously out of sync. The small numbers in the Timeline indicate it is out of sync by 5 frames. The rest of the segments in the sequence have also broken sync.




To Fix Broken Sync:


	□ Find the first edit point where broken sync appears.

	Zooming into your Timeline can help you find the white numbers showing how many frames it’s out of sync.




	□ Enter Ripple Trim mode at the beginning of the first video segment that displays a white number.

	□ Add the Ripple Trim tool to only one of the tracks that is out of sync. If you know which one caused the issue, then select that one. If you’re unsure, it can often be easiest to select the edit on the video track. Make sure only that track has trim rollers on the edit point.

	□ Apply the roller to the A-side of the edit.

	You could instead choose the B-side, but in this situation it’s much easier to choose the Aside since it’s easier to see what is happening in the Timeline as you trim.




	□ Use the trim buttons or keys to add or subtract the appropriate number of frames.

	It is often difficult to know which way to trim but there is a simple way to find out. Just start trimming in either direction—to the left or to the right. If the white number increases (either as an increasingly negative or increasingly positive number), you are trimming in the wrong direction. Simply trim in the opposite direction. When the white number disappears, you have fixed the broken sync at that point in the Timeline.






Work your way down the Timeline and perform Ripple Trims on all following edits where sync breaks appear in the segments. Continue down the timeline until all sync breaks have been rectified.



[image: chpt_fig_278.jpg]


STOP & THINK

Before you continue to edit after trimming or fixing sync, Stop and Think:


	After fine tuning the sequence, did you play it back and watch it with a critical eye?

	Even if you’ve fixed your broken sync, it’s good practice to play back your sequence and carefully review it. You might need to do more fine tuning.










Lesson 8 Review & Discussion Questions - Part 1


	What 3 trim types can be automatically selected by hovering the mouse near, or on, an edit point in the Timeline?

	How do you enter Trim mode?

	In Trim mode, the Composer window reconfigures to a new interface. What does the left monitor display and what does the right monitor display?

	What do the trim counters display in the Trim Mode interface?

	Which keys on the keyboard allow you to trim to the left by 1 or multiple frames (8 or 10)?

	Which keys on the keyboard allow you to trim to the right by 1 or multiple frames (8 or 10)?

	What are the benefits of trimming with the Link Selection Toggle button off?

	What is a split edit? What is the benefit of creating split edits in the sequence?

	Which trim type would cause the entire sequence to be longer or shorter?

	With which editing function(s) are you more likely to break sync—Splice-in, Overwrite, Lift, or Extract? Why?






Lesson 8 Review & Discussion Questions - Part 2


	What trim tool would you use to create a split edit?

	How can you recognize when tracks have broken sync?

	Describe the process to restore broken sync.

	How can you ensure that you maintain sync while using Ripple trim?

	True or False: you should always play back and watch the sequence after trimming.






EXERCISE 8

[image: chpt_fig_015.jpg] Using Trimming to Refine the Edit

Project: Jacuzzi

Duration: 30 Minutes


GOALS


	Use the Trim tools to refine scene 7

	Create a split edit using the dual-roller trim

	Clean up audio using Overwrite trim






Goal #1: Use Trim Tools to Refine Scene 7


	□ From the Jacuzzi project, locate your Scene 7 Rough Cut.

	□ Duplicate the sequence and rename it to Scene 7 Fine Cut.

	□ Open the duplicate sequence by double clicking the Sequence icon.

	□ Review the sequence and use the Ripple Trim tool to adjust the pacing of the scene.

	□ Adjust the edits to match the action from one shot to the next.






Goal #2: Create a Split Edit using the Dual Roller Trim

The first two shots are a good place to create a split edit.


	□ Using the dual-roller trim tool, and with Linked Selection Toggle button off, adjust the first cut so that the audience hears ‘Do you want a refund’ while they see the next shot of Don shaking his head.

	Even if your split edit is a couple frames, it will still work to improve the pacing and feel of your sequence.




	□ Continue to make split edits to your sequence where you can.






Goal #3: Clean up Audio using Overwrite Trim


	□ Using the Overwrite Trim tool, and with Linked Selection Toggle button off, adjust the audio edits in your sequence so that all audio sounds natural.

	□ After making sure everything sounds great, double check that there are no “gaps” of filler on the audio tracks in your timeline.

	If there are gaps, either fill them using the Overwrite Trim tool, or insert audio from another clip to fill the gaps, like we did in Lesson 6.











Screenshots Due:


	□ Take a screenshot of your Timeline after cleaning up your edits. There should be at least 1 split edit at the beginning, and no gaps of filler in the audio tracks.











[image: chpt_fig_001.jpg] LESSON 9

All About Audio

Sound plays a significant role in your audience feeling the emotion you want them to feel. Learning how to edit audio so that the audience doesn’t notice any edits is key to being a good editor. To do this, you need to learn how to properly mix the audio in your sequence.

In this lesson, you’ll learn about the basic tools available to you to help do that, and the all-important audio crossfade to help smooth out hard audio cuts.

Project: Rock Climber Documentary_(Student ID)

Duration: 30 Minutes


GOALS


	Understanding audio mixing

	Learn how to see the waveforms in source media

	Locating audio cues using Digital Audio Scrub

	Work with the Audio tool to achieve proper audio levels

	Use the Clip Gain pop-up mini fader to adjust segment volume

	Add audio crossfades to segments






Audio Mixing

So far, in editing your rock climbing sequences, you have removed audio that is distracting, and in Jacuzzi you were able to trim out some distracting audio.

There’s a lot more work to do when it comes to editing audio. A sudden change in sound volume or quality between audio segments can be jarringly noticeable to the audience. In the same way that editors carefully decide what are the best shots to use at any given moment, they also have to pay close attention to the sound—what does the audience need to hear?

Deciding this is called audio mixing. Great audio mixing starts with being able to hear voices clearly and at the correct level. Then the natural sound, or effects audio, is balanced against the voices. Finally, music volume is adjusted so it doesn’t compete for the attention against dialogue and sound effects. Editing the video is only the beginning! Before we start learning the basics of audio mixing, let’s begin with learning about a new feature—the Toggle/Source Record in Timeline.




Toggle Source/Record in Timeline

You can display the waveform for source material before you bring the clip into the Timeline. This can be helpful when deciding where to place in and out points during dialogue in clips.

To see source waveforms, you can switch the Timeline display from showing the sequence to showing the tracks of the source clip.


To Display Source Audio Waveforms:


	□ Load the source clip R02_02(b) Interview into the Source monitor.

	□ Near the bottom-left side of the Timeline, click the Toggle Source/Record in Timeline button. (Figure 9.1)

	□ If needed, enable the track’s audio waveforms in exactly the same way that you learned in Lesson 6 (Getting Deeper Into the Edit) - click the waveform button in the Track Control panel.




[image: Figure 9.1 The Toggle Source/Record in Timeline button.]
Figure 9.1 The Toggle Source/Record in Timeline button.



When Toggle/Source Record in Timeline is active, the position indicator in the Timeline changes to the same bright green (as shown in figure 9.2), indicating that you are looking at Source material.


[image: Figure 9.2 The bright green position indicator alerts you to the fact that you are looking at the source material.]
Figure 9.2 The bright green position indicator alerts you to the fact that you are looking at the source material.



The Timeline now displays the clip’s source tracks instead of the sequence. This is especially evident in the Track Selector panel. The two green source track selectors are on the right, and the three blue record track selectors are on the left.


	• If you need to adjust the vertical detail of an audio waveform by making the waveform bigger or smaller, remember to use the keyboard shortcuts Ctrl+ALT+K / Ctrl+ALT+L (Windows) or Command+Option+K / Command+Option+L (Mac)

	□ Navigate to approximately 9:03:00. This is one of the audio clips you have already used. (You will need to use the timecode display at the top of the Source monitor as the timecode display in the Timeline still refers to the sequence.)

	If you need to, use the Timeline’s scale bar or keyboard shortcuts to zoom out of the Timeline.




	□ Play the source clip until you find the gap just before he says, ‘Itgives me a chance…’ and add an IN mark.

	□ After his words, ‘…I get to the rock.’ add an OUT mark.

	Figure 9.3 shows how the marked area of the clip is highlighted and the marks appear in the timecode track.







[image: Figure 9.3 The marked area of the source clip is highlighted grey]
Figure 9.2 The marked area of the source clip is highlighted grey



Hit Toggle Source/Record in Timeline again before you continue editing otherwise you will not see new segments being added to the sequence. Remember, a green position indicator means you are looking at the source clip in the Timeline while a blue position indicator means you are looking at the sequence.






Using Digital Audio Scrub

To help more with adjusting audio, you may find it useful to enable Digital Audio Scrub.

Digital Audio Scrub lets you hear the audio recorded with each individual frame you click and move through the Timeline, allowing for very precise audio editing. For example, you may have difficulty identifying in the waveform the exact point between spoken words - Digital Audio Scrub can help you pick the exact frame on which to cut.


	Digital Audio Scrub works by either dragging the position indicator, or by using the Step Forward/Step Back buttons on the keyboard or interface.




Map the Toggle Digital Audio Scrub Button to The Timeline Palette:


	□ From the Tools menu at the top of your screen, open the Command Palette.

	□ At the bottom-left of the Command palette window, make sure the ‘Button to Button’ Reassignment is turned on.

	□ Under the Play tab, locate the Toggle Digital Audio Scrub [image: chpt_fig_126.jpg] button.

	□ Click and drag the button icon to a blank space in the toolbar at the top of the Timeline.

	□ Close the Command palette.






To Enable Digital Audio Scrub:


	□ Hold the Shift key while dragging through the Timeline to temporarily activate Digital Audio Scrub, or

	Use the Toggle Digital Audio Scrub button to switch Digital Audio Scrub on and off.











Setting Up for Audio Mixing

There are a couple of settings that make adjusting audio levels and balance quick and easy.


In the Track Control Panel for Each Audio Track:


	□ In your sequence, open the Track Control panel by clicking on the disclosure triangle at the top of the Timeline.

	□ Click the Audio Data button, as shown in figure 9.4. It opens the Audio Data menu, shown in figure 9.5.




[image: Figure 9.4 The Audio Data button.]
Figure 9.4 The Audio Data button.




[image: Figure 9.5 The Audio Data menu.]
Figure 9.5 The Audio Data menu.




	□ Select Clip Gain in the Audio Data menu. Clip Gain is enabled on the track.

	Holding Alt (Windows) or Option (Mac) in the Track Control panel while you click one of the buttons activates the item for all tracks. Otherwise, all selections are on a per-track basis.






Each audio segment in the Timeline shows a series of horizontal lines superimposed over a less prominent audio waveform—this is a decibel graph. Also, appearing in the bottom-left corner of each clip, is a very small white icon, representing an audio fader. Click on the icon and a fader will appear, allowing you to control the audio level of that segment, as you can see in figure 9.6.


[image: Figure 9.6 With Clip Gain enabled, the audio segment reveals a mini fader.]
Figure 9.6 With Clip Gain enabled, the audio segment reveals a mini fader.








The Audio Tool

When working with audio, you may wish to look at more precise meters than those at the top left of the Timeline. Media Composer also includes large audio meters that are easier to read. The large audio meters are called the Audio Tool. (The Audio Tool does do other things, hence the name “Tool,” but it is primarily a big pair of meters.) Use these meters when you need to accurately measure audio levels.


To Open the Audio Tool:


	□ Press Ctrl+1 (Windows) or Command+1 (Mac) or,

	Select Tools > Audio Tool.






You can increase the size of the Audio tool by dragging the bottom right corner of its window down until the meters reach their maximum size. You can also move the tool to a convenient position on your computer screen, or dock it in the paneled user interface.




All About Decibels

Audio is measured in decibels (dB). Within the Audio Tool, notice that the decibel scale is primarily negative. When you mix audio, you either subtract or add decibels to the current level to make a new audio level. If your levels hit 0db, you’ll notice that the bars turn red. Any point at which audio reaches (or surpasses) the 0dB range is called peaking—it means your audio is too loud and will sound distorted.

So, what is the right audio level? As a rule of thumb, the audio in your sequences should generally be between-20dB and -8dB, as measured by the digital values on the left side of the meter. Voice level is typically around -12 dB within that range.






Using Solo and Mute

Remember the Solo and Mute buttons we used in Lesson 6? These buttons are also helpful in isolating the audio that you need to adjust without being distracted by competing sound on other tracks, as shown in Figure 9.7.

It is possible to solo more than one track. This is ideal for isolating just a couple tracks out of the full mix, such as the music and sound effects without the dialogue or vice-versa.


[image: Figure 9.7 The Solo and Mute buttons are always visible and accessible in the Track Control panel.]
Figure 9.7 The Solo and Mute buttons are always visible and accessible in the Track Control panel.






Adjusting the Volume of a Segment

Work in the Rock Climber Version 2 sequence in your Rock Climber Demo project to practice adjusting audio. This should be the version of the sequence with the natural sound on V1 and the Rock Climber narration on track V2.


	□ Turn on the Solo button for A2 of the Timeline. This means you will only hear the rock climber speaking and not be distracted by any of the natural sound accompanying the climbing footage.

	□ With Clip Gain turned on for A2, click the mini fader in the bottom corner of the first segment on A2 of the timeline.

	A pop-up fader window appears.




	□ Click and drag the fader to adjust the level. Adjust the fader to read a value of +6.0dB. This adds an extra 6.0 dBs to the existing sound to increase the volume of the segment.

	Play the segment and look at the Audio tool to see the voice levels. The levels should be around -12 dB in the audio meter.






You can tell by how wide the waveform is that the voice is fairly loud in the first segment but in the second the voice level tails off to become much quieter.


	□ In the second segment, adjust the fader to +9.0dB.

	□ Continue down the Timeline and adjust each segment on A2 so the voice level in the Audio tool is averaging at around -12.0 dB on the left-hand meter as you play each segment.

	□ When you have finished adjusting the level of each segment, play the entire sequence to make sure the voice level is a consistent volume throughout.

	The pop-up mini fader will close automatically when you click elsewhere in Timeline.






Now, let’s adjust the volume of the segments on A1.


	□ Solo A1 and A2 so you can hear only those audio tracks.

	The advantage now is that because you know the voice levels are correct, you can judge the loudness of the V1 track by ear. If the volume of the effects is dominating or competing for your attention compared to the voice, then it is too loud and will need to be mixed down.




	□ Work through the Timeline and adjust each segment on A1 so you can hear the sound without it drowning out or distracting you from listening to the narration. With background audio, less is more.

	If you decide that any audio segment on A1 is not working, then find a replacement. Using what you learned in an earlier lesson, mark an audio segment from IN to OUT in the Timeline and overwrite it with audio from a different clip that you think works better. Remember to turn off the V1 and A2 track selectors because you are only replacing the sound on A1 and not the video or narration.









Audio Crossfades

Sometimes a sudden change in the quality of the sound can be just as distracting as a change in volume. An audio crossfade can smoothly blend the sound of two audio segments.

A crossfade transition combines two segments by fading them over each other while they transition from one to another. Crossfade transitions can be used on audio or video. In a video crossfade, the transition can be longer to make a long-lasting dissolve. When you use crossfade transitions on very distracting audio cuts, you might use a long (24 frames will do the trick) cross fade so that the two competing segments blend seamlessly together. If you’re cutting a dialogue scene, an audio crossfade typically will be very short—only 1 or 2 frames long—and smooth out the audio nicely so your audience won’t hear any distracting “pops” when the audio cuts from one clip to another.

In this lesson, you’ll get a quick overview of using the Quick Transition dialog box to make audio crossfade. In lesson 10, you’ll learn more about transitions, handles, and modifying transitions using the Effect Editor.

In your Rock Climbing sequence, try adding an audio crossfade to the hard audio cuts.


To Add an Audio Crossfade:


	□ Solo the A1 track.

	□ Turn on only the A1 track selector.

	□ Park the position indicator close to an edit between two segments on A1. You don’t need to be right on the edit point, just close to it.

	□ Click the Quick Transition button in the Timeline palette, shown in figure 9.8.




[image: Figure 9.8 Park near the edit point in the Timeline and click the Quick Transition button.]
Figure 9.8 Park near the edit point in the Timeline and click the Quick Transition button.




	□ When the Quick Transition dialog box opens, as shown in figure 9.9, match the settings below:

	Add: Dissolve

	Position: Centered on Cut

	Duration: 24 frames

	Start: 12 frames before cut







[image: Figure 9.9 The Quick Transition dialogue box.]
Figure 9.9 The Quick Transition dialogue box.




	□ Click Add.



When the dialog box closes, a purple transition icon appears across the edit point in the Timeline, as seen in figure 9.10.


[image: Figure 9.10 A crossfade transition appears across the edit in the Timeline.]
Figure 9.10 A crossfade transition appears across the edit in the Timeline.



A crossfade between the two segments relies on there being sufficient overlap of audio on both sides of the edit. Insufficient media on either side will require you to adjust the transition until a successful crossfade can be achieved.


	□ Play the crossfade and if you don’t like the result, park on the transition icon in the Timeline and click the Quick Transition button again to change the settings.






To Remove Crossfades:


	□ Park your position indicator on the transition icon in the Timeline and click the Remove Effect button (as seen in Figure 9.11) in the Timeline palette.




[image: Figure 9.11 The Remove Effect button.]
Figure 9.11 The Remove Effect button.








Lesson 9 Review & Discussion Questions


	How do you display the waveforms in source material?

	What does Digital Audio Scrub allow you to do?

	How do you open and close the Track Control panel?

	How can you change the size of an audio waveform in the Timeline?

	What does the Audio tool provide?

	In the Audio tool, the audio in your sequence should generally appear within what range of decibels?

	True or False: You can only solo one track of audio at a time.

	Where do you turn on Clip Gain?

	What does Clip Gain allow you to do?

	How do you add a crossfade to an audio edit?






EXERCISE 9

[image: chpt_fig_015.jpg] All About Audio

Project: Rock Climber Documentary_(Student ID)

Duration: 45 Minutes


GOALS


	Add more interview to the end of a sequence

	Use the Extract tool to remove parts from an interview

	Adjust the volume of a segment

	Add short audio crossfades to smooth out cuts in an interview

	Adjust music segments so that they aren’t too loud under an interview






Goal #1: Add More Interview to the End of a Sequence


	□ In the Rock Climber Documentary_(Student ID) open the Rock Climber Version 2 sequence.

	□ Open R02_02(b) Interview-EditStock in the Source monitor.

	□ Turn on Toggle Source/Record in Timeline and turn on your waveforms.

	□ At around 15:48:00, he says, ‘The end of a perfect day is to top out of a route and to, ah, come down and enjoy the sunset.’

	□ Using your audio waveforms as a guide, mark IN and OUT around this section.

	□ Toggle Source/Record in Timeline again to see the sequence in the Timeline.

	□ Splice-in or overwrite the clip to the very end of your sequence.






Goal #2: Use Extract to Remove Parts from an Interview


	□ Using IN and OUT marks in the Timeline, use the Extract function (X key) to remove the ‘ah’ from his words and close up the gap.






Goal #3: Adjust the Volume of a Segment


	□ Using the Clip Gain mini fader, adjust the volume of the interview segments that you’ve just cut into your sequence so that they sound better and look better in the Audio tool.






Goal #4: Add Short Audio Crossfades to Smooth Audio Cuts

In the last interview, you cut out an “ah”. This leaves you with a jump cut in the video and a cut in the audio. For now, leave the jump cut in the video, but let’s fix the harsh cut in the audio.


	□ Add in an audio crossfade to the last interview bite using these parameters:

	Add: Dissolve

	Position: Centered on Cut

	Duration: 2 frames

	Start: 1 frames before cut




	□ Add two more audio crossfades to this interview: one at the beginning of the sound bite and one at the end.

	□ Optional: Add small audio crossfades to ALL of your interview audio edits in the sequence. They should only be 1 or 2 frames. This will help your interview bites sound pristine!






Goal #5: Adjust Music Segment Audio Levels

Your music track that you added to your sequence in a previous exercise is now too short for the interviews and b-roll that you’ve added into your sequence.


	□ Using the Overwrite tool, replace the music track in your sequence with 179_short_we-are-young-we-are-free_0074.wav.

	When you play the sequence, you will not be able to hear the voice or the effects audio because the music overpowers both tracks.




	□ On the music tracks, pull down the pop-up mini fader until the music peaks at about -14 dB on the meters in the Audio tool.

	□ Play the sequence and notice that when the voice starts, the music is still too loud.

	Using what you have already learned, the next few steps are a quick and easy way of lowering the music level so it dips smoothly under the voice.




	□ Make sure only the track selectors for A3 and A4 are turned on.

	□ Just before the narration begins, place an Add Edit [image: chpt_fig_135.jpg] on A3.

	□ Place another Add Edit in the A3 track just after the narration ends.

	Notice that the section of the segment between the Add Edit marks now has its own fader.




	□ Pull down the fader so the music level is well below the voice level. The red ‘=’ sign on the Add Edit is telling you that something is different between the neighboring segments. In this case, the audio levels are different.

	□ To smooth out the sudden change in audio levels, apply crossfades to both Add Edits by using the Quick Transition button. Follow the parameters below:

	Add: Dissolve

	Position: Centered on Cut

	Duration: 45 frames

	Start: 22 frames before cut




	□ Repeat this process for the other two sections of interview that you’ve cut in.

	The music should get louder in between the sections of interview, and quieter underneath the interviews.

	It’s okay that your sequence at the end of this lesson has a gap at the end and a jump cut in the interview. We will fix those issues in later lessons.











Screenshots Due


	□ Toggle Source/Record in Timeline and turn the waveforms on for any source clip. If needed, make the waveforms large enough or small enough to see them. Take a screenshot of your Timeline. Once you take your screenshot, switch back so that you can see the record tracks in the Timeline.

	□ Take a screenshot of your entire sequence, so that all of your segments and tracks in the timeline are visible.











[image: chpt_fig_001.jpg] LESSON 10

Transitions and Titles

There are two things that almost every film has: transitions and titles. Video transitions allow us to tell the audience that time has passed, we can use them to convey an emotion, and even use them to make neat effects, like someone fading away. Putting titles on your sequence can be both stylistic and informational. We can do so much to enhance our product with Avid Titler+ and the Quick Transition tool.

Project: Ski Field and Rock Climber Documentary_(Student ID)

Duration: 65 Minutes


GOALS


	Using the Quick Transition Tool and Effect Palette to create video transitions

	Modifying, moving, and removing transitions

	Creating effect templates

	Creating titles and shapes with Avid Titler+

	Using keyframes to add dissolves to titles

	Adding multiple tracks to a sequence






Creating Video Transitions

The most common video effects used in film and television are dissolve and fade transitions. They can add drama, resolve a difficult cut point, convey the passage of time or location, or even indicate an altered state of consciousness. Media Composer uses the same basic method to create dissolves between video clips as it does for crossfades in audio clips. Because these are the most commonly used effects, the Quick Transition feature provides an easy way of applying them to a sequence.



[image: chpt_fig_279.jpg]


DID YOU KNOW ABOUT TRANSITIONS?

The two most common effects are Dissolves and Fades.

A dissolve blends together the frames between two shots in the sequence. You can use dissolves to tell your audience that a period of time has passed.

A fade blends the video to, or from, black. Fades are commonly used only at the beginning or end of a scene, but can be used creatively to help tell your story—maybe your character is falling asleep, or losing consciousness.




Adding Quick Transitions


	□ Open your Rock Climber Documentary_(Student ID) project.

	□ From the Sequences bin, locate your Rock Climber Version 2 sequence and duplicate it.

	□ Rename the duplicate Rock Climber Version 4_With Transitions.

	You can use this version to add video transitions. If you don’t like the end result you can return to your sequence labelled Rock Climber Version 2, make another duplicate and try again.

	The Quick Transition button, shown in figure 10.1, is the fastest way to add a video dissolve or an audio crossfade to a cut point.

	You can simultaneously add a dissolve and crossfade by having both video and audio track selectors turned on.

	For this lesson, we will only be adding transitions to the video segments.




	□ Turn on the track selector for the video tracks.

[image: Figure 10.1 The Quick Transition button.]
Figure 10.1 The Quick Transition button.




	□ Park the position indicator close to the edit between the first two shots.

	□ Click the Quick Transition button, or

	Press the Backslash key [\] on the keyboard.

	The Quick Transition window opens, as shown in Figure 10.2.




	□ Click the Add button or press Enter.

	The dialog box will close and the default transition—a one-second dissolve centered on the cut—will be applied to the edit point on the active track. A dissolve icon will also appear across the edit point in the Timeline.






Of course, you won’t always want a 1-second dissolve for a transition, so let’s explore the other controls.


[image: Figure 10.2 Using the Quick Transition dialog box is the easiest way to create a transition effect.]
Figure 10.2 Using the Quick Transition dialog box is the easiest way to create a transition effect.








Customizing Quick Transitions

In the Quick Transition dialog box, use the Add effect menu at the top to select the specific transition effect. Click the drop menu to see what options are available.

Below the Add effect menu are a few choices for modifying the duration and alignment of the transition. Included in this section is a visual representation of how the transition will look on your segments. This visual shows the alignment and ‘handles’ of the clip. This can help you to understand any duration or alignment problems that may occur, and help you predict how your transition will look before you click Add.


[image: Figure 10.3 Alignment section of the Quick Transition dialog box.]
Figure 10.3 Alignment section of the Quick Transition dialog box.




Handles

The handle of a segment in the Timeline is the unused portion of the source clip.

To create a transition, you must have more source media in the media file than what is edited into the Timeline. The outgoing segment (the A-side shot) and the incoming segment (the B-side shot) need to overlap for the duration of the transition, as shown in figure 10.4. This extra media required on either side of the edit is referred to as the handle.


[image: Figure 10.4 A handle diagram.]
Figure 10.4 A handle diagram.



If you type a duration in the dialog box that requires more handle than is available in the media file, Media Composer will automatically adjust the duration of the handle to give you the longest possible transition.

By default, the Quick Transition dialog box will apply a dissolve transition that is centered on the cut point, meaning an equal number of frames for the dissolve happens before and after the cut points. This requires the outgoing and incoming segments to have at least enough handle for half the duration of the transition, as you can see in Figure 10.5.


[image: Figure 10.5 A transition alignment diagram.]
Figure 10.5 A transition alignment diagram.



You can change the alignment so the transition starts at the cut, instead of being centered on the cut. This means the outgoing segment will need to have a handle length equal to the entire transition but the incoming shot doesn’t need any extra handle as it already “starts at the cut.”

If you don’t have any handle on the incoming shot, it will reconfigure the dissolve alignment to achieve the best outcome. To see how this works, let’s practice.




Practicing with Handles


	□ Park the blue position indicator near the cut just after the climber says, ‘…really just take in where I am…’.

	□ Click the Quick Transition button or press the Backslash key [\] on the keyboard. See how the Quick Transition reconfigured its settings to achieve the best possible dissolve, as shown in figure 10.6.

	□ Press Enter to apply the dissolve.




[image: Figure 10.6 Transition alignment and duration changes to suit the handle lengths.]
Figure 10.6 Transition alignment and duration changes to suit the handle lengths.



In this case, the outgoing A-side had enough handle for a dissolve while the incoming B-side had no handle available at all. To achieve a dissolve, Quick Transition changed the position to ‘Starting at Cut’. It also calculated that the default duration of 24 frames can be achieved. Given the handle length available, you could make the duration greater or less than 24 frames, but the transition will still only be able to start at the cut.


	Another way to adjust a transition within the Quick Transition dialog box is to drag the left or right edge of the pink graphical effect icon to change its duration. You can also drag within the purple effect icon to change its alignment.



Clicking the Add button will result in the creation of a real-time effect. If you were to click the Add and Render button, Media Composer would render the transition, creating a new media file that is as long as the effect, and combines the outgoing and incoming handles. This can be helpful to ensure real-time playback if you find your computer pauses or stutters when it tries to play a transition.

In the Quick Transition dialog box, the left side of the dialog box is used for track selection. If you forget to select the correct track selectors in the Timeline before clicking the Quick Transition button, or you change your mind, you can change the selected tracks here.






Modifying Transition Effects in the Timeline

Once you have added a transition, the Timeline displays a transition icon over the cut point.

A diagonal line indicates the duration and position of the transition, the pink icon in the middle matches the icon of the Quick Transition button. When you look at the effect icon in the Timeline, notice that there are also handle controls at each end of the diagonal line.

You can click and drag those controls to change the duration of the transition.


	If you click and drag the icon you can change the start position.

	The cursor changes into a black left-right pointing arrow when you click on the control handles to alter the duration.

	The cursor turns into a grabby hand for changing the position of the transition on that edit point.




[image: Figure 10.7 Modifying a transition in Timeline.]
Figure 10.7 Modifying a transition in Timeline.



If you are not seeing these handle controls, or if you do not want to modify the transition from within the Timeline, you can show or hide the controls by clicking the Transition Manipulation button, as shown in figure 10.8. The button is located at the top of the Timeline.


[image: Figure 10.8 The Transition Manipulation button.]
Figure 10.8 The Transition Manipulation button.






The Transition Corner Display

If you start modifying a video transition in the Timeline, the Composer window reconfigures to show you 6 small screens—the Transition Corner Display.


[image: Figure 10.9 The Composer window reconfigures to show the outgoing and incoming frames of the transition.]
Figure 10.9 The Composer window reconfigures to show the outgoing and incoming frames of the transition.



The top 3 images show you the start, middle and end frames of the outgoing shot over the duration of the transition. The bottom 3 images show you the start, middle and end frames of the incoming shot. The images update as you adjust the duration and position of the transition in the timeline.


	You can’t drag an effect beyond the cut point, and you can’t you drag an effect beyond the ends of the handles.

	You can press the Alt key (Windows) or the Option key (Mac) before you drag a transition handle to lengthen or shorten the transition equally in both directions.






When to Use a Transition Effect

Watch your favorite films and TV shows, and you will see that most edits are straight cuts. But, when you start looking at music videos, movie and game trailers, and other short, highly stylized pieces, you can find plenty of examples where transition effects are used instead of cuts.

Let’s consider whether a dissolve is appropriate at the cut between the first two shots in the Rock Climbing sequence. When you started editing, the intention was to try to achieve continuity style cuts between the opening clips, in which the action flowed seamlessly from one shot to the next.

In some cases, using a dissolve is a good way to disguise a discontinuity of action like this. However, a dissolve can also suggest that time has elapsed between shots or there has been a change of location between shots. In your opening series of shots neither of these is true. So, let’s remove the transition we made earlier from this edit.


Removing Transition Effects

The Remove Effect button is at the top of the Timeline. You can use this button to remove segment effects (you’ll learn about those in a later lesson) or transitions you’ve put between segments.


[image: Figure 10.10 The Remove Effect button.]
Figure 10.10 The Remove Effect button.




	□ Park the blue position indicator near the transition you created just after the climber says, ‘…really just take in where I am…’.

	□ Turn on only the track(s) you want to affect—in this case, turn on only V1.

	□ Click the Remove Effect button.

	The effect will be removed.






You can also remove a transition effect using the Transition Manipulation button.


	□ If it’s not already active, turn on the Transition Manipulation tool.

	□ Click on the transition effect icon. The effect will be highlighted.

	□ Press Delete.

	The effect will be removed.











Adding Transition Effects to Multiple Segments

Media Composer allows you to easily add Quick Transition to a series of edits. This is a great time-saver in situations, like in a montage, where you may want to add dissolves to several edits in a row. There is a section of your sequence that might lend itself to this approach.

When the music starts, you have edited a series of quick shots together that depict the rock climber energetically scaling the wall. While straight cuts work well, adding dissolves or dips to black tells the audience that scaling the rock takes time to achieve.


To Add a Dissolve to Multiple Segments at Once:


	□ In the Rock Climber Version 4_With Transitions sequence, turn on only the track(s) you want to affect—in this case, turn on only V1.

	□ Mark IN and OUT points around all of the edit points where you want to add transitions.

	The marked series of edited will be highlighted, as shown in Figure 10.11.







[image: Figure 10.11 Selected edit points between IN and OUT marks in the Timeline.]
Figure 10.11 Selected edit points between IN and OUT marks in the Timeline.




	□ Click the Quick Transition button or press the Backslash key [\] on the keyboard to open the Quick Transition dialog box.

	□ Select the Apply to All Transitions (IN->OUT) checkbox that now appears in the dialog box, as shown in Figure 10.12.




[image: Figure 10.12 The Apply to All Transitions (IN -> OUT) option.]
Figure 10.12 The Apply to All Transitions (IN -> OUT) option.




	□ Click the Add button.

	All the edits between the IN and OUT marks now have a transition applied to them, as seen in Figure 10.13.







[image: Figure 10.13 All edit points with transitions added.]
Figure 10.13 All edit points with transitions added.








Transitions in the Effects Palette

While the Quick Transition dialog box provides quick access to the most commonly used effects, all effects, including dissolves, fades, and wipes can be accessed through the Effects Palette.


To Open the Effects Palette:


	□ Click the Effect Palette tab in the Bin Container.

	If you’re working on a computer with only one monitor, the Effect Palette will be tabbed in the Bin Container. If you’re working on a computer with two monitors, the Effect palette isn’t tabbed by default. You can open it by going to Tools in the menu bar, and choosing Effect Palette.






The Effect Palette displays a list of all available effects. Across the top of the palette are tabs to show Filters (also known as segment effects), Transition, Audio Track, and Audio Clip. These four categories help to keep things organized and easier to find.

Within each tab, the left side of the Effect Palette lists effect categories, and the right side lists specific effects within the category. When you select a category on the left side, all the effects in that category are displayed on the right.


	A green dot next to an effect icon indicates that the effect is a real-time effect. It does not require rendering in order to play it back.




[image: Figure 10.14 The Effect Palette docked in the Bin Container.]
Figure 10.14 The Effect Palette docked in the Bin Container.






To Add a Transition from the Effect Palette:


	□ Open the Effect Palette.

	□ Select the Transitions tab at the top of the palette.

	□ Select the Blend category in the left-hand column.

	□ Drag the Dip to Color onto an edit point in the Rock Climber Version 4_With Transitions sequence.

	When the edit point highlights, release the cursor to apply the effect.









To Replace a Transition:


	□ Drag a transition effect from the Effect Palette over an existing transition in the Timeline.

	□ When the existing transition highlights, release the mouse to replace the effect.








Modifying Effects and Transitions in the Effect Editor

To change the way an effect or transition looks, you can adjust the parameters in the Effect Editor.


To Open the Effect Editor:


	□ Park the blue position indicator on one of the dissolve transitions that you created earlier.

	□ Turn on only the track that the transition is on—in this case, turn on only V1.

	□ Choose Tools > Effect Editor, or

	Choose Windows > Workspaces > Effect, or

	Click on the Effects workspace button on the right-hand side of the Media Composer interface, or

	Click the Effect Mode button in the Timeline toolbar, as shown in Figure 10.15.







[image: Figure 10.15 The Effect Mode button.]
Figure 10.15 The Effect Mode button.



The Effect Editor organizes effect parameters in collapsible groups, using disclosure triangles. The types of parameters available depend on the effect you are working with. In the case of a dissolve, the Foreground parameter is the only one you can change. Clicking a disclosure triangle next to the parameter opens the group and displays available adjustments, as shown in Figure 10.16.

Any changes you make are instantly previewed in the Composer window.


[image: Figure 10.16 The Effect Editor.]
Figure 10.16 The Effect Editor.



What happens along with this is more subtle, but very critical. In the Composer window, the Record monitor has now become an Effect Preview monitor. The monitor no longer shows you the entire sequence but only displays the selected effect, which is highlighted in the Timeline. The position bar under the monitor, which normally allows you to scrub through the entire sequence, now only scrubs through the selected effect.


	When working in Effect mode, it’s best to get in the habit of using the position bar in the Effect Preview monitor to scrub through the effect. Don’t scrub using the timecode track in the Timeline, because if you click the timecode track, the Effect Editor will close.

	Depending upon how you opened the Effect Editor, the Composer window may be configured as a single Effect Preview monitor or as a two-monitor display.



Opening Effect Mode by clicking the Effect Mode button or via the menu Tools > Effect Editor results in a two-monitor configuration where the left-hand screen functions as the normal Source monitor, as shown in figure 10.17.


[image: Figure 10.17 The Effect Editor, Source monitor and the Effect Preview monitor in a two-monitor configuration.]
Figure 10.17 The Effect Editor, Source monitor and the Effect Preview monitor in a two-monitor configuration.



Opening the Effect Editor through the Effects workspace button in the sidebar results in a single, larger Effect Preview monitor, as seen in figure 10.18.


[image: Figure 10.18 The Effect Editor and the Effect Preview monitor in a single-display configuration.]
Figure 10.18 The Effect Editor and the Effect Preview monitor in a single-display configuration.



However you chose to work, the Effect Editor allows you to change the start position (or alignment) of the dissolve and its duration.


	□ In the bottom of the Effect Editor, click the Transition Effect Alignment button to reveal a list of options, or type a duration for the effect in the Transition Duration field.




[image: Figure 10.19 The Transition Effect Alignment button & Transition Duration field.]
Figure 10.19 The Transition Effect Alignment button & Transition Duration field.



You can click the Play Loop button in either the Effect Editor or the Effect Preview monitor to loop playback through the effect, shown in figure 10.20. To stop the looping playback, just click anywhere other than the button (for example in the Effect Preview monitor).


[image: Figure 10.20 The Play Loop button and keyframes under the Effect Preview monitor.]
Figure 10.20 The Play Loop button and keyframes under the Effect Preview monitor.



Keyframes allow you to modify a dissolve in a way that’s not possible through the Quick Transition dialog box. Typically, you expect a dissolve to start on the outgoing image (the A-side) and transition through to the incoming image (the B-side). The keyframes each have a value assigned to them that controls that transition from one image to the next. Those values are determined by the Foreground slider in the Effect Editor.




To Keyframe a Transition:


	□ Click on the start keyframe under the Effect Preview monitor or the Effect Editor. The keyframes on all the tracks mirror each other at the same point in time. When one is selected, they will be highlighted pink, as shown in Figure 10.21.

[image: Figure 10.21 The start keyframe and Foreground slider value in the Effect Editor.]
Figure 10.21 The start keyframe and Foreground slider value in the Effect Editor.




	Notice that the Foreground slider has a value of 0 when the start keyframe is selected. This means the outgoing image (A-side) is fully visible, and the incoming image (B-Side) is invisible.




	□ Click on the end keyframe so it turns pink (See Figure 10.22). The Foreground slider has now changed position and has a value of 100, meaning the outgoing image (A-side) is invisible, and the incoming image (B-side) is now fully visible.

[image: Figure 10.22 The end keyframe and foreground slider value.]
Figure 10.22 The end keyframe and foreground slider value.




	The time between the start and end keyframes is the duration of the dissolve.




	□ Select the start keyframe and change the Foreground slider value to 100 and then select the end keyframe and change its Foreground slider value to 0.

	If you’ve been following along, you have produced a very unusual result.




	□ Close the Effect Editor or click in the Timeline’s timecode track.

	□ Play the sequence to discover the potential and power of keyframes to modify effects.

	Your dissolve now works in reverse, starting with the B-side and ending with the A-side.











Effect Templates

After doing all of that hard work, you may want to reuse the transition in other parts of your sequence. For this, you can save effects as templates and use them repeatedly without having to re-create them.

It’s best practice to save your effect templates in their own separate bin.


[image: Figure 10.23 The effect icon allows you to save the effect as a template.]
Figure 10.23 The effect icon allows you to save the effect as a template.




To Save an Effect Template from the Effect Editor:


	□ Create a new bin called Transitions.

	□ From the upper-left corner of the Effect Editor, drag the effect icon (shown in Figure 10.23) into the Transitions bin.

	□ Once your transition is in the bin, name it Reverse Dissolve.

	You rename effects in bins the same way you rename clips in bins—just click on the text and start typing the new name.









To Apply Effects Templates from a Bin:


	□ From the bin, drag an effect template onto an edit point in your sequence.

	Any open bin that contains an effect template will also be displayed as a category at the bottom of the Effect Palette (The category will be named after the bin where you put the effect). Selecting the bin category will display all the effect templates from that bin on the right side of the Effect Palette.











Creating Titles with Avid Titler+

A title can be created in a graphics program such as Photoshop and input into Media Composer in the same way you ingest any media file. However, you can create your own titles inside Media Composer.

We will use Avid Titler+ to create titles in Media Composer. With Avid Titler+, you can put a graphic on a segment without needing to use a second video track, or you can create a second video track to customize when your title appears on screen. In either case - the title is technically an effect that goes on top of segments in the Timeline. The big advantage of generating titles within Media Composer is that you can edit them quickly. If there is a change of detail or a spelling correction required, then it can be easily updated.


Applying a Title to an Entire Segment in the Timeline:


	□ Open the Ski Field project.

	□ Create a new sequence and splice in the 5 seconds of the following three clips (in order):

	5 seconds of clip C0017

	5 seconds of clip C0030

	5 seconds of clip C0028




	□ Select a segment in V1 by clicking on it in the Timeline with the Lift/Overwrite tool, then either:

	□ Click the Avid Titler+ button in the toolbar at the top of the Timeline, as shown in Figure 10.24, or

	Select Tools > Avid Titler+ from the menu at the top of the screen.







[image: Figure 10.24 Avid Titler+ button.]
Figure 10.24 Avid Titler+ button.



Four things happen when a title is applied to the segment:


	A title effect icon appears on the segment in the Timeline.

	The Avid Titler+ tool opens.

	The Effect Editor opens.

	In Avid Titler+, the Text mode is activated and ready for you to type.




[image: Figure 10.25 The new windows and icon that appear after opening Avid Titler+.]
Figure 10.25 The new windows and icon that appear after opening Avid Titler+.






To Edit a Title:

Without being too concerned about font type, size, and other attributes, click in the middle of the Effect Preview monitor and type the title CHINA PEAK. Click between the words “China” and “Peak” and press enter, so that the words are on two different lines. The text will appear inside the text box (see Figure 10.26).


[image: Figure 10.26 Text typed inside the text box with Avid Titler+.]
Figure 10.26 Text typed inside the text box with Avid Titler+.



With the text box as the active element in the Effect Preview monitor, you can begin modifying the basic text attributes in Avid Titler+. You might be familiar with general text attributes, such as font selection, bold, italic, underline, shadow, and justification. These attributes work the same way in Media Composer.


[image: Figure 10.27 Text attributes can be modified from this area.]
Figure 10.27 Text attributes can be modified from this area.



Before making changes to any text, you need to select the text by triple clicking on the text, or switch to Move mode and click on the text. This will make control handles visible around the text box. From there, you can reposition and resize the text from within the Effect Preview monitor.

More settings (also known as parameters) can be modified and animated from within the Effect Editor. Many of these parameters are replicated in both the Effect Editor and the Avid Titler+ tool, so you can use either to modify the title.


[image: Figure 10.28 Avid Titler+ tool and the Effect Editor.]
Figure 10.28 Avid Titler+ tool and the Effect Editor.




	□ Triple click on the text to select all of the words.

	You can also select all of the words by clicking and dragging your mouse around them (this is called lassoing)




	□ In the Avid Titler+ tool, click the Horizontal Justify Center button. This centers each line of text within the text box.

	□ Press ESC on your keyboard to toggle from Text mode to Move mode.

	□ In the Effect Preview monitor, click a word once to select the text box.

	A white box will appear around the text.




	□ In the Avid Titler+ tool, click and drag across the Size parameter value and increase it to 275.0

	To make this process faster, you can click on the number and type 275 on your numeric keypad, if you have one.




	□ In the Align H. parameter, press the Align Center button to center the text box horizontally in the screen.

	□ In the Align V. parameter, Press the Align Center button to center the text box vertically in the screen.



Sometimes the background image is too bright compared to the title, so the creation of a shape within the title may help our audience be able to read the title we create.




To Create a Shape in Avid Titler+:


	□ Select the Add Rectangle tool.

	□ Click and Drag in the Effect Preview monitor to create a large square that almost covers the entire screen. It’s okay that it covers your text.




[image: Figure 10.29 Click the Add Rectangle tool and a default shape is created]
Figure 10.29 Click the Add Rectangle tool and a default shape is created




	□ Use the Send to Back button to send the background shape behind the text (See Figure 10.30)




[image: Figure 10.30 Click on the Send to Back button and the shape is sent behind the text.]
Figure 10.30 Click on the Send to Back button and the shape is sent behind the text.




	□ Modify the transparency by lowering the fill % Slider of the background shape from within the Fill parameter group in the Effect Editor. Turn it down to 65%.

	□ Turn Off the Shadow parameter.




[image: Figure 10.31 Transparency of the shape set to 65%.]
Figure 10.31 Transparency of the shape set to 65%.




	□ Once you are happy with your title, close Avid Titler+ and play your sequence.



The title we created looks good, and it was easy to create. Chances are, though, you’ll have to go back and fix a spelling error or make changes to your titles at some point.




To Modify an Existing Title in the Timeline:


	□ With the Lift/Overwrite arrow, click on the title in the Timeline.

	□ Reopen Avid Titler+ by clicking on the button in the Timeline palette.

	□ With Type mode on, triple click on the text.

	The text is selected and ready for you to make any changes.









To Create a Title Template:


	□ To save the title as a template in a bin, click and drag the effect icon out of the Effect Editor and into a bin.

	It’s best to have a bin that you keep titles and any other effect templates in.









To Apply a Title from a Bin to a Segment in the Timeline:


	□ Drag and drop the title icon from your bin onto a segment in the Timeline.






To Remove a Title from a Segment:


	□ Turn on the track selector for the segment’s track the effect is on.

	□ Park the position indicator on the effect icon and click the Remove Effect button, or

	Select the segment in the Timeline and press the Delete key on the keyboard.











Adding a Title over Multiple Segments

There are many occasions when you want the title to span across two or more segments in your sequence. To achieve this, you’ll need to learn how to work with multiple tracks.

When you use this method of adding titles, you can move, trim, and cut titles just like you do when you move, trim, and cut segments.

Before you proceed, make sure you followed the steps above and have saved a copy of the title effect as a template in a bin. Then remove the title from the segment in the Timeline.


To Add Tracks to your Timeline:


	□ Select Timeline > New > Video Track from the menu at the top of the screen, or

	Right click in the Timeline then click New > Video Track




	□ Turn on the track selector for V2 and turn off all other record track selectors

	□ Switch the Video Track Monitor button to the V2 track (Figure 10.32)








Adding a Title Across Two Segments


	□ In the Timeline, park the blue position indicator in the middle of the first clip.

	□ Click the Add Edit button located in the toolbar at the top of the Timeline. You are adding an edit to filler.

	□ Move down over the middle of the second segment in the timeline and apply another Add Edit to the V2 track where you want to fade out the title. Depending on the brightness of your user interface, you should be able to see the two add edits in the filler.

	□ Drag and drop the title template from the bin onto the filler segment you created between the Add Edits marks (See Figure 10.32).




[image: Figure 10.32 The title template applied to filler on track V2, with the Video Track Monitor button enabled on the V2 track.]
Figure 10.32 The title template applied to filler on track V2, with the Video Track Monitor button enabled on the V2 track.




	□ Play back the sequence. You will see the title pops in and out over the background segments on track V1. That seems a little jarring, since we are used to seeing titles fade on and off the screen.




To Dissolve Titles Using Transitions:


	□ Turn on only the track that contains the title.

	□ Park the position indicator over the beginning of the title segment.

	□ Using the Quick Transition button, create a dissolve on the beginning and end of your title segment.

	This method can only be done if your title is on a separate track from your segments, not embedded into them.











Lesson 10 Review & Discussion Questions - Part 1


	What must you do to ensure a Quick Transition is added only to a video cut point, and not an audio cut point?

	What is a handle, and why is it important in the context of transition effects?

	What function must be enabled before you can modify a transition effect from within the Timeline to change its duration or position?

	True or False: The Transition Corner Display shows the first, middle, and last frames of the A-side and B-side of the transition.

	If you want to add multiple dissolves to a series of cut points using the Quick Transition dialog box, how do you identify the cuts that will get the dissolves?

	True or False: Dragging a transition from the Effect Palette onto an existing transition in the Timeline replaces the existing transition.

	What does a green dot on an effect icon mean?

	What is the benefit of using the Effect Editor on transitions?

	When you open the Effect Editor what happens to the Record monitor in the Composer window?

	How can you save an effect as a template?






Lesson 10 Review & Discussion Questions - Part 2


	How does the Avid Titler+ effect behave when it is applied to an entire segment in the Timeline?

	How does Avid Titler+ behave when it is applied to filler on a higher-level video track above a background layer?

	How can you save a title as a template?

	How do you define what part of a filler track you add Avid Titler+ to?

	What does adding a title to a filler track allow you to do compared to adding it to a segment?






EXERCISE 10

[image: chpt_fig_015.jpg] Transitions and Titles

Project: Rock Climber Documentary_(Student ID)

Duration: 30 Minutes


GOALS


	Add a Dip to Color transition and save it as a template

	Add a title to your sequence

	Add a dissolve transition to your title






Goal #1: Add a Dip to Color Transition and Save It as a Template


	□ Open your Rock Climber Documentary_(Student ID) project, open your Rock Climber Version 4_With Transitions sequence.

	This is the sequence you made if you followed along with the steps in the lesson.




	□ Use either Quick Transition or the Effect Palette to add a Dip to Color transition to the first edit in the sequence

	□ Open the Effect Editor for that transition and see that the Dip to Color transition has a Background Color parameter that you can change. Click on the disclosure triangle to reveal the Hue, Saturation and Luminance sliders.

	□ Choose a color other than black.

	□ Adjust the timing of the transition to your liking.

	□ Save the transition as a template in the Transition bin you created in the lesson.

	□ Rename your transition Dip to (whatever color you chose)

	□ Apply your new transition effect template to the first 5 edits in the sequence.

	You can add a transition to each edit in turn or apply them to all transitions at once.









Goal #2: Add a Title to Your Sequence


	□ In your Rock Climber Documentary_(Student ID) project, load your Rock Climber Version 2 sequence.

	□ If you don’t already have one, create a V2 video track.

	□ Apply Add Edits to the filler on the V2, so a title will span across the first two shots of the sequence.

	□ Apply an Avid Titler+ effect to the filler, making sure your Video Track Monitor button is enabled on the higher video track.

	□ In the Effect Preview monitor, type a title for the film about this rock climber. Use the available text attributes to give your title a style appropriate for the program content.

	□ Using the Move mode, vertically and horizontally center the title in the screen.






Goal #3: Add a Dissolve Transition to Your Title


	□ Using the Quick Transition tool, add dissolves to the beginning and end of the title, so it fades nicely on screen.

	Because your title works just like a segment, if you don’t like the placement, or would like to trim it to make it longer or shorter, you can.




	□ Adjust the title placement in the sequence.








Screenshots Due:


	□ With the Transitions bin open, your entire Rock Climber Version 4_With Transitions sequence in the Timeline, and your position indicator parked in the middle of a dip to color transition, take a screenshot of your entire screen.

	□ From the Record monitor, take a screenshot of your title.











[image: chpt_fig_001.jpg] LESSON 11

Efficient Editing Techniques

There is so much more to Media Composer than what you’ve learned so far. In this lesson, you’ll learn some of the features that will make you a much more efficient editor. The bulk of your time spent editing should be making creative decisions, not fiddling with buttons and functions—but as an editor-in-training, it is important to know the different buttons and functions available to you.

Duration: 30 Minutes


GOALS


	Understanding 3-point editing

	Create multiple video and audio tracks

	Understand the different ways to patch tracks

	Use Sync Locks to maintain sync

	Efficiently move multiple segments up and down tracks

	Rename and color tracks in the Timeline

	Create and modify workspaces







3-Point Editing

Drag-and-drop editing is a fine way to build your sequence, but more experienced editors will use 3-point editing to add clips into their sequence—especially if they’re adding clips to a sequence that has already been built.

You’ve already used the 3-point editing technique in previous lessons, when you used IN and OUT marks and the Overwrite/Splice-in commands to put clips into your sequence. It’s called 3-point editing because you use 3 marks to perform the edit.


	For example, you mark an IN point on a source clip where you want your clip to begin. You mark an OUT point on your source clip where you want your clip to end. Then, in your Timeline, you mark an IN point where you want the clip to be placed. This is just one example of how to perform a 3-point edit (Figure 11.1).




[image: Figure 11.1 Preparing to make a 3-point edit.]
Figure 11.1 Preparing to make a 3-point edit.



Drag-and-drop editing is not 3-point editing, because technically you don’t need any IN and OUT marks to perform an edit. In this lesson, you’11 learn how to effectively use the 3-point editing technique.




Working with Tracks

Experienced editors always work with multiple video and audio tracks—adding multiple tracks, even if they’re empty, creates room for more creativity. You can move segments around, test them out, stack visual effects, use filler for color correction, and so much more. Before that can happen, you need to add empty tracks so you can say to yourself, “There’s so much space to!”



To Add Video Tracks:


	□ With a sequence open in the Timeline, from the menu bar at the top of your screen, choose Timeline > New > Video Track, or

	Right-click in the Timeline, then choose New > Video Track, or

	Press Ctrl+Y (Windows) or Command+Y (Mac).






At this point, you may have noticed small icons that look like speaker on the audio tracks. Some audio tracks have one speaker icon, while others have two speaker icons stacked on top of each other. The single icon represents a mono track. The double icon represents a stereo track. The difference between the mono and stereo will be covered later in lesson 18. For now, all you need to know is how to create the different types of audio tracks.


[image: Figure 11.2 In this Timeline, track A1 and A2 are mono tracks, while track A3 is a stereo track.]
Figure 11.2 In this Timeline, track A1 and A2 are mono tracks, while track A3 is a stereo track.






To Add a Mono Audio Track:


	□ With a sequence in the Timeline, from the menu bar at the top of your screen, choose Timeline > New > Audio Track > Mono, or

	Right-click in the Timeline, then choose New > Audio Track > Mono, or

	Press Ctrl+U (Windows) or Command+U (Mac).









To Add a Stereo Audio Track:


	□ With a sequence in the Timeline, from the menu bar at the top of your screen, choose Timeline > New > Audio Track > Stereo, or

	Right-click in the Timeline, then choose New > Audio Track > Stereo.

	Press Shift+Ctrl+U (Windows) or Shift+Command+U (Mac).











Patching Tracks

Once you’ve added multiple tracks to your Timeline, when you start adding clips in from the Source monitor, you need to stop and think: Which track do I want to place the clip on? For example, I might have three video tracks in my sequence (V1, V2, and V3) but my source clip only has a V1 track. So which track will my V1 source clip be placed? V1, V2, or V3?

When you use the drag-and-drop method of editing, you can directly drag a video or audio clip onto the track where you want it to go.

When you use 3-point editing, you need to connect (also known as patching) source video or audio clips to the specific record tracks where you want to place them in your Timeline. Patching tracks enables you to edit a source video track onto any available record video track in the Timeline by turning your tracks on and off.

Source audio tracks (audio that is in the Source monitor) can only be patched to record audio tracks of the same type. A mono source track can only be patched to a mono record track, and a stereo source track can only be patched to a stereo record track.


Auto-Patching

Auto-Patching is a default setting that allows you to automatically patch tracks based on which tracks are turned on.




To Patch Tracks Using Auto-Patching:


	□ Disable the record track selectors (blue) to which the source tracks selectors (green) are currently patched.

	□ Enable the desired record track selectors.

	The enabled source track selectors will jump next to the newly enabled record track selectors. This is Auto-Patching.









Manually Patching Tracks

Manual patching is when the editor manually aligns a source track selector with the record track selector.




To Manually Patch Tracks Using Click and Drag:


	□ Click and drag the source track selector (V1 in Figure 11.3) to the target track that you want to patch.

	A white arrow will help you visualize exactly which track you are patching to.

	The source track selector you selected jumps to the record track selector and becomes active.








[image: Figure 11.3 Drag from the Source track selector to the target record track to manually patch the track.]
Figure 11.3 Drag from the Source track selector to the target record track to manually patch the track.






To Activate/Deactivate Track Selectors Using the Keyboard:

You can also use keyboard shortcuts to turn on and off your tracks.


	□ Select either the Record monitor or Source monitor in the Composer window.

	□ Press the keys shown in figure 11.4 to activate or deactivate a track selector.




[image: Figure 11.4 Track Selector activation using the keyboard shortcuts.]
Figure 11.4 Track Selector activation using the keyboard shortcuts.








Using Sync Locks

Previous lessons covered using Sync Lock to maintain sync. This is particularly helpful when you are using Splice-in to add clips between segments that are already in the Timeline.

To review - in the Track Control panel, turn on the Sync Lock button next to the timecode track. As you can see in figure 11.5, all tracks in the Timeline are now locked so they will maintain sync during 3-point editing.

It’s important to note that Sync Locks will not work when using Segment tools to move segments around in the Timeline. When moving segments around using the Extract/Splice-in tool, or deleting segments from your sequence, keeping the Link Toggle Selection activated is key to maintaining sync.



[image: Figure 11.5 Turning the Sync Lock buttons on and off.]
Figure 11.5 Turning the Sync Lock buttons on and off.



However, when you are using multiple video tracks, you may not want all tracks to be locked together in sync. For instance, you may have all the interview segments exactly where you want them on tracks V1 and A2 and you don’t want them to move as you edit in climbing shots on V2 and A1. As you try editing in new climbing shots and rearranging existing segments, you may only need to maintain sync between the segments on V2 and their corresponding natural sound on track A1.


To Maintain Sync between Specific Tracks:


	□ Turn on the Sync Lock button beside the individual track selectors of the tracks you want to keep in sync before using the Overwrite or Splice-in commands to place a clip into your sequence.






Recognizing Broken Sync

We covered broken sync in a previous lesson, but here’s a quick review of it. Media Composer will indicate if audio and video segments that come from the same source have broken sync by overlaying little numbers and thin lines along the bottom edges of the segments, as shown in Figure 11.6. The value indicates the number of frames they are out of sync by.


[image: Figure 11.6 The small numbers indicate how many frames the segments have broken sync by.]
Figure 11.6 The small numbers indicate how many frames the segments have broken sync by.








Moving Segments Between Tracks

Now that you’ve made some empty tracks in your Timeline, allowing you more room to work creatively, let’s find out some helpful hints to move segments up and down in your tracks.

In previous lessons, you learned how to use the Lift/Overwrite and Extract/Splice-in segment tools to add clips to a sequence and move them around the Timeline.

You can also use these Segment Mode tools to move segments vertically from one track to another. Table 11.1 shows a couple of additional keyboard shortcuts that will help ensure that you move the segments exactly as you wish.





	Keyboard Shortcut
	Result





	Ctrl-drag (Windows) / Command-drag (Mac)
	Snaps the head of the segment to edit points on the timeline. Use this when moving segments from left to right.



	Ctrl+Shift-drag (Windows) / Command+Shift-drag (Mac)
	Locks the segment to vertical movement only—when pressing this, you cannot move segments left to right—only up and down tracks





Table 11.1 Useful keyboard shortcuts when moving segments.



The table shows that you can move a segment vertically between tracks without letting it slip horizontally along the Timeline as you move it.

However, you need to be aware of which Segment Mode tool you are using as you move the segment. In this scenario, let’s use the Lift/Overwrite tool.


Move Segments Vertically by Keyboard:


	□ Turn on the Segment Mode button.

	□ Remember that when the Segment Mode button is turned on it has a light grey highlight around it. If both Lift/Overwrite and Extract/Splice-in segment modes are active, then the tool’s icon appears as a split red/yellow arrow, as shown in figure 11.7.

	□ Using the Lift/Overwrite tool, click on the segment you want to move.

	□ Press the Up and Down arrows on your keyboard.

	□ Notice that when you move the segment up and down using the keyboard arrows, the segment doesn’t move left to right.






Move Segments Vertically with Tools:

Eventually, you’re going to want to move video or audio segments up or down tracks. It’s important that when you’re doing this, you don’t accidently move the segment from left to right. There are different ways to do this. First we will explore moving segments vertically with segment tools, then we will learn how to do the same thing using keyboard shortcuts.


	□ To move a segment up and down using segment tools, enable Segment mode as a Smart tool, as shown in in figure 11.7.

	□ Remember, the position of the cursor in the Timeline automatically determines which segment tool will be used, as shown in figure 11.8.




[image: Figure 11.7 Segment Mode button when it’s enabled as a Smart tool.]
Figure 11.7 Segment Mode button when it’s enabled as a Smart tool.




[image: Figure 11.8 Segment Mode when both tools are active will change depending on where your mouse is placed.]
Figure 11.8 Segment Mode when both tools are active will change depending on where your mouse is placed.




	□ Move one of the segments up to track V2 with the red Lift/Overwrite tool.

	Notice that you can slide the clip from left to right if you want.

	Notice that filler is left in the Timeline as you move the segment up to V2.




	□ Undo the edit.

	□ Now, move one of the segments up to track V2, but this time, Ctrl+Shift-drag (Windows)/Command+Shift-drag (Mac). It should only move vertically between tracks without moving horizontally along the Timeline.





[image: Figure 11.9 The Lift/Overwrite tool lifts the segment from one track and overwrites it on the other.]
Figure 11.9 The Lift/Overwrite tool lifts the segment from one track and overwrites it on the other.




	□ Undo the edit.

	□ Move the cursor over the bottom half of the same segment on V1. The cursor should change into the yellow Extract/Splice-in tool.

	□ Ctrl+Shift-drag (Windows)/Command+Shift-drag (Mac) the segment to V2. Again, it will move vertically, but not horizontally, as shown in figure 11.10. But now the video segments to the right move to close the gap on V1. Now all of the video tracks on V1 are out of sync with their audio segments.

	When performing this task with the Extract/Splice-in tool, you might throw your entire sequence out of sync.







[image: Figure 11.10 The Extract/Splice-in tool extracts the segment from one track and splices it in on the other. Following segments close the gap and sync is broken.]
Figure 11.10 The Extract/Splice-in tool extracts the segment from one track and splices it in on the other. Following segments close the gap and sync is broken.




	□ Undo the edit.








Selecting Multiple Segments

There will be times when you want to move multiple segments in the Timeline at once. Using Segment mode, you can select multiple segments at once. There are several ways to do this. Choose the way that works best for you.


To Select Multiple Segments Using Shift+Click:


	□ Enable one or both Segment mode tools.

	□ While holding down the Shift key, click each segment that you want to select.

	Each segment is highlighted to indicate it is selected. This is useful for selecting a few segments, whether they are right next to each other or not.

	You can use the “Shift-click” method to deselect segments as well.









To Select Multiple Segments Using a Lasso:


	□ Starting in the gray space below the timecode ruler but just above the top video track, click-and-drag the cursor down and to the right. This creates a lasso.

[image: Figure 11.11 Creating a lasso to select multiple segments at once.]
Figure 11.11 Creating a lasso to select multiple segments at once.




	The direction that you create the lasso is very important. Lassoing from left to right selects multiple segments. Lassoing right to left puts you into an entirely different type of editing mode—trim mode (specifically a trim type called slipping— you can learn more about slipping in the Media Composer 110 book).

	The lasso must completely encompass a segment to select it.




	□ Release the cursor button to select the segments.

	All segments completely inside the lasso when you release will be highlighted. This is useful for selecting a group of segments next to each other, even if they are stacked on top of each other on different tracks.









To the Left, to the Right, and Select In/Out Buttons

You can select a group of segments by using dedicated buttons in the Timeline. It’s important before using these buttons that you check which tracks are active. These are shown in Table 11.2.






	Button
	Name
	Description





	[image: chpt_fig_280.jpg]
	Select Left
	Selects the segments to the left of the position indicator on all active tracks



	[image: chpt_fig_281.jpg]
	Select Right
	Selects the segments to the right of the position indicator on all active tracks



	[image: chpt_fig_282.jpg]
	Select In/Out
	Selects all segments between the IN and OUT marks on all active tracks





Table 11.2 Buttons for selecting multiple segments.






To Map the Buttons to the Timeline Toolbar:


	□ From the menu at the top of the screen, select Tools > Command Palette.

	□ At bottom-left of the Command Palette, make sure the ‘Button to Button Reassignment’ button is selected.

	□ From the Edit tab of the Command Palette, drag-and-drop each button from the table above in turn to a blank button in the Timeline toolbar.

	□ Close the Command Palette.




[image: Figure 11.12 The Button to Button Reassignment button, and helpful buttons to map to the Timeline toolbar.]
Figure 11.12 The Button to Button Reassignment button, and helpful buttons to map to the Timeline toolbar.






To Select Segments by Using Dedicated Buttons:


	□ Select the tracks containing segments you want to move by turning on their track selectors.

	Optionally, add IN and OUT marks to define a region of the sequence.




	□ Click the Select Left, Select Right, or Select In/Out button to make your selection.

	The segments are selected in the same way as if you had selected them with the segment tool. You can now move these segments together with either your red Lift/Overwrite or yellow Extract/Splice-in tools.











Monitoring Video Tracks

In previous lessons, you used the Solo and Mute buttons in the Track Selector panel of the Timeline. The Video Track Monitor button in the Track Selector panel can work similarly to the Solo button if you click it while holding down Ctrl (Windows) or Command (Mac) on your keyboard. The Video Track Monitor button will turn bright green, indicating that you are seeing only one video track—and nothing else underneath it.

Each video track has a Video Track Monitor button, but unlike when you Solo or Mute multiple audio tracks, you can only have one Video Track Monitor button active at any one time. Or, you can turn the Video Track Monitor button off and not see any of your video tracks.


[image: Figure 11.13 The different ways you can use the Video Track Monitor button.]
Figure 11.13 The different ways you can use the Video Track Monitor button.




	You can use the Video Track Monitor button on both record track selectors and source track selectors in the timeline. Figure 11.13 shows how it works with Record tracks.

	When the Video Track Monitor button for V2 is active, you will see from the V2 track down to all tracks below. In the example above, the blue position indicator is parked where a climbing shot of the rock climber on V2 obscures the shot of him in interview on V1 underneath.

	When the Video Track Monitor button for V1 is active, you will see from track V1 down. You can now see the rock climber in an interview because you are seeing what is on the track below.

	If you turn all Video Track Monitor buttons off, you see nothing but a black screen on the Record monitor, because you are not monitoring any video tracks.

	If you hold down Ctrl (Windows) or Command (Mac) on your keyboard while clicking on the Video Track Monitor button, you will effectively solo that track—meaning you cannot see anything on any other track beside the segments on the track you are monitoring.





[image: chpt_fig_278.jpg]


STOP & THINK

If you have segments in your Timeline, but you can’t see them in the Record monitor, you have to Stop and Think:


	Check your Video Track Monitor button – you might have accidentally turned it off, and all you need to do is turn it back on to see the footage on your Timeline.

	This accident can also happen for your source tracks. If you have a clip loaded in the source monitor, but can’t see anything, check the Video Track Monitor button on the source side. Chances are, it’s off and just needs to be turned back on.








Staying Organized

Not only do Timeline tracks allow you to arrange and combine video and audio segments, but they play an important role in keeping your work organized. In editing your rock climbing sequence, you have used the following track layout:


	V1: Footage

	V2: Title

	A1: Natural Sound (FX audio)

	A2: Narration (Interview)

	A3/A4: Music (stereo)



Figure 11.14 illustrates what your track layout and arrangement of segments might look like so far.


[image: Figure 11.14 The Rock Climber Version 4_With Transitions sequence.]
Figure 11.14 The Rock Climber Version 4_With Transitions sequence.



By keeping the audio on separate tracks, you can immediately see the relationships between each type of sound. It also makes monitoring, editing, adjusting levels, and mixing much easier.

It is often helpful to place different types of video clips on separate tracks. For instance, in Rock Climber, you might like to edit all the interview clips onto V1 and all the climbing clips (or b-roll) onto V2. Here’s a helpful hint to help you stay organized when things start to get messy in your Timeline.


To Rename Tracks:


	□ In the Track Selector panel, right-click a track’s name.

	□ Click Rename Track.

	□ Type a new name for the track and click OK. Figure 11.15 shows an example of a sequence that has its tracks renamed.






To Color Tracks:


	□ In the Track Selector panel, right-click a track’s name.

	□ Hover over Track Color.

	□ Choose a new track color.



Now that you know how to select multiple segments, move them vertically, rename tracks and change the track color, you’re able to spend some time organizing your sequence. Figure 11.15 is an example of a sequence that has great organization: its tracks are clearly labeled, and the colors of the tracks are all separated by type.


[image: Figure 11.15 A Timeline with re-named tracks and customized track colors.]
Figure 11.15 A Timeline with re-named tracks and customized track colors.








Managing your Workspace

You already know that in Media Composer, you can adjust the sizes of your panels and windows. When you make those adjustments, you can save them by creating a new workspace. Different phases of production might call for different workspaces. Media Composer makes this easy in two different places—the Windows > Workspaces menu and the Workspace bar.

Figure 11.16 shows the Windows > Workspaces drop-down menu. The top section includes four default workspaces:


Edit workspace - This is the default workspace when you open Media Composer. It’s the workspace you’ve been working in for most of the book so far. It has the Source and Record monitors in the Composer window, the Timeline, and the Bin Container all evenly spaced out. You can use this workspace when you are ingesting, organizing clips, and creating your sequence.

Effects workspace - You can use this workspace when you’re doing heavy duty effects work, like keyframing or creating titles. It keeps the Effect Editor open, docking the panel between the Composer window and Bin Container.

Color workspace - You can use this workspace when you are color correcting shots.

Audio workspace - You can use this workspace when you’re mixing your sequence. It keeps the Audio Mixer tool open, docking the panel between the Composer Window and Bin Container.





[image: Figure 11.16 The Windows > Workspaces menu.]
Figure 11.16 The Windows > Workspaces menu.




To Customize a Default Workspace:


	□ Make changes to the size and layout of the panels and windows. You can even open a tool and dock it to one of the windows.

	□ Click on Windows > Workspaces > Save Current. This layout will replace the default and become the new configuration of the workspace.






To Restore a Workspace to its Default Layout:


	□ Click on Windows > Workspaces > Restore Current to Default…






To Create a New Workspace:


	□ Click on Windows > Workspaces > New Workspace.

	□ Type in a name for your workspace.

	□ Click OK

	The workspace you created will now show up as an option in Windows > Workspaces and will also appear in the Workspace bar.











The Workspace Bar

The Workspace bar, at the far right of the interface, is a different way to access most of the same options as the menu bar. Just click a workspace icon to switch.



[image: Figure 11.17 The Workspace bar with four default workspaces, and three customized workspaces.]
Figure 11.17 The Workspace bar with four default workspaces, and three customized workspaces.




To Hide the Workspace Bar:


	□ At the bottom of the Workspace bar, click the circular button with a triangle inside.

	□ In the pop-up menu, choose Hide Workspace Bar.




[image: Figure 11.18 The Workspace Bar pop-up menu.]
Figure 11.18 The Workspace Bar pop-up menu.








Lesson 11 Review & Discussion Questions


	What is the benefit of working with multiple video and audio tracks?

	Will sync locks work to maintain sync if you use segment tools when moving around or deleting segments from the Timeline?

	What is the difference between auto-patching and manually patching tracks?

	What are the two ways source tracks can be patched to record tracks?

	What are the shortcut keys that allow you to turn track selectors on and off?

	How can you move a segment up or down a track without accidentally sliding it left to right?

	How can you use segment tools to select multiple segments in the Timeline? Describe at least two ways.

	How do you control monitoring of video in the Timeline?

	What are some ways you can organize your Timeline?

	After you adjust the window sizes and the layout of the interface, how do you save it to use later?






EXERCISE 11

[image: chpt_fig_015.jpg] Efficient Editing Techniques

Project: Rock Climber Documentary_(Student ID)

Duration: 1 Hour


GOAL


	Finish editing the 3-minute rock climbing sequence






Goal: Finish Editing the 3 Minute Rock Climbing Sequence


	Start with either the Rock Climber Version 4_With Transitions, or the Rock Climber Version 2 sequence.

	Duplicate the sequence and name it Rock Climber_Locked Cut.

	Using the efficient editing techniques and all of the exercises you’ve done so far, edit your Rock Climbing sequence to the best of your abilities.

	Your sequence should have, at a minimum, the following elements—in no required order (use the check boxes to make sure you have the required elements in your sequence):







	□ 1 title

	□ 1 Dip to Color effect

	□ 1 video dissolve

	□ 1 audio crossfade

	□ 1 on-camera interview video shot

	□ 3 interview clips (2 off-camera narration)

	□ Footage throughout the entire 3-minute music track

	Right now, there is a gap at the end of your sequence. Fill that with either interview or B-roll.




	□ Music, with the volume lowered underneath the interview bites, and with transitions

	□ Properly mixed audio






Advanced Editing Suggestions:


	□ Using the Avid Titler+, try giving the rock climber a lower third title. His name is Matt Rodgers, and he’s a professional rock climber.

	□ Fade up from black on the first shot, and fade to black on the last shot.

	□ Use the Trim tools to make the pacing as up-beat as the music.

	□ Use your waveforms as a guide to edit the cuts to the beat of the music.

	□ Play around with more transitions in the Effect Palette.

	□ Have fun! This is your time to be creative and show off the skills you’ve learned so far!








Screenshots Due:

With your entire sequence visible, take a screenshot of the entire Timeline.









[image: chpt_fig_001.jpg] LESSON 12

Exporting

Now that you’ve learned the fundamentals of editing in Media Composer | First, you might want to export your sequence and share it. There are many different export settings to choose from, but in this lesson we will learn a quick and easy way to export to your computer. From there, you can choose where to send your finished work.

Duration: 10 Minutes


GOALS


	Export a sequence

	Save export settings as a preset

	Export in high definition

	Understand codecs and why you would use H.264 vs. DNxHD






Exporting Your Video

It’s time to share all of your finished sequence with the world! Where you share your work depends on your usage rights, the type of video you created, and your reason for making it—but before you share your work, you’ll need to get your sequence out of Media Composer and onto your computer.


Exporting a Sequence to a Hard Drive:


	□ From the Rock Climber Documentary project, load the Rock Climber_Locked Cut sequence into the Timeline.

	□ From the menu bar, choose File > Publish to > Local Drive…, or

	Right-click on the Record monitor and select Publish to > Local Drive…

	The Publish dialog box opens, as shown in Figure 12.1.

	Some settings are greyed out, meaning these options are not available.




[image: Figure 12.1 Publish dialog box.]
Figure 12.1 Publish dialog box.




	□ From the Type drop down menu select what you want to export from the Timeline.

[image: Figure 12.2 Type drop down menu]
Figure 12.2 Type drop down menu




	□ Click the Set button to navigate to the destination drive and folder. This is where you will find the final exported video file.

	□ From the Codec menu select the type of compression you want to apply to the exported file. For now, choose the H.264 codec.

[image: Figure 12.3 Codec drop down menu]
Figure 12.3 Codec drop down menu




	□ From the Quality drop menu, select Best.

	This setting is only available if you selected the H.264 codec.




[image: Figure 12.4 Quality drop down menu]
Figure 12.4 Quality drop down menu




	□ Select the Stereo button.

	Audio will be exported as a stereo track with left and right channels. The mono option will export the audio as a single channel of audio.






These settings can also be saved as a preset that you can use whenever you want to export another sequence using the same settings.




To Save Export Settings as a Preset:


	□ In the Profile section, Type a name for the profile in the open field.

	□ Click Save profile.

	Next time you export, you’ll be able to see your preset in the Profile drop down menu.




	□ Click OK.

	A progress bar will appear indicating how long the export is taking, as shown in figure 12.5.

	While exporting, you will not be able to use Media Composer.

[image: Figure 12.5 Export progress bar]
Figure 12.5 Export progress bar







	□ Once the export is complete, locate the exported file and play it.






[image: chpt_fig_278.jpg]


STOP & THINK

After you export, you have to Stop and Think:


	Did I play my file and watch it through to make sure that there is video, audio, and correct sync?

	It’s easy to get excited and walk away after you export. Best practice is to play back your exported file and make sure it looks exactly the way you want!








Exporting as High Definition


	□ Follow the steps above, but this time choose the DNxHD codec from the Codec drop down menu.








Codecs

The word Codec is a combination of two words: Compression/Decompression. Codecs are explained in more detail in the Media Composer 110 book, but they’re essentially different ways to compress video files.

When you finish your two exports, compare the file size of the H.264 version with the file size of the DNxHD version.

The DNxHD file size will be considerably larger than the H.264 file but when you play both files there should be no observable difference in video quality.

So, what is the difference? The H.264 codec heavily compresses the file while maintaining a high-quality image. It is an excellent codec when you want to publish a video to the internet. The smaller the file, the easier it is for it to stream over the internet without interruption.

The DNxHD codec is a ‘softer’ codec that retains more data, and therefore more information, in the exported file than the H.264 codec does. While the larger file size is generally unsuited to playing over the internet, it is ideal as a master format from which other versions can be produced. For instance, it could be used to author a high-quality DVD or Blu-ray disc.

Publishing a DVD or Blu-ray disc is not a feature available in Media Composer | First—if that’s what you want to do, you’ll have to use a separate application. DVD and Blu-ray also use heavy compression but recompressing an already heavily compressed H.264 file risks losing more visual information and therefore degrading the picture quality compared to a disc produced from the better DNxHD file.

It ultimately comes down to choosing an export file format that suits the intended purpose, so it’s best practice to ask your client how they want the file delivered.




Lesson 12 Review & Discussion Questions


	In which menu can you find the Publish To… command?

	What codec is best used to create a file published to the internet, like YouTube or Vimeo?

	What is one of the obvious differences between a video file with the DNxHD codec compared to one created with the H.264 codec?

	What’s the advantage of a larger size exported file?

	If you exported your sequence but the exported file contained no audio, what Export setting would have caused that to happen?






EXERCISE 12

[image: chpt_fig_015.jpg] Exporting

Project: Rock Climber Documentary_(Student ID)

Duration: 15 Minutes


GOAL


	Export your Rock Climbing sequence






Goal: Export Your Rock Climber Sequence


	□ Before you start this lesson, find the files you exported while working through the lesson and delete them from your computer.

	□ In the Rock Climber Documentary_(Student ID) project, open the Rock Climber_Locked Cut sequence.

	□ Before exporting, turn on the Video Track Monitor button on to the highest track.

	□ Make sure that no audio tracks have Solo or Mute enabled.

	□ Play back your entire sequence and fix any mistakes that you see.

	□ Export with the H.264 Codec, Best quality, and Stereo tracks.

	□ After the export, watch and listen to your Rock Climber video.

	□ Give yourself a pat on the back for a job well done!








File Due:


	□ Rock Climber_Locked Cut.mov

	Ask your instructor how they would like you to turn your final file in.














[image: chpt_fig_001.jpg] LESSON 13

Effects

You’ve learned how to apply transition effects between segments in the Timeline. In this lesson, you will learn about effects that you apply directly to individual video segments. Visual effects can add interest and drama to a story as well as allow editors to fix shots that are less than perfect. This lesson covers some of the common tools used to improve a variety of those imperfect shots.

Project: Rock Climber Demo

Duration: 35 Minutes


GOALS


	Finding segment effects in the Effect Palette

	Adding effects to segments

	Using the Effect Editor to adjust parameters

	Keyframe the Resize effect to create movement in a shot

	Stabilize shaky footage






Adding Segment Effects

Segments effects are effects that you place on a segment in your sequence. Media Composer has three different visual effect types:


Transition effects - Applied at the transition point between two clips, often to emphasize a change of time, location, or theme. Transition effects include dissolves, dip-to-color effects, wipes, pushes, squeezes, spins, etc.

Segment effects - Applied to an entire segment in sequence to change the look of a shot. Segment effects include color effects, masks, resizes and more.

Motion effects - Applied to entire clips within a sequence or to source clips to vary the frame rate or motion of the footage. You’ll learn more about these in a later lesson.



Segment effects are accessed through the Filters tab in the Effect Palette, as shown in Figure 13.1.


[image: Figure 13.1 Displaying effects in the Image category.]
Figure 13.1 Displaying effects in the Image category.



Remember, the Effect Palette has a series of tabs across the top—Filters, Transitions, Audio Track, and Audio Clip—which organize the effects by type. Each type of effects is further organized into categories listed in the left column, with individual effects appearing in the right column.


	You can look for a specific effect through a search field at the top right of the Effect Palette.




To Search for an Effect:


	□ Open the Effect Palette by clicking on the Effect Palette tab, or

	Use the keyboard shortcut Command + 8 (Mac) or Ctrl + 8 (Windows)




	□ Type the name in the search field. For the purposes of this lesson, type Flop.

	When you start typing, Media Composer filters the effects displayed in the Effect Palette as you type, as seen in Figure 13.2.







[image: Figure 13.2 Search results update as you type.]
Figure 13.2 Search results update as you type.



Once you find the effect you want to add, there are a couple ways you can quickly add it to a segment in the Timeline.




To Add an Effect to a Segment:


	□ Get started by opening the Rock Climber Demo project and opening the Rock Climbing sequence.

	This is not the same project that you’ve been working on in lessons 3–12; this is the very first project you worked on in Lesson 2 - so the Rock Climber Demo project should only have one short sequence in it.




	□ Drag an effect icon from the Effect Palette on a video segment in the Timeline, or

	Enter Effect Mode by entering the Effects workspace, then select a segment (with a Segment tool) in the Timeline, and then double-click the effect icon in the Effect Palette.

	When you add the Flop effect, the frame in the Composer window immediately shows the clip reversed from left to right.

	Not all effects display an immediate result. For some effects, you need to modify parameters before you see any change in the image.

	The Timeline also displays an effect icon on the segment (See Figure 13.3). Each effect icon in the Timeline is designed to symbolize the effect that you have applied.







[image: Figure 13.3 An effect icon in the Timeline.]
Figure 13.3 An effect icon in the Timeline.



In the example shown in figure 13.3, where the effect has been applied to the R04_160 Matt Climbing Top-EditStock clip, the climbers left and right hands have been effectively switched. This may help solve a continuity issue in which the right hand needs to be the one performing the action in both shots.




To Remove an Effect:


	□ Select the segment with the effect icon in the Timeline.

	□ Click the Remove Effect button.








Working with the Effect Editor

You’ve worked with the Effect Editor in Lesson 10. In this section, you’ll be reviewing the Effect Editor and diving a little deeper into what you can do with it. The Effect Editor allows you to have complete control and customization of the effects in the sequence. Because the Effect Editor is only active when you need it, there are times when you might unintentionally close it, or the parameters disappear from the Effect Editor interface. This is most likely to happen if you try to review an effect by scrubbing the timecode track. When working with the Effect Editor, you need to scrub the position bar at the bottom of the Effect Preview monitor (Figure 13.4) to review the effect if you want the Effect Editor to stay open.


[image: Figure 13.4 The Effect Preview monitor.]
Figure 13.4 The Effect Preview monitor.




To Open the Effect Editor:


	□ Use the Effects Editing Workspace. In the menu bar, click Windows > Workspaces > Effects, or




	Click on the Effects button in the Workspace bar, or

	Use the Effect Mode button located in the Timeline palette, or

	In the menu bar, click Tools > Effect Editor.



The Effects workspace is an arrangement of tools and windows specifically for working with effects. This includes opening the Effect Editor and positioning it on the main display right next to the Composer window, which also changes to a single large Effect Preview monitor.






Stabilizing Shaky Footage

A common problem you will encounter as an editor is unstable camera work. In a documentary, it’s not always possible to use a tripod. Sometimes, you want the look and energy of a handheld shot, but just want it toned down. Media Composer has a flexible stabilization effect that can either remove all camera motion, or just eliminate the erratic bumps and jitters but keep the general camera movement.


To Smooth Out a Shaky Shot:


	□ From the Image category in the Effect Palette, drag the Stabilize effect onto the shaky segment in the Timeline.

	□ For this example, use clip R04_156 Matt Climbing-EditStock

	The Tracking Window automatically opens (See Figure 13.5), and the process of stabilization begins automatically. You will see green dots appear and disappear over the image as Media Composer uses 3D tracking to identify and track reference points in the image, and then uses that information to stabilize the shot.




	□ Close the Tracking window and playback the clip to view the results.




[image: Figure 13.5 The Tracking Window.]
Figure 13.5 The Tracking Window.



The effect quickly steps through the clip one frame at a time. Once the entire clip is analyzed, the Stabilize effect inverts the motion data and applies it to the clip, leaving only the smooth movement of the camera.

For example, if the camera suddenly jerks down to the left, the motion data offsets it by repositioning the frame up to the right. The amount the frame has to be offset determines how much it also has to be scaled up in size so the image still fills the frame. The end result is a clip that appears much smoother because it repositions each frame by the same amount but in the opposite direction to the detected movement.

Sometimes, you need a way to compare the original segment with your changes. In the Effect Editor, the green enable buttons allow you to do that, as shown in Figure 13.6. You can click a green enable button to disable that parameter and playback the clip. The settings are still there, so they can be enabled again at any time.


[image: Figure 13.6 The Effect Editor’s enable buttons.]
Figure 13.6 The Effect Editor’s enable buttons.








Resizing a Shot

If you’ve ever taken a photo and used a crop tool to cut out unwanted scenery around the edges, you’ll understand the resize effect. The difference here is that instead of cropping down a photo, you scale up the shot. The result is the same: Unwanted material around the edges of a shot can be removed.


To Use the Resize Effect:


	□ Select the Image category in the Effect Palette.

	□ Drag the Resize effect onto a segment in the Timeline.

	□ Open the Effect Editor

	□ Use the parameters to resize and reposition the image to crop out any part of the frame that you don’t want.

	If you cannot see any parameters displayed in the Effect Editor, check that the track selector (blue) for the track you want to affect is turned on. Park on the effect icon in the segment then reopen the Effect Editor.




	□ To avoid distorting the image while you resize it, in the Scaling parameter, make sure the Fixed Aspect button is checked.

	This ensures the width and height are adjusted in proportion when using the parameter sliders. It also means you only need to change either the X or Y Scaling parameter as the other parameter will automatically follow.






Unlike many other effects, the Resize effect can be manipulated directly in the Effect Preview monitor when the Effect Editor is open. You can reduce the size of the viewing area in the Effect Preview monitor by using the Reduce button (see Figure 13.7), making it easier to work outside the boundaries of the visible frame (to increase the size of the viewing area, click on the Enlarge button).


[image: Figure 13.7 Use the Reduce button to zoom out of the Effect Preview monitor.]
Figure 13.7 Use the Reduce button to zoom out of the Effect Preview monitor.



A white outline surrounds the frame in the Effect Preview monitor. The outline allows you to directly manipulate the Resize effect from within the monitor. Resize changes are made by dragging the white handles.


	The handle in the upper right allows you to maintain the image aspect ratio as you resize the frame. When you use this handle to resize, you will not stretch or warp the frame.

	By clicking and dragging within the white outline, you can reposition the scaled image to re-center the shot or eliminate unwanted parts around the edges of the frame.



Any time you directly manipulate the image from within the Effect Preview monitor, Media Composer adds a keyframe where the position indicator is parked. If you don’t want the keyframe, select the keyframe and hit Delete on your keyboard to remove it.




Cropping with Resize

The only geometrical parameters within the Resize effect that do not have controls in the Effect Preview monitor are within the crop parameter group. The crop parameters in the Effect Editor enable you to cut out unwanted areas around the edges of the frame without scaling. Since the Resize effect is not a compositing (blending) effect, when you crop it does not create a transparent area. Instead, a colored background is revealed.


	You can adjust the background color using the background parameter group.



When you resize, or reposition the image, a keyframe is left behind at that point in time. When you use keyframes, you can choose when, where, and how the resize effect is adjusted.






Standard Keyframes

Keyframes allow you to make an adjustment to an effect at a specific frame. Combining the Resize Effect and keyframes can create a Ken Burns style effect—mimicking a camera zooming into a subject.

Under the Effect Preview monitor is a position bar that represents the duration of the segment. Keyframes are added at the location of your blue position indicator whenever you press the Add Keyframe button. Selected keyframes are displayed in pink, while unselected keyframes are gray (see Figure 13.8).


[image: Figure 13.8 Keyframes located under the Effect Preview monitor.]
Figure 13.8 Keyframes located under the Effect Preview monitor.



Once a keyframe is added, selecting it and then changing any parameter sets the parameter value for that frame. Selecting another keyframe and changing the same parameter causes a transition (also called interpolation) between the different values on the keyframes. This interpolation creates the change of the parameters over time. Creating animation is the process of selecting keyframes at various points in time and adjusting parameter values differently for each keyframe.


To Add Keyframes:


	□ Click the pink Add Keyframe button under the Effect Preview monitor, or

	Directly manipulate of the image in the Effect Preview monitor, or

	Press the Keyframe shortcut on your keyboard (apostrophe key).









To Use Keyframing to create a Pan and Zoom Effect Using the Resize Effect:


	□ Place a resize effect on a segment.

	□ Open the Effect Editor for the Resize effect.

	□ Park the position indicator at the beginning of the effect.

	□ Click the Add Keyframe button.

	A keyframe appears in the position bar.




	□ Do not change any parameters for the first keyframe, if you want to do a zoom into your shot.

	□ In the Effect Preview monitor’s position bar, move the position indicator to the last frame of the segment.

	□ Add another keyframe.

	□ Change the Scaling and Position parameters to zoom in and tilt up on the video.

	□ Use the Play Loop button under the Effect Preview monitor to view the resulting animation.

	Remember, dragging the position indicator in the Timeline will cause you to exit Effect mode. Use the position bar beneath the Effect Preview monitor to move the position indicator within the effect and stay in Effect mode.









To Select All Keyframes on an Effect:

You can add any number of keyframes to animate different parameters, but if you want a parameter adjustment to be applied across the entire effect, you must select all the keyframes in the position bar before making the parameter change.


	□ Click in the Effect Preview monitor to activate it.

	□ Press Ctrl+A (Windows) or Command+A (Mac), or

	From the menu bar click Edit > Select All






If there are no keyframes added to the effect then any parameter adjustments will be applied to the entire effect.

Try to keep the amount of scaling up on a clip to a minimum. As you scale up, your image quality gets worse.






Realtime vs Non-Realtime Effects


Realtime Effects

When an effect icon has a green dot beside it in the Effect Palette (see Figure 13.1) or on the effect icon in the Timeline (see Figure 13.3), Media Composer can process that effect in real time, meaning that you won’t have to render to play the clip.




Non-Realtime Effects

Any effect that Media Composer cannot process in real time will not have a colored dot beside the effect icon in the Effect Palette and will have a blue dot on the icon in the Timeline. A non-real time effect must be rendered before you can play the effect in the Timeline. A rendered effect is a new media file that is a modified copy of the original file with the effect permanently baked in.

When an effect has been rendered, the effect icon in the Timeline losses its colored dot, regardless of whether it was a real-time or non-real-time effect.

Regardless of whether media has been linked or imported into a Media Composer project, Media files aren’t changed when effects are applied. Both types of effects can be removed, and the media file remains exactly as it was.






Lesson 13 Review & Discussion Questions


	What are the three different types of visual effects?

	What are the ways you can apply an effect to a segment in the Timeline?

	How do you remove a segment effect from the Timeline?

	What sorts of things can you do in the Effect Editor?

	The Cinematographer decided not to use a tripod and now the shot you want to edit with is a little shaky. What segment effect can you use to fix it, and how does that effect work?

	What are the Enlarge and Reduce buttons in the Effect Preview monitor helpful for?

	When using a Resize effect, where are you able to change the scale and position parameters?

	What do keyframes allow you to modify in the Resize segment effect?

	What does a blue dot on an effect icon mean?

	What does it mean when an effect icon does not have either a green or a blue dot in the Effect Palette?






EXERCISE 13

[image: chpt_fig_015.jpg] Effects

Project: Ski Field

Duration: 30 Minutes


GOALS


	Create a montage of shots using Ski Field footage

	Use keyframe and resize to create a pan and zoom effect

	Explore segment effects

	Use titles to label and show off your segment effects






Goal #1: Create a Montage of Shots Using Ski Field Footage


	□ From previous lessons, you should have a sequence with 5 seconds of C0017, C0030, and C0028. If you followed along with previous exercises, there should also be a title on top of the clips.

	□ Duplicate the Ski Field sequence you have and name it “Ski Field_Effects”.

	□ Remove the title on V2, if you have one.

	□ To review previous lessons, add in 7 more shots (each between 3–5 seconds long) to your sequence. Your clips can go in any order you’d like.

	After, you should have 10 shots in your sequence.









Goal #2: Use Keyframe and Resize to Create a Pan and Zoom Effect


	□ On the very first shot in your sequence, add a Resize effect.

	□ Keyframe the segment so that it looks like the camera zooms in and moves either up, down, left, or right.






Goal #3: Explore Segment Effects


	□ Open the Effect Palette.

	□ Grab 10 different segment effects and put a different effect on each clip.

	It’s okay if your sequence looks silly—have fun with it and try out different effects!









Goal #4: Use Titles to Label and Show Off Your Segment Effects


	□ On V2, use Add Edit to mark the filler track to match the segments in the Timeline.

	Holding down Ctrl (Windows) or Command (Mac) while you click and drag your mouse will help speed up this process.




	□ Using Avid Titler+, add basic titles to the filler on your V2 track that says the name of the effect on the segment below it.

	Make sure that the titles are easy to read by adding a drop shadow or a shape behind it.

	Remember, you can save a title as a template in a bin.

	If you forgot the name of the effect you used, open up the Effect Editor. The name of the effect, as well as parameters you can adjust, will be in there.











File Due:


	□ Ski Field_Effect.mov— export as H.264.

	Ask your instructor how they would like you to turn in your file.
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The Narrative Rough Cut

Until now, we have primarily been working with documentary footage to learn the basics of Media Composer. Working with a scripted film can be very different in terms of workflow.

In documentaries, an editor will watch interviews and sculpt the rough cut based off those interviews and available b-roll. In scripted films, an editor sculpts the rough cut based off the script and the notes from the director that were taken while filming.

In this lesson, you’ll get to experience what an editor does in the initial stage of editing a scripted film, television show, or commercial—creating the rough cut.

Project: Jacuzzi

Duration: 50 Minutes


GOALS


	Understand circle takes

	Color code clips inside of a bin

	Create markers in source clips and sequences

	Build the rough cut of a scene using a script and circle takes

	Use multiple tracks to edit in reaction shots






Tools for Working with Circle Takes

When editors begin previewing ‘dailies’ or ‘rushes’, (raw, unedited footage that comes directly from the camera) there is always one thing they would like to know—which of the many takes is the one preferred by the director? On set, the director may tell the script supervisor to ‘circle that take’. The script supervisor will draw a circle around the take number on the script as a clear message to the editor that the director thinks that take is a good one. In this lesson, instead of working with real circle takes, we will be practicing using the clip names highlighted in yellow throughout the script.

Editors also like to make their own notes as they view the footage. Perhaps one particular take is the best overall, but there may be a moment in a different take when a character delivers a line or provides a facial expression, a gesture or reaction that is better than all the rest.

Working with circle takes is a common practice, and throughout this lesson you will learn tools that will help you with that process.

Below is a scene from the screenplay for the film Jacuzzi. It is a dialogue scene in which much of the story is conveyed through what the characters are saying, but there is emotional context, too. How the characters feel should come through the screen. The best takes of each line has been chosen for you and is indicated by the red lines and yellow highlighted clip number.
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Color Coding Clips

To help organize your workflow, you can color code clips to help you easily identify good or circle takes.


To Color Code Clips inside of a Bin:


	□ On the left side of an open bin, find the column labeled color.

	□ Right click in a blank color square next to a clip icon and a color palette opens, as you can see in figure 14.1.

	□ Select a color and it is assigned to the clip.

[image: Figure 14.1 Color coding a clip in a bin.]
Figure 14.1 Color coding a clip in a bin.




	□ Use the color column in your bin to assign a color to each one of the takes listed in Figure 14.2. It will make selecting the good shots much quicker when you start putting the scene together. By the end, your Scene 7 bin should resemble Figure 14.2.




[image: Figure 14.2 Sample circle takes color coded in bin.]
Figure 14.2 Sample circle takes color coded in bin.








Markers

Another organizational approach uses markers to take or give notes. You can add a marker to a single frame in a clip and then attach a comment to it.


To Add a Marker to a Clip:


	□ Open the clip 7_31_1 in the Source monitor.


	The actors stop during their performance and start again later in the take.




	□ Park the position indicator at timecode 01:00:56:00.

	It’s where the actors started the action after their false start.




	□ Click the Add Marker button (Figure 14.3) in the toolbar under the Source monitor. The Edit Marker dialog bow will then open.

[image: Figure 14.3 The Add Marker button in the Source monitor.]
Figure 14.3 The Add Marker button in the Source monitor.




	□ Type in a name for the marker.

	□ Assign a color to the marker from the Color drop down menu

	□ Add comment.

	□ Click OK.




[image: Figure 14.4 The Edit Marker dialog box.]
Figure 14.4 The Edit Marker dialog box.



Once you close the Edit Marker dialog box, a marker will appear behind the position indicator in the Source monitor’s position bar, as shown in Figure 14.5. When you park on the marker, a larger marker with the comment attached appears at the bottom of the frame in the Source monitor.


[image: Figure 14.5 The marker with text visible in the Source monitor.]
Figure 14.5 The marker with text visible in the Source monitor.



You can add as many markers as you need to a clip, and some can benefit from adding multiple markers. For instance, clip 7_35_1 has three versions of Don reluctantly agreeing to take delivery of the jacuzzi, as you can see in figure 14.6.


[image: Figure 14.6 Multiple markers added to a clip.]
Figure 14.6 Multiple markers added to a clip.



Multiple markers make it very quick and easy to locate something happening inside of a shot.




Efficient Ways to Work with Markers

It’s very likely you will be working with multiple markers in a clip or in the Timeline. Whether you’re using markers to mark places in a clip where action is taking place, or using them to address notes given to you, you’ll need to know how to work with them efficiently.




To Snap to a Marker:


	□ Click the marker in the position bar and the position indicator jumps to that time in the clip.



If you are going to be working a lot with markers, map the Go to Marker buttons to the Source monitor. You’ll be able to click the button and your position indicator will automatically snap to the next/previous marker.




To Map Go to Previous/Next Marker Buttons


	□ Open the Command Palette by clicking Tools > Command Palette

	□ In the Move tab, find the buttons in Figure 14.7

	□ With “Button to Button Reassignment” selected, click and drag the buttons to the toolbar in the Source monitor or Timeline.

	□ Close the Command Palette and use those buttons to navigate through markers in Source media.




[image: Figure 14.7 Go to Previous and Go to Next Marker buttons in the Command Palette.]
Figure 14.7 Go to Previous and Go to Next Marker buttons in the Command Palette.






The Marker Tool

It is also possible to add markers to the sequence in the Timeline. These can be helpful to identify segments or frames that you need to do further work on, such as applying effects or color correction or where audio needs to be replaced because of poor quality sound.

Once you start working with more markers, you’ll need a place to see them all in a list. The Markers tool shows you all of the markers within a clip or sequence and shows columns of information about those markers.




To Open the Markers Tool:


	□ From the menu, choose Tools > Markers.

	The Markerstool opens, shown in figure 14.8.




	□ Double-click a marker in the Markers tool to snap your position indicator to it.

	You can also edit markers in the Markers tool. Right click on the marker and choose Edit Marker to reopen the Edit Marker dialog box.







[image: Figure 14.8 The Markers tool.]
Figure 14.8 The Markers tool.








The Rough Cut

The first assembly of a scene or film is for you to set out the basic structure of the scene and discover if there are any obvious problems with the camera coverage or performances. This is called a rough cut. Once you have put together the building blocks of the scene, you can start fine tuning the sequence and fix anything that needs attention (for instance, the microphone boom might be seen in bottom of frame during a good take). Adding markers might help remind you to fix problems later.

With the script as a guide, start assembling the sequence to create a rough cut. Mark IN and OUT points based off the dialogue in the script. Pay attention to any action occurring at the edit points. Don’t be too concerned about matching action at this stage.


Editing the First Two Shots of the Jacuzzi Rough Cut


	□ Open the Sequences bin.

	□ From the menu bar click Timeline > New > Sequence.

	An Untitled Sequence.01 will appear in the Sequences bin.




	□ Rename the sequence Jacuzzi_Scene 7_Rough Cut.

	□ From the Scene 7 bin, open the clip 7_36_5 in the Source monitor. Just after the director calls ‘action’, use the I key to mark the IN point. After Ivan says, ‘OK, you’re the boss’, use the O key to mark the OUT point.

	□ Review the marked section of the clip by pressing the 6 key on the keyboard.

	□ In the Timeline, check your tracks. Make sure the source and record track selectors are enabled on V1 and A1 in the Track Selector panel.

	□ Press the V key to splice-in the clip into the Timeline.

	Why is this clip the one we are choosing to start the scene? There are other possible choices that in the end might work better, but you need to start somewhere and there are a few good reasons why this shot might be suitable:

	○ The scene commences with Ivan delivering the first line.

	○ The shot shows that Ivan is talking to Don, although Don has his back to the camera.

	○ The shot shows the audience where the action is occurring—at the front door of the home with Ivan outside and Don inside.




	As the editor, you are acting on behalf of the audience. You need to ask: what do they need to know and when? Sometimes, for dramatic purposes you want to withhold information from them, but at other times, like this, you may want to keep them informed to avoid any confusion.




	□ Load clip 7_31_1 into the Source monitor.

	□ Mark IN just before Ivan says, ‘Pack it up boys.’ Mark OUT after Ivan says, ‘He doesn’t want it.’

	□ Press the 6 key to review the marked section of the clip.

	□ Splice-in (V) the clip at the end of the first segment in the Timeline.

	□ Review your two clips in the Timeline and see if you have included all the lines of dialogue up to that point in the script.

	It doesn’t have to be a perfect cut. You just need to know you have included everything. You can improve on it later.

	Consider: Why is this our second shot?

	○ In this part of the scene, Ivan is still speaking, but he is now addressing his workers, Leeroy and Moose. The shot shows where Ivan is standing in relationship to the boys and reveals that the jacuzzi is already unloaded from the truck.














Adding Reaction Shots

The opening shot is one continuous interaction between Ivan and Don. Although Ivan is doing all the talking, he is obviously reacting to non-verbal signals from Don. It is important to show the audience how Don is responding to what Ivan is saying.

You could choose to overwrite parts of the first segment on V1 with reaction shots of Don, but we’ve learned that adding extra tracks allows for more creative freedom—and here’s an example of why you want to edit using multiple tracks.

If you overwrite reactions shots to V1, what happens if you don’t like those shots the next day, or want to reposition them? You would have to do a lot of work to get the shots that you replaced back in the timeline.

A better approach may be to leave the segment on V1 untouched and overwrite the shots of Don onto V2 of the Timeline instead. That way you can try different options and move segments around on V2 without affecting the basic shot on the video track underneath.


To Edit Reaction Shots Using Multiple Tracks:


	□ Create a new video track in the Timeline by going to the menu bar and clicking Timeline > New > Video Track.

	A new V2 track is now in the Timeline on top of V1.




	□ In the Track Selector panel, turn off the record track selectors for V1 and A1. You don’t want to affect what you have already edited into those tracks.

	□ If necessary, turn on the track selectors for V2.

	If you have Auto-Patching enabled, it will automatically patch the source track selector on V1 to the record track selector on V2.




	□ In the Timeline, mark IN just after Ivan says, ‘Do you want a refund?’ and mark OUT just before Ivan looks surprised and says, ‘Oh, you don’t want it?’

	□ Open clip 7_34_2 in the Source monitor and mark IN after Ivan delivers the line, ‘So you want a refund.’

	You don’t need to add a mark OUT as Media Composer will automatically calculate the out point based on the duration between the marks in the Timeline.




	□ Perform an Overwrite edit by pressing the B key on the keyboard.

	The shot of Don shaking his head will be edited onto V2. Review the edit to see how well it works. Don’t be concerned about hearing the crackle of the microphone under the shot of Don. You can fix that later.

	To review the sequence, ensure the Video Track Monitor button in the Track Selector panel switched to the V2 track (as shown in figure 14.9) so you can view both video tracks.




[image: Figure 14.9 Video Track Monitor button must be on V2 to see the changes.]
Figure 14.9 Video Track Monitor button must be on V2 to see the changes.




	□ Now mark IN and OUT points in the Timeline for Don’s response to Ivan’s line, ‘Oh, you don’t want it?’.

	The points should be after Ivan delivers the line.




	□ Mark the IN point in clip 7_34_2 for Don’s response

	□ Overwrite it (B) onto V2.








Trying Alternative Takes

You can also use additional video and audio tracks to test alternative takes. If you are not sure the take you have used is works the best, overwrite the video of an alternative version onto a higher-level video track and edit the audio onto another audio track.

By default, the Timeline already has an A2 audio track that you can use. To monitor the alternative take, enable the Video Track Monitor button for the track you have used and solo the associated audio track.


To Replace Takes in the Timeline:


	□ Activate a segment tool and select the segment you want to replace.

	□ Press the T key or click the Mark Clip button under the Record monitor or in the Timeline palette.

	□ Open the replacement clip in the Source monitor and mark the IN point.

	□ Make sure the Source track selectors are patched to the correct Record track selectors.

	If you want to “test out” a take without replacing your original segment, patch the video tracks to the track above your original segment. Do the same with the audio of the segment. Then, you can use your Video Track Monitor, Solo and Mute buttons to test out the alternate takes.




	□ Perform an Overwrite edit (B).








Lesson 14 Review & Discussion Questions


	What are ‘dailies’ or ‘rushes’?

	What might a director do to identify good takes for the editor?

	How can you mark a good take in a bin?

	How can you mark a specific frame in a clip or sequence?

	What is a rough cut?

	Apart from deciding if a performance is good or not, what else helps guide shot choices when assembling a sequence?

	How can you add reaction shots without affecting the segments you have already edited into the Timeline?

	When using multiple video tracks, how can you control which video track you are monitoring?

	When using multiple audio tracks, how can you monitor a single track?

	True or False: You can add markers to a source video clip, source audio clip, and in the Timeline.






EXERCISE 14

[image: chpt_fig_015.jpg] The Narrative Rough Cut

Project: Jacuzzi

Duration: 40 Minutes


GOALS


	Finish building the rough cut of Scene 7

	Add reaction shots to a sequence

	Use multiple tracks to test out different takes

	Fix audio issues by overwriting different takes

	Clean up the edits using trim tools






Goal #1: Finish Building the Rough Cut of Scene 7


	□ Open the Jacuzzi project and load the Jacuzzi_Scene 7_Rough Cut sequence that you created in the lesson.

	The project has 3 bins—one each for Sequences, Scene 7 and Scene 9. The two scene bins contain the dailies for scene 7 and scene 9.




	□ Open the Scene 7 bin.

	The clip icons show the clips have been created by importing the media files.

	The clip names are based on the information on the slates at the start of each clip (Scene Number_Slate Number_Take Number). When you look at the slate numbers, you see that the scene is comprised of 6 different shots, and apart from slate 35, all slate numbers have more than one take.




	□ To finish the rough cut, use the script from the beginning of the lesson as the guide and use each of the suggested circle takes to assemble the sequence.

	They may not end up being the best shots for the final version, but they will let you know how well the scene works and if there are any problems that need fixing.

	Always keep in mind that you want the audience to know more than just what is said and by whom. You also want the audience to know how they are feeling about the situation.

	Don’t be too picky with little things like repeated or funky audio - after you have put together the rough cut you can start fine-tuning the scene.









Goal #2: Add Reaction Shots to a Sequence


	□ Decide where to include another shot or two of Don.

	Although the interaction is between Ivan and the boys, Don is looking on and feeling increasingly guilty about sending the jacuzzi back.




	□ Use the V2 track to include at least one more cutaway of Don as he listens to the conversation.






Goal #3: Use Multiple Tracks to Test Different Takes

There are three different takes for the final shot in the sequence. This is an important part of the story: After watching the conversation, Don changes his mind. He finally gives up and will take the Jacuzzi. This is an opportunity for our story to introduce a new plot point—so the take that you choose is very important.


	□ For the last segment in the sequence, use multiple tracks to test all the different takes of Don shaking his head.

	□ Use your Video Track Monitor button and your Solo button to only watch the takes that you’re trying out.

	□ Choose the take that best fits the story and delete all other takes from your sequence.






Goal #4: Fix Audio Issues by Overwriting Different Takes

There is the poor audio in the first segment when the microphone breaks up.


	□ Look for a different take of Ivan saying, ‘Oh, you don’t want it?’

	There are two reaction shots of Don on V2, so you should be able to replace the shot on V1 and A1 without the viewer knowing you have used a different take.

	Be sure to fix the audio break up just before Ivan speaks his lines, too.




	□ When you’ve found a take that doesn’t have the audio breakup, overwrite it onto A1 of the Timeline.

	Be sure to check your tracks: you don’t want to replace the video here, just the audio.









Goal #5: Use Trim Tools to Clean up All the Audio Errors

There are probably quite a few audio errors—especially if you’ve used multiple tracks.


	□ Use your Overwrite Trim tool and dual-roller trim to clean up the audio mistakes in the Timeline.

	Working with your waveforms on and zoomed into your Timeline will help.

	Adding 1 or 2 frame audio crossfades on all audio cuts will help make those audio cuts sound more natural.











File Due:


	□ Jacuzzi_Scene 7_Rough Cut.mov - Export as H.264.

	Ask your instructor how they would like you to turn in your file.
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Motion Effects and FluidMorph

When putting a scene together, sometimes the original timing of the shots needs to be adjusted. You might want to slow down or speed up segments as a creative storytelling technique. Or you need to re-time a shot so that it fills a gap in your Timeline.

This lesson introduces you to motion effects that enable you to change the speed of a clip or freeze the clip using freeze frames.

This lesson also introduces you to FluidMorph—a great effect you can use to fix jump cuts.

Project: Rock Climber Demo

Duration: 35 Minutes


GOALS


	Explore the different types of motion effects

	Create and edit freeze frames

	Create and edit motion effects

	Understand the benefits of Fit To Fill

	Use the Timewarp effect

	Keyframe Timewarp to speed up, slow down, and freeze a segment

	Use Fluid Morph to fix a jump cut in an interview






Types of Motion Effects

Motion effects alter clip playback speed. In Media Composer, you can create 3 types of motion effects:


Freeze frame - create a new clip that displays only one frame.

Motion effect - create a new clip that plays faster or slower than the original, but still at a constant speed.

Timewarp effect - a clip’s rate of motion can be keyframed and varied over time within a single segment. This means you can create motion effects where, for example, a shot of a person running can ramp from normal speed into slow motion to add drama or tension.



The key difference between the three effect types is that two of them—freeze frames and motion effects—are created from the Source monitor of the Composer window, while Timewarp effects are created from footage that already exists in the Timeline. Depending on the stage of your edit, one may be more convenient to use than the other.

There is also another significant difference: Applying a motion effect to a source clip changes the duration of the new clip compared to the original.

For instance, if the duration of the original clip in the Source monitor is 5 seconds and you apply a 50% slow motion effect, the new motion effect clip will be 10 seconds. On the other hand, if you apply a 50% speed Timewarp effect to a clip of 5 seconds duration in the Timeline, the motion effect clip in the Timeline still runs for 5 seconds. The difference is you only see half of the action in the motion effect clip compared to what you saw in the original. We’ll explore this later in this lesson to help you understand this concept more.




Creating Freeze Frames

A freeze frame displays a single frame from a clip on the screen for a duration you choose. Freeze frames are generated from a clip or subclip in the Source monitor and creates a new clip in the bin. Then, as with other types of clips, you’ll edit a portion of the freeze frame clip into your sequence.


To Create a Freeze Frame:


	□ Open the Rock Climber Demo project and load the Rock Climbing sequence.

	□ From the Rushes bin open the master clip R05_46 Matt Bouldering-EditStock in the Source monitor.

	□ Mark IN at the beginning of the clip and Mark OUT at 19:16, just as the climber’s legs swing under the rock face after he falls.

	□ Edit the marked section of the clip to the end of the sequence in the Timeline.

	You are now going to create a freeze frame of the last frame of that segment and edit the freeze frame to the end of the sequence in the Timeline. You create the freeze frame from the clip still loaded in the Source monitor.




	□ Place the position indicator on the OUT point in the position bar of the Source monitor. The easiest way to make sure you are parked on that frame is to press the W key on the keyboard. The position indicator will jump to the OUT point.

	□ With the Source monitor as the active window, from the menu bar, choose Composer > Freeze Frame, as shown in Figure 15.2, or

	Right click the image in the Source monitor and select Freeze Frame.

[image: Figure 15.2 Freeze frame menu item]
Figure 15.2 Freeze frame menu item







	□ Select one of the set durations, or click on Specify Duration… to type in a custom duration not included.

	□ Creating a freeze frame creates a small media file, so Media Composer displays a dialog box asking where to store the media, Figure 15.3.

[image: Figure 15.3 Select Media Drive window.]
Figure 15.3 Select Media Drive window.




	It is generally a good idea to store the rendered media on the same drive as the rest of your media.




	□ If you have at least one bin open, Media Composer asks where to store the freeze frame clip (Figure 15.4) in the project.

	You also have the option at the bottom of the window to create a new bin.

	It is a good idea to create a dedicated FX bin in which to store your freeze frames, motion effect clips and other effect templates. It helps you keep the project organized.







[image: Figure 15.4 Bin selection window.]
Figure 15.4 Bin selection window.






Editing a Freeze Frame into a Sequence

After you save the freeze frame, it is automatically loaded into the Source monitor and appears in the bin. Freeze frames can be easily distinguished from other clips in the bin by their unique icon (Figure 15.5). When a new freeze frame is created, it’s named after the original clip with “FF” added to the end. Now that the new freeze frame is in your bin, it works just like any other clip in a bin.


[image: Figure 15.5 Freeze frame in an FX bin.]
Figure 15.5 Freeze frame in an FX bin.




	□ Drag-and-drop the freeze frame into the Timeline, or

	Open it in the Source monitor and overwrite it into the Timeline.






Notice that the freeze frame in the Timeline has an effect icon on the segment, Figure 15.6.



[image: Figure 15.6 The effect icon on the clip.]
Figure 15.6 The effect icon on the clip.








Match Frame

The Match Frame button (Figure 15.7) locates the frame currently displayed in the Record monitor by loading its source clip into the Source monitor. If you click it, the clip is loaded into the Source monitor, and an IN point is marked at that location.

This is helpful for creating freeze frames and other motion effects when you’re working in the Timeline and don’t have the source clip readily available. However, it’s not mapped by default to the Timeline palette. In Exercise 15, you can follow the steps to map the Match Frame button to the Timeline palette.


[image: Figure 15.7 The Match Frame button.]
Figure 15.7 The Match Frame button.






Creating Motion Effects

With motion effects, you control the frame rate at which a clip plays, resulting in fast or slow motion. It’s even possible to purposefully add a stuttered look to the video, called strobing. When creating motion effects, the more noticeable the motion is in a clip, the more careful you should be when you choose a new frame rate or render method. For example, if someone is running quickly through the frame, not all frame rates and render methods will create a good-looking effect. Additional information on render methods can be found in the MC110 course.

As with freeze frames, motion effects are generated from clips in the Source monitor using the Motion Effect tool.


To Create a Slow Motion Clip Using Motion Effects:


	□ Load the original clip R05_46 Matt Bouldering-EditStock into the Source monitor.

	□ It should still have the IN and OUT marks you added earlier. You can reuse these to designate which part of the clip you want to apply a motion effect to.




	□ With the Source monitor as the active window, from the menu bar choose Tools > Motion Effect Editor.

	□ The Motion Effect dialog box opens, as shown in Figure 15.8.


[image: Figure 15.8 Motion Effect dialog box.]
Figure 15.8 Motion Effect dialog box.







	□ Leave the default value at 50% speed.

	□ To change the speed of the clip in the Motion Effect Editor, you can enter in a new duration, frame rate, or a percentage of the actual playback speed, as shown in Figure 15.9.

	□ In this lesson, we’ll focus on using the percentage of speed. A clip will playback in real time at 100%. A number lower than 100% will create slow motion and a number greater than 100% will create fast motion. Entering a negative value in the % Speed field will reverse motion.

[image: Figure 15.9 Enter the speed change by changing the number of frames, the frame rate, or the percentage of speed.]
Figure 15.9 Enter the speed change by changing the number of frames, the frame rate, or the percentage of speed.




	□ Under Render 2-Field Motion Effect Using:, choose the Both Fields render method.




	□ Click Create.

	A Select dialog box will be displayed, asking you to choose the bin where you want to save the motion effect.

	In the bin, motion effect clips have the same clip icon as a freeze frame but are named their new frame rate is added to the end of the clip (See Figure 15.10).

	As with freeze frames, the newly created clip is automatically loaded into the Source monitor.




	□ Play back the clip in the Source monitor.

	Notice that when you play the motion effect clip in the Source monitor that the entire clip plays at half speed. The part before the climber falls tends to be tedious to watch but the fall in slow motion is now quite interesting.






With the exception of very high-speed motion effects, it is not typically necessary to render motion effects if you are editing on modern computer hardware and drives.


[image: Figure 15.10 Motion effect in bin.]
Figure 15.10 Motion effect in bin.








More on Motion Effects

So, what has happened when you created the 50% speed slow-motion effect? The duration between the IN and OUT marks on the original clip was close to 5 seconds. When you cut the clip speed to 50%, it doubled the duration of the new motion effect clip, making it 10 seconds.

By doubling the duration of the effect, you also doubled the number of frames in the clip. Applying a 50% speed variation has duplicated every frame. For example, frame #1 is now shown twice in the clip, followed by frame #2 shown twice, etc. If you had applied a 25% speed variation, there would be 4 copies of each frame in the clip. If you slow the motion down excessively, then the effect appears to stutter when it plays.

This is because you begin to see the effect as groups of freeze frames being played one after another. Alternatively, if you had created a fast-motion effect by speeding up the clip by 200% you would have removed every second frame so the effect clip duration will be half that of the original—the original 5 second clip would now be only 2.5 seconds long.


The Motion Effect Button

The Motion Effect button [image: chpt_fig_220.jpg] can open two different tools depending on where you select it. If you open it under the Source monitor, then the Motion Effect window opens, as shown in Figure 15.8. If you open it from the Timeline palette, then the Motion Effect Editor opens (Figure 15.11), which is used with the Timewarp effect.

Because of this, you cannot use the Motion Effect Editor button in the Timeline toolbar, to create a motion effect. This button is used to modify a motion effect that has already been created in the sequence, and to edit Timewarp effects.




Fit To Fill

Another useful option when creating a motion effect is the Fit To Fill check box. Use this option when you have a specific part of a source clip that you want to fit to a specific duration in your sequence.

Unlike a typical three-point edit, using Fit To Fill requires that you have four marks set: two in the Source monitor and two in the Timeline. The four marks define two different durations. Media Composer calculates the difference and will speed up or slow down the source material so that the new clip that is generated fits exactly into the marked duration of the sequence.

Here’s a simple example: if the duration marked in the Source monitor was 1 second, and the duration marked in the Timeline was 2 seconds, the resulting rate would be 50%. So, Media Composer would take the original 1-second clip from the Source monitor, slow it down by 50%, and it would become a 2-second clip in the Timeline.

Fit To Fill can be an efficient way to generate things like a very high-speed version of a long, slow shot.




To Create a Fit To Fill Motion Effect:


	□ Mark IN and OUT in the sequence where you want to the footage to be replaced

	□ Load a clip in the Source monitor.

	□ Mark IN and OUT on the source clip.

	□ With the Source monitor selected, open the Motion Effect Editor.

	□ Enable the Fit To Fill check box in the Motion Effect dialog box.

	□ Click the Create or Create and Render button.

	Now you have a new Motion Effect clip placed in the bin you have selected and also automatically loaded into the Source monitor for you.






Since the new motion effect clip’s duration exactly matches the duration marked in the sequence, and because the blue position indicator is placed at the beginning of the clip by default, all you must do now is use the Overwrite function to edit it into the Timeline.



[image: chpt_fig_279.jpg]


DID YOU KNOW HOW A CAMERA RECORDS MOTION?

Early in the development of motion pictures it was determined that smooth motion could be represented by filming a scene at 24 frames per second. Provided the film was projected at the same frame rate, the eye and brain interpreted the rapid succession of images as motion.

Now, it’s common to shoot in 24 fps or 30 fps.

It quickly became apparent to filmmakers that a slow-motion effect could be created by filming at a higher frame rate but projecting it at a slower rate.

For example, if the camera records at 60 fps and the frames are displayed at 30 fps, then what took 1 second to occur in real time lasts 2 seconds on screen. This technique produces high-quality slow-motion effects because each of the 60 frames is unique and shows the subtle variations of motion over time.

At even higher frame rates, motion can be recorded that is imperceptible to the human eye. The path of a bullet slicing through an apple is a classic example of ultra-slow-motion photography.








Timewarp

The Timewarp effect can create motion that is sped up, slowed down and stopped—all in a clip that was filmed at a standard frame rate.


To Apply the Timewarp Effect:


	□ Load the original clip R05_46 Matt Bouldering-EditStock into the Source monitor.

	□ Press the T key on the keyboard and the entire clip will be marked from IN to OUT.

	In the Timeline, the duration between marks will be 5:20.




	□ Edit the clip to the end of the Rock Climbing sequence in the Timeline.

	□ Open the Effect Palette and from the Timewarp category drag the Timewarp effect onto the segment in the Timeline.

	The Motion Effect Editor opens, as shown in figure 15.11. The Motion Effect Editor can display two graphs, Speed and Position. They provide complementary visual ways of manipulating the frame rate of the original clip.




	□ If not already visible, open the graphs by clicking on their respective buttons.





[image: Figure 15.11 Motion Effect Editor.]
Figure 15.11 Motion Effect Editor.



The Speed graph makes it easy to see how you can change the motion rate of the clip over time—which makes the clip look like it’s sped up or slowed down.

By default, the Speed graph shows a green horizontal line at the 100% mark on the y-axis. The y-axis represents the speed and direction of motion. A positive value means the motion is forward while a negative value means the motion is in reverse.

The x-axis represents the segment’s timecode in the sequence. At the default start position, the green line indicates that for the duration of the segment in the Timeline, the action plays at normal or 100% speed.

When you open the Motion Effect Editor after applying the Timewarp effect, there is always a keyframe at the start of the green horizontal line. By clicking and dragging the keyframe up or down you can reposition the green horizontal line against a faster, slower, forward or backwards motion.




To Change the Speed of a Segment in the Timeline Using Timewarp:


	□ Click and drag the keyframe so the green horizontal line sits at the 50 mark on the y-axis.

	As you drag the keyframe down you will see a green number displayed at the top of the graph showing you the corresponding value of the y-axis line as you move it.




	□ Click the Play Loop button at the bottom of the Motion Effect editor and watch the slow-motion replay in the Record monitor.

	The clip looks identical to when we created a 50% motion effect from the Source monitor, except we made it in the Timeline.









To Keyframe the Timewarp:


	□ Drag the keyframe back to the 100 mark.

	□ Now move the blue position indicator in the speed graph to just before the climber begins to fall.

	□ Click the Add Keyframe button.

	□ Move the position indicator a few more frames so you see the fingers slipped off the rock.

	□ Add another keyframe.

	□ Drag the new keyframe down to approximately the 50 mark on the y-axis.

	□ Click the Play Loop button and watch the action.

	The climber ascends the rock at normal speed but falls at 50% slow motion. This is where you see how Timewarp does not change the duration of the segment. The play loop ends before the climber’s legs swing under the rock face. The clip in the Timeline is still 5:20 in duration.




	□ Use the Ripple Trim tool to extend the end of the clip in the Timeline, adding the frames that the Timewarp effect has removed in order, until you can see the rest of the clip that got cut off.

	□ Click the Play Loop button again in the Motion Effect Editor and see now that the climber’s legs swing under the rock face and swing out again but at 50% speed.

	□ Move the blue position indicator to the frame just as his legs complete their swing under the rock face.

	□ Add a new keyframe.

	□ Move a few more frames down the Timeline.

	□ Add a new keyframe.

	□ Drag this keyframe down to the 0 value in the Speed Graph.

[image: Figure 15.12 The Motion Effect Editor Speed graph.]
Figure 15.12 The Motion Effect Editor Speed graph.




	□ Click the Play Loop button.

	The motion stops just as his legs swing under the rock face. You can modify the speed and direction value for any keyframe by dragging the keyframe vertically.

	You can move a keyframe’s position in time by holding down the Alt (Windows) or Option (Mac) key and dragging the keyframe left or right.











Hiding Jump Cuts with FluidMorph

Media Composer has a unique transition effect that can also be used to hide problems in a sequence. FluidMorph, located in the Illusion FX category (see Figure 15.13), specifically helps solve the problem of jump cuts, where two shots of the same subject are edited back-to-back with slight differences between them. It’s a jarring cut because elements within the frame suddenly change position on screen. FluidMorph can warp the two images to better align with each other, so they perform a more seamless transition. The effect is particularly well suited to disguising jump cuts in interviews.


[image: Figure 15.13 Fluid Morph is located in the Illusion FX category of the Effect Palette.]
Figure 15.13 Fluid Morph is located in the Illusion FX category of the Effect Palette.



In the Rock Climbing sequence, after the opening series of rock climbing shots, there is a group of three interview segments that have been edited back to back. Play them back and see the two jump cuts that occur at the edit points.


To Hide Jump Cuts Using a FluidMorph Effect:


	□ From the Illusion FX category, drag the FluidMorph effect onto the first cut point.

	□ In the Effect Editor, under FluidMorph, choose Still > Still.

	□ Click the Render Effect button [image: chpt_fig_224.jpg] at the bottom left of the Effect Editor.

	The Render Effect window will appear, prompting you to choose a location for the rendered file. Select the drive where you keep the rest of your media and click OK.

	Don’t be disappointed at the first result from applying the effect. While FluidMorph does not require any user input to work, there are a few options in the Effect Editor that may produce a less noticeable transition.

	FluidMorph works best when most of the image is the same and the difference in the object that moves is not too severe.

	By default, FluidMorph warps both images based on the luminance of the images. Under Input Parameters, Feature Match may improve the warping by aligning feature patterns as it warps from one image to the other (See Figure 15.14).







[image: Figure 15.14 The FluidMorph Feature Match option in the Effect Editor.]
Figure 15.14 The FluidMorph Feature Match option in the Effect Editor.



If you still want to improve FluidMorph’s results, try different combinations of outgoing and incoming frames at the edit point. You can select the options through the drop menu at the top of the Effect Editor window, as shown in figure 15.15.

By default, FluidMorph takes the safest approach and uses Still>Still. It uses freeze frames on the outgoing and incoming sides of the edit during the morph transition. Warping two freeze frames to create the morph produces more reliable results but it doesn’t always look the most realistic.

FluidMorph can also work by warping each side of the transition frame by frame. This is the Stream > Stream setting. It is the most complicated of the settings but will produce the most realistic results if there isn’t a lot of movement between the two clips. This setting is more likely to degrade the clip because you have two images moving that must be aligned.

Setting one side of the transition to Still instead of Stream splits the difference; these half-and-half settings lower the complexity by creating a freeze frame for one of the shots but produces a more realistic result because one shot still has normal motion.


[image: Figure 15.15 The FluidMorph drop menu options in the Effect Editor.]
Figure 15.15 The FluidMorph drop menu options in the Effect Editor.



Adjusting the duration and alignment of the transition makes a big difference if FluidMorph will look realistic or not. Most of the time, a shorter duration of 3 to 10 frames will create a better result.

After you have chosen all your settings, you can use the Effect Preview monitor’s position bar to scrub through the various stages of the effect, but the subtlety of this effect can really only be judged by playing it in real time, which requires rendering.

FluidMorph works well when it works. If you can’t cover up your jump cut with b-roll, and you’re really in a pinch, try it out.




To make the FluidMorph on the Rock Climber work:


	□ In the Effect Editor of the first FluidMorph jump cut, change all of the settings to match the settings below:

	Source drop menu - Still->Stream

	Feature Match - On

	Transition alignment - Starting at Cut

	Duration - 6 frames




	□ For the second jump cut try these settings:

	Source drop menu - Stream>Stream

	Feature Match - On

	Transition alignment - Centered on Cut

	Duration - 6 frames




	□ Render each FluidMorph transition. You can either use the Render Effect button in the Effect Editor, or in the menu bar, choose Timeline > Render > Render at Position.








Lesson 15 Review & Discussion Questions


	What are the three types of motion effects?

	What are the key differences between the three motion effect types?

	How can you create a freeze frame?

	True or False: After you create a freeze frame, it will automatically show up in your sequence.

	What is the Match Frame button?

	How are motion effects created?

	How many marks in total are required to create a Fit To Fill effect?

	Describe two ways how creating a motion effect in the Timeline is different than creating a motion effect in the Source monitor.

	If you have a segment that you want to speed up, then halfway through slow down - then freeze on the last frame, which type of motion effect would you use?

	What is the FluidMorph effect able to do? Do you have to render it before being able to play it back in real time?






EXERCISE 15

[image: chpt_fig_015.jpg] Motion Effects and FluidMorph

Project: Rock Climber Demo

Duration: 40 Minutes


GOALS


	Create a freeze frame

	Create a motion effect at 200%

	Create a Fit To Fill

	Create a Timewarp effect

	Add titles to identify the different motion effects






Goal #1: Create a Freeze Frame


	□ Open the Rock Climber Demo project.

	□ Create a new bin called Motion Effects

	□ Open up the Command Palette (Tools > Command Palette)

	□ With Button to Button reassignment enabled, drag the Match Frame button from the “Other” tab onto an empty button in the Timeline palette

	□ Close the Command palette

	□ Duplicate the Rock Climbing Sequence and name it Rock Climber_Motion Effects

	□ Open the duplicate in the Timeline.

	□ In the duplicated sequence, remove any segment effects that might be there from previous lessons.

	□ Go to the second segment in the sequence, R04_153 Matt Climbing-EditStock

	□ Park your position indicator on the frame when he is tilting his head up, looking towards the sky

	□ Click the Match Frame button.

	The frame we located earlier is pulled up in the Source monitor and is ready for us to make a freeze frame




	□ Right click anywhere in the Source monitor and choose Freeze Frame > 5 Seconds

	□ Use the Using Both Fields render type.

	□ Click OK

	□ In the Bin Select Dialog Box, select the Motion Effects bin and press OK

	□ The freeze frame will save in the bin and load in the source monitor

	Make sure all of your tracks, or your sync locks, are on.




	□ Press V on your keyboard or the Splice-in button under the Source Monitor to splice in your freeze frame.






Goal #2: Create a Motion Effect at 200%


	□ Go to the first frame of the clip R04_160 Matt Climbing Topping Out-EditStock

	It’s about halfway through the sequence




	□ Press the Match Frame button

	□ Go to Tools > Motion Effect Editor

	□ Change the speed of the clip to 200%

	□ Save it in the Motion Effects bin, then press V to splice the clip into your Timeline.






Goal #3: Use a Fit to Fill Effect


	□ In the sequence, there are three separate interview segments. This causes a jump cut in the interview. Let’s use Fit To Fill to solve this problem

	□ Click on the middle interview segment with the Lift/Overwrite segment tool.

	□ Press the T key to mark the area.

	□ In the clips bin, find clip R8_19 Boldering on Top-EditStock and open it in the Source monitor

	□ Press the T key to mark IN and OUT marks around the entire source clip.

	□ Go to Tools > Motion Effect Editor

	□ In the Motion Effect Editor, check the Fit To Fill checkbox.

	□ Click create and put it in your Motion Effects bin.

	□ This time, we want to overwrite the clip, not splice-in. Make sure only track V1 is on, then press B on your keyboard, or the Overwrite button under the Source monitor.






Goal #4: Create a Timewarp Effect

Last is Timewarp. This is the only motion effect that you use the Effect Palette and a segment in the sequence to create.


	□ Open the Effect Palette

	□ Go to the Timewarp category

	□ Drag and drop the Timewarp effect onto your last clip in the timeline.

	□ In the Motion Effect Editor, click on the Speed Graph icon (the little green running man)

	□ Scrub through the clip halfway and add a keyframe

	□ Drag the keyframe down to 50%

	□ Scrub through a bit more and add another keyframe

	□ Drag the third keyframe up to 300%

	□ Play it back. The clip starts at normal speed, slows down, and then speeds up.

	□ Since the Timewarp effect doesn’t change the duration of the clip, in the Timeline, use trim tools to cut off the last bit of the clip.






Goal #5: Add Titles to Identify the Different Motion Effects


	□ Just like in the last lesson, add titles to each motion effect you used by adding edits to filler in the V2 track and place the Avid Titler+ effect on them.

	A quick way to do this is to look at the motion effect icons on the segments—then, look at the exercise to find what motion effect you put on each segment.

	This sequence will look funny—that’s okay. Don’t worry about fixing the audio. The purpose of this exercise is to show you how the motion effects work!











File Due:


	□ Rock Climber_Motion Effects.mov— export as H.264.











[image: chpt_fig_001.jpg] LESSON 16

Multiple Effects and Split Screens

When you drag an effect on top of another effect in the Timeline, the new effect replaces the existing one. But there will be plenty of times when you want to add more than one effect to a clip. In Media Composer, the process of combining effects in one segment is called nesting effects.

Split screen is a creative editing technique that you’ve seen before. Not only is it fun to watch, but it can also help solve problems with pacing and issues in your footage. Combining effects and stacking segments on multiple tracks can help you create awesome visuals that will help tell your story in a different way.

Project: Rock Climber Demo

Duration: 40 Minutes


GOALS


	Understand nesting effects

	Use auto-nesting to combine multiple effects

	Modify nested effects in the Effect Editor

	Use simple and expanded nesting view

	Create a split screen effect using the Picture-In-Picture effect






Nesting Effects

In this lesson you will learn how to apply multiple effects to a single segment via the nesting process. A good analogy to describe nesting effects is the Russian nesting dolls. When you open one, there’s another inside, and another inside that, and so on.

Having multiple effects on a segment can be very beneficial, especially when you become a more advanced editor and have a creative idea in your head that you want to make happen on screen.


Auto-Nesting

If you need to apply more than one effect to a clip, the easiest approach is to use a technique known as Auto-nesting. This technique allows you to add a new effect on top of an existing effect.




To Combine Two Effects in One Segment:


	□ Open the Rock Climber Demo project and the original Rock Climbing sequence.

	In a previous lesson you applied a Resize effect to the last segment in the sequence. Initially this was to hide the man at the bottom of frame. You then used keyframes to scale the segment over time, producing a slow zoom in on the image. The problem with resizing a clip is the loss of resolution.

	We will be applying a mask to the clip. This will resolve the issue of the man at the bottom of the frame, without losing quality by scaling up too much with a resize.




	□ Place the position indicator over the last segment in the Timeline.

	It should already have the Resize effect applied from the previous lesson. Make sure the track selector for V1 is active.




	□ Use the Remove Effect button to delete the effect from the segment.

	□ From the Effect Palette select the Image category and again apply the Resize effect to the segment. Do not modify any parameters.

	□ While holding the Alt key (Windows) or Option key (Mac), drag the Mask effect from the Image category on top of the segment in the Timeline.

	The effect icon changes from the Resize effect icon, to the Mask effect icon.

	The Mask effect has been auto-nested on top of the original Resize effect, but Resize is still underneath Mask. Because you have not adjusted any parameters, you can’t see the result of applying either the Resize or Mask effects, but you can use the Effect Editor to see that both effects have been applied, as shown in Figure 16.1.

	There are a few effects that cannot be nested. If you attempt to create a nest with one of these, Media Composer will alert you with a message.








[image: Figure 16.1 The Effect Editor with two effects displayed.]
Figure 16.1 The Effect Editor with two effects displayed.






Seeing Multiple Effects in the Effect Editor

With multiple effects applied to a single segment, the parameters for each effect are available in the Effect Editor. You need to open the disclosure triangles under each parameter to make changes.

Effects are always processed from the bottom of the nest first. All other effects are listed, traveling upward, in the order they reside on the segment and therefore the order in which they are processed. This means that as you add new effects to a clip, each new effect will affect what’s below it in the nest.

This order of processing can have a big impact on the final appearance of the clip, but it’s easy to change the order of processing if you don’t like the order of the nested effects.




Modifying Effect Parameters

Since parameters for nested effects are displayed in the Effect Editor, you can adjust each effect to see how they interact with each other. And you don’t need to modify parameters in the order in which the effects are applied. You can adjust any parameter for any effect as needed and you will immediately see the combined result in the Record monitor.



[image: Figure 16.2 The Mask effect parameters.]
Figure 16.2 The Mask effect parameters.






To Modifythe Nested Effects:


	□ If needed, open the Mask disclosure triangle.

	□ In the Scaling parameter group, make sure the Fixed Aspect box is unchecked.

	□ Adjust the Hgt (height) parameter to crop the top and bottom of frame by changing the slider value to 75. (See Figure 16.2)

	When you click on the slider control, you can either:

	○ Drag the slider to the left or right to adjust the value

	○ Type a value on the keyboard, then press Enter

	○ Click the left/right arrows on the keyboard to make incremental adjustments.







	□ Scrub the position indicator under the Effect Preview monitor and see that throughout the clip the top of the climber’s head has been cropped while the man at bottom of frame is also still visible. The Mask effect by itself isn’t good enough—we also need to reposition the clip to hide the man and expose the climber.

	Before adjusting the parameters for the Resize, it will be helpful to add a background color to the Mask effect so you can see exactly what is going on.




	□ Open the group of parameters for the Background Color in the Mask effect. Adjust the sliders for Hue, Sat (saturation), and Lum (luminance) until you achieve a background color you like. Alternatively, you can use the Color Picker, the small box at the top of the Background Color group of parameters, shown in figure 16.2.






To Use the Color Picker:


	□ Roll the mouse over the box and the pointer will change into an eye dropper.

	□ With the mouse icon changed to the eye dropper icon, click to activate the color picker.

	□ Now move the mouse pointer over the image in the Effect Preview monitor. The Color Picker will sample the color of the target area and display that color in the box.

	□ Click the mouse on a color you want.

	The background color of the masked region of the image will now change to the selected color.









To Continue to Modify the Nested Effects:


	□ Now adjust the Resize effect to reposition the image behind the masked area. Under the Position parameter, use the Y slider to move the image down in the frame—change the Y value to 110.

	□ Notice how the position of the mask remains unchanged. This is because, in order of application, the Resize processes the image first, then the Mask processes it second (See Figure 16.3). Thus the Mask effect is impacting the Resize effect’s appearance.






Changing the Order of Nested Effects

Now you know you can modify parameters in any order, and that it’s important to know the processing order of the nested effects. That’s because the order in which the effects are applied determines how the combined result will appear on screen.

Sometimes you might need to change the order of the effects in the nest because you applied them in the wrong order. To see just what applying effects in the wrong order can look like, you can rearrange the order of the Mask and Resize effects that you have already applied to the segment.


[image: Figure 16.3 The Mask effect over the Resize effect.]
Figure 16.3 The Mask effect over the Resize effect.






To Re-Order Effects in the Effects Editor:


	□ Open the Effect Editor by hovering your position indicator over the segment and clicking on the Effect Editor button in the Timeline palette.

	□ Click the icon of the Mask effect and drag it down below the Resize effect.

	The order that the effects are processed has now been reversed, as shown in Figure 16.4.

	Look in the Timeline and notice the Resize effect icon is now visible on the segment instead of the Mask effect icon.

	Although no parameters of the effects have been modified, the result on screen is quite different.







[image: Figure 16.4 The effect order is changed by clicking and dragging the effect icons to rearrange the order.]
Figure 16.4 The effect order is changed by clicking and dragging the effect icons to rearrange the order.




[image: Figure 16.5 The different result on screen when the Resize effect is above the Mask effect.]
Figure 16.5 The different result on screen when the Resize effect is above the Mask effect.



Because the Mask effect has been processed first and then the Y position of the Resize effect has been processed second, the combined result is that the mask and image have moved lower in frame.


	□ Click and drag the Mask effect back above the Resize effect in the Effect Editor.






Displaying a Nest in the Timeline

In addition to the Effect Editor, there are two other ways that you can view effects within a nest.

These two methods are called simple nesting and expanded nesting, and both are viewed in the Timeline.




Simple Nesting View

In this method, you travel down inside a nest, allowing you to view the lower effects in isolation from the effects above them. This is a very useful technique, especially for complex nests with numerous effects and/or video tracks, because it enables you to “dive underneath” higher effects so that you can focus on the effects beneath.

To move down through each effect and back up to the top effect, you use the Step In and Step Out buttons located at the bottom of the Timeline, shown in Figure 16.6.



[image: Figure 16.6 The Step In (left) and Step Out (right) buttons.]
Figure 16.6 The Step In (left) and Step Out (right) buttons.






To Step into an Effect Nest Using Simple Nesting View:


	□ Park the position indicator on a segment with nested effects.

	□ Make sure the track selector is active.

	□ Click the Step In button (the down-pointing arrow) at the bottom of the Timeline.

	When you step into a nest, three things happen:

	○ The Timeline view changes, and only the content of the nest (that is, what’s beneath the top effect) is visible, as shown in Figure 16.7. In the case of our nested Mask and Resize effects, you have stepped in under the Mask effect and you can now only see the Resize effect applied to the segment. The Timeline shows nothing else.

[image: Figure 16.7 Simple Nesting reveals the lower level effect in the Timeline.]
Figure 16.7 Simple Nesting reveals the lower level effect in the Timeline.




	○ The Effect Preview monitor only shows the result of the lower-level effect (See Figure 16.8). You cannot see the result of any higher-level effects (in this case, the Mask) applied to the segment.

[image: Figure 16.8 The Effect Preview monitor only shows the result of the lower level effect.]
Figure 16.8 The Effect Preview monitor only shows the result of the lower level effect.




	○ The Effect Editor only shows you the parameters for the lower-level effect (in this case the Resize). You cannot adjust the parameters of any higher-level effects (in this case, the Mask).









Simple Nesting completely restricts your view to only the effects of the one segment you stepped into. In the Timeline video and audio clips from before and after the segment also disappear.

You can continue to use the Step In button to step downward, as long as there are effects to step into. To tell how deep you are in a nested effect, you can look at the Track Selector panel. Beneath the video tracks appears a nest depth indicator, shown in Figure 16.9.


[image: Figure 16.9 The N1 on the nest depth indicator tells you have stepped downward by 1 effect.]
Figure 16.9 The N1 on the nest depth indicator tells you have stepped downward by 1 effect.






Adding Effects While in Simple Nesting

You can use the Step In button as many times as necessary until you reach no more effects applied to the segment. At this level you can open the Effects Palette and apply a new effect to the segment. This new effect will now be at the lowest level and will be the first effect processed in the nest.




To Apply an Effect in Simple Nesting View:


	□ Park your position indicator over the clip with the Mask and the Resize effect.

	□ Step In under the Mask effect then Step In under the Resize effect.

	The segment will be displayed in the Timeline and the original un-effected clip will be displayed in the Effect Preview monitor.




	□ From the Effects Palette, select the Image category and locate the Color Effect.

	Be careful not to choose the Color Correction effect by mistake.

	The Color Effect is a simple way to alter the color balance of a clip, which is ideal for this exercise.




	□ Drag the Color Effect onto the segment in the Timeline.

	The Effect Editor should automatically open, showing the parameters for the Color Effect.




	□ Go to the Color Gain parameter group and make slight adjusts to the Red, Green, and Blue sliders until you have made a slight tint to the segment.

	Any color tint you like will work.




	□ Use the Step Out button to return to the normal view of the Timeline.

	Each time you step out you will see the next effect that is nested.









Expanded Nesting View

Expanded Nesting lets you see the entire sequence, while allowing you to nest effects. It also allows you to listen to audio and access all material in the sequence before and after the nested effects that you are working with.

Unlike simple nesting, the video track monitor button in the Timeline is always positioned at the top of the nest and cannot travel into the nest. As a result, with expanded nesting, you can edit the contents of a nest and still see the composite result of all effects within the nest.




To See a Nest in Expanded Nesting View:


	□ Park your position indicator on a segment with nested effects.

	□ Make sure that the track selector is active.

	□ Alt+click (Windows) or Option+click (Mac) the Step In button.

You can also enter and exit expanded nesting by double-clicking a segment with an effect on it. This can be disabled via File > Settings > User > Timeline.




	The Timeline displays the tracks inside and outside the nest, with the tracks inside the nest appearing directly above the track that contains the nest, as shown in Figure 16.10.

	With the expanded nesting view, Media Composer slides every layer onto its own track. In Figure 16.10, the Resize is actually underneath the Mask effect in terms of compositing order. However, in the expanded nesting view it has been raised from behind the mask, so we can see it.







[image: Figure 16.10 Expanded nesting track indicators (left) and Expanded nesting view (right).]
Figure 16.10 Expanded nesting track indicators (left) and Expanded nesting view (right).



The Track Selector panel indicates the nest level for each element within the nest, this time using two numbers separated by a period instead of just one.

The first number indicates the nest level of the track. In this case, the number 1 indicates that you have stepped into the first nested level (the Resize under the Mask). The number 1 after the period indicates that there is one track within this nested level.

When you select the V1 track selector, all the effects and their parameters will be accessible from the Effect Editor.

If you had selected the 1.1 track selector, only the effect on that nested level and any effects below it will be accessible in the Effect Editor.




To Exit Expanded Nesting View:


	□ Alt+click (Windows) or Option+click (Mac) the Step Out button or double-click the segment at the lowest level—V1 level (not V1.1) for our example.








Creating a Split Screen with the Use of Multilayer Effect Editing

The use of split-screens is a common filmmaking technique, and can be found in feature films, documentaries, reality TV, travel shows, music videos, commercials, and almost every other genre.

A split-screen effect displays two or more video images on the screen at once. This requires layering the video tracks over each other in the Timeline on multiple tracks. It’s not enough to edit video onto a higher-level track, though. If you have ever put a segment on V2 on top of another segment on V1, you know that the higher-level clip will be seen instead of the lower clip. To see both clips at once, you have to use a technique called multilayer effect editing.

Multilayer effect editing means that you are stacking segments with effects on top of other segments and combining them to create an effect like Split Screen. Think of multilayer effects as stacked segments effects that allow you to combine or composite them.

To combine clips, you need multiple video tracks to stack segments on top of each other in the Timeline. In Figure 16.11, track V1 is the background layer under the foreground segment on V2. A special type of segment effect is applied to the foreground layer to achieve the composited image. In this case the segment effect is a Picture-in-Picture.


[image: Figure 16.11 An example of multilayer effects: multiple tracks used to create composite images.]
Figure 16.11 An example of multilayer effects: multiple tracks used to create composite images.




To Create a Split Screen Using the Picture-ln-Picture Effect:


	□ Open the Rock Climber_Demo project and the Rock Climbing sequence.

	□ If there is not already a V2 track in the Timeline, create one by selecting Timeline > New > Video Track in the menu bar.

	□ From the Clips bin, locate and load the R8_19 Boldering On Top-EditStock clip into the Source monitor.

	□ Mark IN and OUT around the best 5 seconds of the clip.

	□ At the end of the Timeline, edit the clip onto track V1.

	Notice that the Rock Climber is on the right side of the screen.




	□ Locate and load the R04_153 Matt Climbing-EditStock clip into the Source monitor.

	□ Mark IN at the beginning of the clip. If there is an OUT point on the clip, clear it.

	□ In the Timeline, place your position indicator on the R8_19 Boldering On Top-EditStock clip that you’ve just placed at the end of the sequence.

	□ With only the V1 record track selector active, press the T key on the keyboard to mark the clip from IN to OUT.

	□ Turn off the record track selector for V1.

	□ Turn on the record track selector for V2.

	The V1 track selector for the source clip will auto-patch to V2.




	□ Overwrite the source clip into V2 of the Timeline.

	□ Double check that the Video Track Monitor button is on V2. If it’s not, turn on Video Track Monitoring for V2. (Figure 16.12)

	Because the new clip on V2 is above V1, you will not be able to see the original clip on V1… yet.




	□ Open the Effect Palette, and from the Blend category drag the Picture-In-Picture effect icon onto the segment on V2 of the Timeline.

	The Effect Editor automatically opens so you can modify the effect parameters.






The Picture-In-Picture effect has a default set of parameters that reduces the foreground image to V frame size and positions it in the center of the Effect Preview monitor, revealing the background image behind it on V1.



[image: Figure 16.12 Track monitor button and the Picture-In-Picture effect.]
Figure 16.12 Track monitor button and the Picture-In-Picture effect.




	□ On the Picture-In-Picture effect, use the Rgt (Right) slider in the Crop parameter group to remove the left side of the frame by setting the value to -450.

	□ In the Scaling parameter group, increase both X and Y to a value of 100.

	If the Fixed Aspect box it checked, changing one slider will change both X and Y parameters.




	□ Use the Play Loop button to preview your split screen effect.

	The action happening on the right side of the split-screen could be more visible.




	□ Apply a Resize effect (Image category) to the segment on V1.

	□ In the Position parameter group, change the X value to -140



Remember that in the Effect Editor you are also able to modify parameters over time using keyframes. If you wanted to, you could make the segment on track V2 fly in from the right side to create a neat animation.



[image: Figure 16.13 The finished split-screen effect.]
Figure 16.13 The finished split-screen effect.








Lesson 16 Review & Discussion Questions


	How do you add an effect to a clip in the Timeline on top of an existing effect, without replacing it?

	What do you call the process of adding an effect on top of an existing effect, without replacing it?

	How can you change the order of effects within a nest?

	In which order are effects processed in a nest?

	What are the two different methods you can use to view the effects inside of a nest in the Timeline?

	What is an advantage of simple nesting view?

	What is an advantage of expanded nesting view?

	What is the difference between nesting effects and creating a multilayer effect?

	A multilayer effect is a special type of segment effect. What does it allow you to do?

	How do you control which video track is being monitored when you are compositing multiple layers in the Timeline?






EXERCISE 16

[image: chpt_fig_015.jpg] Multiple Effects and Split Screens

Project: Jacuzzi and Ski Field

Duration: 45 Minutes


GOALS


	Hide a mistake made in production with the resize effect

	Nest multiple effects

	Use multilayer effects to give a sequence a more cinematic feel.






Goal #1: Hide a Mistake Made in Production with the Resize Effect


	□ Open the Scene 7_Rough Cut sequence in your Jacuzzi project.

	□ Duplicate the sequence and name it Scene 7_Fine Cut.

	□ In clip 7_33_2 in Scene 7 of Jacuzzi, there is a boom mic that enters the bottom of the frame. It should be about halfway through your sequence.

	If you have a reaction shot over it, for the purposes of this exercise, move or remove the reaction shot. If you don’t have this shot in your sequence, overwrite it into the sequence.




	□ Put a Resize effect on clip 7_33_2 and adjust to hide the boom mic entering the shot.






Goal #2: Nest Multiple Effects


	□ Open the Ski Field project, and duplicate your Ski Field_Effects sequence.

	□ Name the new sequence Ski Field_Nested Effects.

	The sequence should have 10 segments with 10 different effects and a V2 track of titles on it.




	□ Remove any 6 shots (and their effects/titles) from the Timeline.

	Consider keeping your 4 favorite effects that you used in the previous lesson.




	□ On the 4 remaining clips, nest at least 1 effect into each clip.

	□ This time, use the parameters in the Effect Editor to really play and be creative with the nested effects.

	□ Update the text in the title and add the other effect names you’ve nested into the segments.

	□ Export your sequence as H.264.






Goal #3: Use Multilayer Effects to Give a Sequence a More Cinematic Feel

The producer of Jacuzzi wants to simulate the wider cinema aspect ratio of film, so the solution is to apply a Mask effect on all the clips in the sequence. This will crop the top and bottom of frame without rescaling the images. The result will give the appearance of a wide aspect ratio film reformatted to fit the television screen’s aspect ratio, but the segments will have to be adjusted underneath the mask.


	□ Open the Jacuzzi Scene 7_Fine Cut sequence,

	□ Create a new, empty track in your Timeline if you don’t already have one.

	□ From the Effect Palette, grab the 1.85 Mask and drop it on your empty filler track.

	□ All clips in the sequence will need a Resize effect applied to reposition the action within the masked area of the frame.

	□ Go through the sequence, shot by shot, and apply a resize to make sure all the important action takes place inside of the frame.

	To do this quickly, resize one shot, then save the template in a bin and apply it to all the segments at once. Then, you can go through individual clips and fix any issues you see.

	Make sure to give every character headroom—space between the top of their head and the edge of the frame.

	You can also play with scaling up the resize at moments to increase the emotional impact of a scene.




	□ Export your sequence as H.264.








Files Due:


	□ Ski Field_Nested Effects.mov

	□ Jacuzzi_Scene 7_Fine Cut.mov






Screenshots Due:


	□ Take a screenshot of your Jacuzzi sequence in expanded nesting view, showing that all segments have a Resize effect, and the Mask effect is on the top track.











[image: chpt_fig_001.jpg] LESSON 17

Color Correction

In production, filmmakers use lights, white balance, and proper exposure to get a good-looking image. In post-production, editors use color correction to take footage and make it look the best it can possibly be.

If you like before and after photos, then you’re guaranteed to find color correction satisfying as you take footage and really make it pop on screen.

In this lesson, you’ll learn about the automatic color correction features that provide a good start for taking your edit and putting the finishing touches on it, as well as ways to work quickly with color correction by using buckets and templates.

Project: Rock Climber Demo

Duration: 40 Minutes


GOALS


	Understanding when to color correct footage

	Use the Color workspace to apply auto color correction

	Use HSL (Hue, Saturation, and Luminance) to color correct clips

	Create a color correction effect template and save to a bin

	Use color correction presets on multiple segments






Using Color Correction to Improve the Footage

It’s normal to work with footage that is too dark or too bright. Exposure in filmmaking is the quantity of light that reaches the sensor of the camera. If too much light is let in, then the footage will be too bright—also called overexposed. If not enough light is let into the camera, then the footage will be too dark—also called underexposed. When footage is overexposed, all detail is lost in the bright parts of your image. When it’s underexposed, all detail is lost in the dark parts of your image.

Footage could also lack contrast (the difference between the light and dark parts of the image), or maybe the white balance wasn’t set properly. White balance is the process of adjusting your camera settings so that you establish the true color of white. During production, the white balance may have not been set correctly. If that’s the case, then all your footage might be too blue or too orange. Color correction can do a lot to solve these common problems and improve the look of your edit. Figure 17.1 shows a before and after example of a shot with corrections applied.


[image: Figure 17.1 A before and after a color correction has been applied to a segment.]
Figure l7.1 A before and after a color correction has been applied to a segment.



You can use color correction to help you accomplish three common goals:


	Fix - You’ll need to fix exposure or color related problems in the footage.

	Match - One shot might look very different from the next in terms of brightness and color—even when the shots are all from the same location and time of day. You’ll need to match the color of those clips.

	Stylize - This is a creative goal. Maybe you want to stylize a series of related shots to give a certain look to a scene. For example, if your story has a flashback in it, you can use color correction to decrease saturation, or even make all the footage black and white.






Color Correction

Media Composer | First has a color correction tool that is based on adjusting three basic properties of an image—hue, saturation, and luminance. The color correction tool in Media Composer | First is therefore described as an HSL color corrector.


	Hue - The actual colors in an image. The overall hue of an image can be described as its color balance.

	Saturation - The intensity of the colors in an image.

	Luminance - How light or bright the image is. This can often be described in terms of the exposure of the image.




Color Correcting Segments

The Color workspace (Figure 17.2) has a dedicated interface that offers the ability to apply automatic adjustments that make simple color correcting fast.




To Open the Color Correction workspace:


	□ Open the Rock Climber Demo project and the Rock Climbing sequence.

	□ Park the position indicator near the middle of the second segment.

	□ Turn off all other track selectors except V1.

	□ In the menu bar, choose Windows > Workspaces > Color, or

	Click the Color workspace button in the sidebar at the right of the user interface.







[image: Figure 17.2 The default Color workspace in Media Composer | First]
Figure 17.2 The default Color workspace in Media Composer | First








The Color Workspace

The Color Workspace has a three-monitor display, as shown in Figure 17.2. The middle monitor shows the segment where the blue position indicator is parked in the Timeline. This is the segment that will have corrections applied to it.

The left monitor, by default, shows the segment before the segment where you are parked in the Timeline. This allows you to visually compare the segment you are working on with the previous segment. The right monitor displays the next segment in the Timeline.




Controls Tab

In the Controls tab of the Color workspace, you’ll see three different sections. In this book, we will just focus on the first section of sliders. If you would like to learn more about color correction, consider taking the MC239 course.

The first section of the Controls tab has four different sliders.


To Apply Color Correction in the Controls Tab:


	□ Drag the Hue slider to shift the hues in the image around the color wheel.

	This slider could be used to stylize your shots in a new and creative way.




	□ Drag the Saturation slider to adjust the amount or intensity of a color.

	If you drag the slider all the way to 0, the image will be black and white.




	□ Drag the Brightness slider to adjust the luminance of the image.

	The Brightness control also adjusts the contrast of the image, so adjusting this might make the image looked “washed out”—or lacking contrast. Adjust the Contrast slider to counteract this.




	□ Drag the Contrast slider to adjust the amount of contrast in the image.

	The contrast ratio is the difference between the lightest pixels and the darkest pixels within a shot.

	If there is very low contrast in an image, then the blacks or shadows in the image will be a light grey color, and the whites in your images will also dim down to be a grey color.

	If there is high contrast in an image, then the blacks or shadows in the image will be very dark. The whites will be very bright white.








[image: Figure 17.3 The result of adjusting the four sliders in the Controls tab.]
Figure 17.3 The result of adjusting the four sliders in the Controls tab.






To Disable Settings in the Controls or Hue Offsets Tab:


	□ Click on the green Controls switch to toggle all settings in that tab on or off.

	□ Click on the green Hue Offsets switch to toggle all settings in that tab on or off.

	□ Because we are going to focus on the Hue Offsets tab next, turn off the settings in the Control tab.








Hue Offsets Tab

In the Hue Offsets tab of the Color workspace, you’ll see three different sections. In this book, we will just focus on the first two sections of this tab. If you would like to learn more about the others, consider taking the MC239 course.

The first section of the Hue Offsets tab has three different color wheels. In the top left corner of each color wheel, you’ll see the following labels:

Shd - This color wheel will change the hue of the shadows in the image.

Mid - This color wheel will change the hue of the midtones in the image.


	Midtones are the colors that lie between your shadows and highlights.



Hlt - This color wheel will change the hue of the highlights in the image.


[image: Figure 17.4 The Shadow, Midtones, and Highlight color wheels in the Hue Offsets tab.]
Figure 17.4 The Shadow, Midtones, and Highlight color wheels in the Hue Offsets tab.



The middle section of the Hue Offsets tab has Gain, Gamma, and Setup sliders and Auto Correction tools. Here’s how they can all be used while color correcting your image:


[image: Figure 17.5 The second section in the Hue Offsets tab.]
Figure 17.5 The second section in the Hue Offsets tab.



Gain Slider - This slider adjusts the highlights in your image. As the slider moves up, the whites become brighter, but the shadows and midtones will stay the same.

Gamma Slider - This slider adjusts the midtones in your image. As the slider moves up, the middle levels become brighter, but the highlights and shadows will stay the same.

Setup Slider - This slider adjusts the shadows in your image. As the slider moves up, the blacks become brighter, but the highlights and midtones will stay the same.

[image: chpt_fig_245.jpg] Auto Balance Button - Balances the colors in the image and eliminates any color cast. This button will automatically adjust all three color wheels in the Hue Offsets tab.

[image: chpt_fig_246.jpg] Auto Black Button - Makes the darkest areas of the image as dark as possible.

[image: chpt_fig_247.jpg] Auto Contrast Button - Makes the brightest parts of the image as bright as possible, and the darkest parts of the image as dark as possible. Using this button is the same as using both the Auto White and Auto Black buttons.

[image: chpt_fig_248.jpg] Auto White Button - Makes the brightest areas of the image as bright as possible.


To apply color correction using the Hue Offsets tab:


	□ Drag the crosshair in the Shadows color wheel around.

	Notice that all of the shadows and dark parts of your image changes to the color where your crosshair is placed.




	□ Drag the crosshair in the Midtones color wheel around.

	Notice that all of the midtones (specifically the color of the rock climbers’ skin) of your image changes to the color where your crosshair is placed.




	□ Drag the crosshair in the Highlights color wheel around.

	Notice that all of the white and bright parts of your image changes to the color where your crosshair is placed.




	□ Adjust the Gain, Gamma, and Setup sliders up and down and notice the changes happening in the image.

	□ Press the Automatic Correction buttons and notice the changes happening in the image.






To delete a color correction effect from a segment in the Timeline:


	□ With the Overwrite segment mode arrow, click on the segment with the Color Correction applied and press delete on your keyboard.








Limitations of Automatic Color Correction

Automatic color correction is a useful tool to solve basic image problems very quickly. Like any fully automatic function, it won’t produce a perfect result in every situation.

The weakness of automatic color corrections is that the system cannot see what’s in the scene. It doesn’t see a landscape or faces; it can’t differentiate between foreground and background; it only knows that there is some white, yellow, blue, and so on. It will make assumptions about the colors in the frame—assumptions that may or may not be correct. Also, automatic corrections do not compare one shot to another.

Some problems you won’t be able to fix with automatic color correction:


Extreme light conditions: If a significant area of an image is deliberately overexposed or underexposed, automatic color corrections may misunderstand the intent and produce an undesired result.

Extreme color-balance problems: Automatic color corrections might not provide the expected result on images that show extreme white-balance issues or in mixed-lighting conditions where part of the image is white balanced while other parts of the image are not. A night club scene with deep and multi-colored lighting is a typical example.

Images lacking contrast: Automatic color corrections are effective only with images that have the appropriate content for calculating either white, black, or both, such as areas of strong highlight (white or close to white) and areas of strong shadow (black or close to black).






Color Correction Templates

If you have multiple segments with the same problem, you can create an effect template that you can reuse, using the Create FX Template button (Figure 17.6).

A visual effect, and in this case a color correct effect, is sometimes called VFX, or FX in post-production. As you’re reading the rest of this lesson, we will use FX in place of the word “effect”.


[image: Figure 17.6 The Create FX Template Button.]
Figure 17.6 The Create FX Template Button.




To Create FX Templates:


	□ In the same Rock Climbing sequence, park the position indicator on a Color Correction effect icon that you created previously in this lesson.

	The parameters in the Color Correction tool in the Color workspace will show the adjustments applied to that Color Correction effect.




	□ Click and drag the Create FX Template button from the Color Correction tool into an open bin.

	The color effect has now been saved.

	It’s best to create a bin for holding any FX templates that you create.






You can now apply the color effect while working in any workspace of Media Composer.




To Apply an FX Template to a Segment in the Timeline:


	□ From the bin, drag the effect icon onto the segment in the Timeline.

	To modify the parameters for any color effect, you can open the effect in the Effect Editor or return to the Color workspace.











Stylizing a Scene Using Color Correction Presets

After you have adjusted individual shots in the Timeline for correct color balance and exposure, then matched shots for consistency throughout the sequence, you might want to introduce a specific look to enhance the emotional impact of the scene. Media Composer has a large selection of Color Correction Presets that can quickly and easily stylize or colorize a group of shots.

While it is possible to apply the preset color effect to each segment in turn, it is much easier to apply it to an entire group of segments in one click. By doing this, you can try out different presets to see what they look like very easily.


To Apply a Color Correction Preset to a Group of Segments:


	□ With the Rock Climbing Sequence open, from the menu bar, select Timeline > New > Video Track.

	A new track will be created in the Timeline.




	□ To make sure you can see your work, switch the video track monitor to the highest track.

	□ Turn off all the record track selectors except for the highest video track.

	□ Park the position indicator on the first frame of the first interview segment in the sequence.

	□ Click the Add Edit button.

	Remember, an empty filler track works like a video segment. That means performing an Add Edit splits the filler into multiple filler segments.




	□ Add an Edit in the filler track to the last frame of the last interview segment.

	□ Open the Effect Palette and in the left column select the Color Correction Presets category.

	□ You want to adjust all the interview segments with one color correction preset. From the right column, click and drag the Dark Winter preset onto the filler in between the edits you made.

	To try a different preset, simply drag and drop the alternative effect onto the track. The new effect will replace the original.







[image: Figure 17.7 A Color Correction Preset applied to filler.]
Figure 17.7 A Color Correction Preset applied to filler.



You can use your saved effect templates on filler to correct multiple shots in the sequence. Instead of putting a preset onto the Timeline, just drag the effect template from the bin onto the filler track.






Lesson 17 Review & Discussion Questions


	What should be the three main goals when color correcting your sequence?

	Although there is a Color Correction effect in the Effect Palette, what is the best way to work with adjusting exposure and color balance of segments in the Timeline?

	Hue, Saturation, Luminance: What do each of these properties do, and why are they important to color correction?

	How do you change the view of the monitors in your Composer window when in the Color workspace?

	How do you disable settings in the Controls or Hue Offsets tab?

	How do you create a color correction template?

	True or False: A color correction effect can be placed on filler in the Timeline.

	How do you apply a color correction template that you’ve made to multiple segments?

	Automatic color correction is a great start, but when shouldn’t you use it on a clip?

	What is a Color Correction preset? What is it good for, and how do you use it?






EXERCISE 17

[image: chpt_fig_015.jpg] Color Correction

Project: Jacuzzi

Duration: 45 Minutes


GOAL


	Color correct Scene 7 of Jacuzzi






Goal: Color Correct Scene 7 of Jacuzzi

Picture Lock is the term commonly used to describe the stage in editing when all editorial decisions have been made and approved. The film is then handed over to the finishing processes such as on-line editing, color grading and audio mixing.

By this stage you will have completed editing Scene 7 of the Jacuzzi project, and it’s ready for picture lock. In this goal, color correct the scene so that it looks natural and finished.


	□ Open the Scene 7 Fine Cut sequence, duplicate it, and name is Jacuzzi_Scene 7_Locked Cut.

	○ The only thing you have left to do is color correction.

	○ When you play the sequence, it is obvious that there are exposure differences between the shots of the boys unloading the truck and Don and Ivan in the shade of the front porch of the house.




	□ Open the Color workspace and use the Hue Offsets window to adjust the luma levels so all shots fall within the maximum and minimum values.

	□ Use the Gamma slider to adjust the mid-tones of the shots of Don and Ivan so there is a better match with the shots of Leeroy and Moose.

	□ Adjust any other color correction parameters so that you feel the scene looks as great as possible.








File Due:


	□ Jacuzzi_Scene 7_Locked Cut











[image: chpt_fig_001.jpg] LESSON 18

Technical Fundamentals

In this lesson, you’ll learn the nitty gritty details of ingesting and media management. You’ll also get a few examples of structures to keep you as organized as possible.

Duration: 30 Minutes


GOALS


	Change media creation settings to match source footage

	Understand frame rate and frame size

	Find where Media Composer saves imported media files (MXF)

	Ingest audio as mono or stereo

	See a sample of proper media management workflow






Importing a Media File - Preparing for Import

Because the process of importing (as opposed to linking) makes a new copy of a media file and saves it in a folder determined by Media Composer, it is important that you specify what type of file you want to create and on what drive you want to save it.

For consistency, you typically only need to do this once at the beginning of a project, and then leave it alone. Set it and forget it.


To Set the Media Creation Settings:


	□ From the Menu bar, choose File > Settings

	The Settings window opens as shown in Figure 18.1

[image: Figure 18.1 The Settings window.]
Figure 18.1 The Settings window.







	□ From the top of the Settings window, select the Project tab.

	□ Double click the Media Creation option.

	The Media Creation window opens as shown in Figure 18.2




[image: Figure 18.2 The Media Creation window.]
Figure 18.2 The Media Creation window.




	□ Click in the “Video Resolution” drop down list to reveal all the available resolutions that you can use to create the copy of a media file.

	The video resolution determines which codec will be used to create the media.

	The process of reducing the file size is called compression or encoding and the process of recovering the video image from the compressed file is called decompression or decoding. The term ‘codec’ is a contraction of the two words enCOde and DECode. Codecs are designed to reduce the file size of video media while preserving as much of the image quality as possible.

	As you can see from the list shown in Figure 18.3, there are a lot of codecs to choose from.

[image: Figure 18.3 The Video Resolution drop-down menu.]
Figure 18.3 The Video Resolution drop-down menu.




	Choosing a video resolution (codec) can be a daunting task. For an editing application, the need to constantly decompress and recompress heavily compressed video files can take up a lot of computer resources and this can significantly impact on performance.

	Avid DNxHD or Apple ProRes are both codecs that produce excellent quality copies of video media files without taking up too much drive space. Because they are not heavily compressed, they are also easy for editing applications to process, especially when you are creating visual effects that combine multiple video files.




	□ To select the drive in which you want to save the copy of the media file, click the Target Drive drop-down menu.

[image: Figure 18.4 The Target Drive drop-down menu.]
Figure 18.4 The Target Drive drop-down menu.




	The drives listed here will be dependent on your computer system. Media Composer will list all drives that are suitable for saving media files. If you have any external drives connected to your computer, those will show up in the list as well. Select the drive that works for you. It is always preferable to store media files on a drive other than the drive in which the operating system and applications reside.




	□ Click OK.

	The Media Creation dialog box will close.




	□ Close the Settings window by clicking on the red X at the top of the window.








Frame Size and Frame Rate

Cameras often allow you to change settings so you can record your video at different frame sizes and frame rates.

The frame size is the physical dimension of each video frame, and usually is expressed by “width x height” of the frame in pixels.

The frame rate is how many video frames make up one second and is expressed as ‘frames per second’ (FPS).

It is generally the best idea to import media files as the same frame size and frame rate as the original footage.

When you are working with material that you have filmed yourself, you should know the frame size and frame rate of your camera at the time of filming. However, that is not always the case, especially when you are working with footage shot by someone else.

Before importing media files, it is advisable to check to see what those settings were. Fortunately, that information is imbedded in the media files themselves.


To Check the Frame Rate and Frame Size of Footage:


	□ Using your computer’s operating system, open the folder that contains the footage.

	You are not doing this step in Media Composer.




	□ Select any one of the media files and open it in a media player (such as QuickTime or VLC Player).

	QuickTime Player can display information about the media file in a window called the Inspector, as shown in Figure 18.5.

	When working in VLC Media Player, in the menu bar go to Tools > Codec Information.




	□ In the Figure 18.5, the frame size is shown to be 1920 x 1080 and the frame rate is 59.94 frames per second. It also tells you the original files were encoded using the H.264 codec.

[image: Figure 18.5 The Inspector in QuickTime Player (left) and Codec information in VLC Media Player (right)]
Figure 18.5 The Inspector in QuickTime Player (left) and Codec information in VLC Media Player (right)




	Now that you know the settings of your original media files, you are now ready to import. Let’s practice using the Ski Field Footage.




	□ In Media Composer, reopen the Source Browser and, in the Navigation pane, select the Ski Field_Footage folder.

	□ From the File/Folder Contents pane, select one of the media files.

	□ At the bottom left of the Source Browser, select the Import button.

	If this is the first time you have imported video media into a project, Media Composer will ask you what frame size and frame rate you want to apply to the media files it will create, and the Project Properties dialog box will open.

[image: Figure 18.6 The Project Properties dialog box.]
Figure 18.6 The Project Properties dialog box.




	The Project Properties dialog box allows you to select the frame size (called Raster in Media Composer) and the frame rate (called Edit Rate) for the project.




	□ Open the Raster drop-down menu and choose the option that matches the frame size of the footage. In this case, choose HD 1080.


[image: Figure 18.7 The Raster drop-down menu.]
Figure 18.7 The Raster drop-down menu.




	□ Open the Edit Rate dropdown menu and choose the frame rate of the footage: 25 fps.

[image: Figure 18.8 The Edit Rate drop-down menu.]
Figure 18.8 The Edit Rate drop-down menu.




	□ Click OK.

	□ At the bottom right corner of the Source Browser, use the Target Bin selection menu to choose the Clips bin.






To Import the Selected Media File:


	□ At the bottom right corner of the Source Browser click the Import button.

	□ Drag and drop the media file from the File/Folder Contents pane to the desired bin (in this case, the Clips bin).

	If there is a difference between the video resolution of the original media file and the video resolution you set earlier in preparing to import a media file, an alert appears as shown in Figure 18.9.

[image: Figure 18.9 The Import Resolution Conflict window]
Figure 18.9 The Import Resolution Conflict window




	This window only opens if the resolution of the original file is also listed in the Media Creation drop list.

	If the resolution of the original file is not listed in the Media Creation setting then the window will not open and the import will continue uninterrupted, using the resolution you set in Media Creation.




[image: Figure 18.10 The [file directory] cannot be imported message.]
Figure 18.10 The [file directory] cannot be imported message.




	□ When you click OK, the system offers you a message to link and consolidate/transcode the media (using the Media Creation settings) as shown in figure 18.10. Click Yes to proceed with the import.

[image: Figure 18.11 The Import progress bar]
Figure 18.11 The Import progress bar






When the import is complete, the target bin will now contain a clip for the imported media file. Notice in Figure 18.12 that the video clip icon is similar to that of a linked clip, but the icon lacks the 2 links of a chain on the right side.

This tells you that the project has imported the media file, not linked to it. And like a linked file, the imported clip has the same name of the source media file.


[image: Figure 18.12 An imported clip vs a linked clip]
Figure 18.12 An imported clip vs a linked clip








Where Does Media Composer Save the Media?

You’ve learned that linked clips refer to the original media file wherever it is located, but where has an imported media file been saved? You selected a drive in the Media Creation setting, but it may not be obvious exactly where on that drive the file has been saved.

When you import, Media Composer creates an Avid MediaFiles folder on the drive selected. In that folder is an MXF folder that contains numbered folders. Any imported media files are saved within those folders.


	On a Windows OS the MXF folder is found in the following location: drive:\Users\Public\Documents\Avid Media Composer\Avid MediaFiles\MXF

	On a Mac OS the MXF folder is found in the following location:

	Users/Shared/AvidMediaComposer/Avid MediaFiles/MXF




To Locate Media Files:

If you are looking for the media file of a specific clip in your project, Media Composer also provides a tool that will locate the file for you.


	□ Select a clip icon in the bin and from the Fast menu choose Reveal File.

	□ An Explorer/Finder window will open and shows the file path and the media file(s) associated with the clip.




[image: Figure 18.13 the Finder window that opens after using the Reveal File command]
Figure 18.13 the Finder window that opens after using the Reveal File command








Importing vs. Linking Using Drag and Drop

You can ingest media to your project by dragging media files directly from an OS window to a bin. The default behavior is to import them, but you can use a modifier key to link the clips instead.


To Import Media Files Using Drag and Drop:


	□ Drag the files from the OS window to an open bin.

	If you plan to import media using drag-and-drop, it is best to check your Media Creation settings first, since the files will be imported using the current settings.









To Link to Media Files Using Drag and Drop:


	□ Hold the Alt key (Windows) or Option key (Mac) and then drag the files from the OS window to an open bin.








Ingesting Audio Media - Mono vs. Stereo

Like video media, you can link and import audio media. As you have seen, video media often has audio attached while music and sound effects will only consist of audio files.

There is one further consideration when ingesting audio into a project. How many channels of audio does the media file contain and how should they be handled?

A single audio channel, like a voice recording, is referred to as monoaural, or mono for short.

A stereo recording, like music or sound effects, is often comprised of two channels - one for the left speaker and one for the right.

A video recording is typically accompanied by two channels of audio. Does that make it a stereo recording or two mono recordings? Actually, it could be either. Many video cameras are equipped with a stereo microphone that uses the two channels to record the left and right audio signals. But it is equally possible that those two channels could both be used to record separate mono sources. For instance, two separate microphones could be used to pick up the voices of two actors, or an interviewer and interviewee.

When considering how to ingest audio, it is worthwhile deciding whether the two channels carry paired sound, as in stereo music, or do they carry independent sound, as in two mono recordings of two actors.

You have the option of ingesting two channels of audio as either a clip with one stereo track or as a clip with two mono tracks.


Importing Audio as a Single Stereo Track:


	□ Select the Music bin in the Bins pane.

	□ Open the Source Browser and search through the Navigation pane to locate and select the Music folder.

	□ In the File/Folder Contents pane select the Input-NEW020101_Techno.mp3 music track.

	□ In the Source Browser select the Import button and click the small gear icon (as shown in Figure 18.14) to open the Import Settings Window.

[image: Figure 18.14 The Import Settings button.]
Figure 18.14 The Import Settings button.




	□ In the Import Settings dialog box, select the Audio tab.

	□ In the Multichannel Audio pane, click the Edit… button.

	The Set Multichannel Audio window will open.

[image: Figure 18.15 Set Multichannel Audio window.]
Figure 18.15 Set Multichannel Audio window.







	□ Click the Format button, located under the A1 and A2 track indicators. The button will turn green showing that audio channels 1 and 2 from the source media file will be combined into a single stereo track clip in the imported clip, as shown in Figure 18.16.

[image: Figure 18.16 When Imported, the two audio channels will be brought it as a single stereo track.]
Figure 18.16 When Imported, the two audio channels will be brought it as a single stereo track.




	□ Click OK

	The Set Multichannel Audio window will close.

	The Import Settings window will now show Stereo: A1A2 in the Multichannel Audio pane, as shown in Figure 18.17.

[image: Figure 18.17 Stereo track configuration.]
Figure 18.17 Stereo track configuration.







	□ Click OK to close the Import Settings window.

	As with video media, files can either be dragged from the Source Browser to the desired Bin, or by clicking the Import button at the bottom right of the dialog box (after selecting the appropriate Target Bin, which in this case is the Music bin).




	□ After the music track has been imported, close the Source Browser.

	□ In the Music bin, double click the icon of the newly imported music clip. The clip opens in the Source monitor. (You can also drag the clip icon from the bin into the Source monitor.)

	In the Timeline, the Track Selector panel displays only one track for the clip, as shown in Figure 18.18. But the track selector shows two overlapping speaker icons in the bottom right corner, indicating this is a stereo track. A1 has both left and right channels combined in a single audio track.




[image: Figure 18.18 Stereo track icon in the Track Selector panel.]
Figure 18.18 Stereo track icon in the Track Selector panel.









Importing Audio as Two Mono Tracks:


	□ Open the Source Browser and select the Import button.

	□ Click the small gear icon next to the Import button.

	□ When the Import Settings window opens, select the Audio tab.

	□ Click the Edit… button and turn off the green Format button for A1 & A2 by clicking it, or by clicking on the right side of the format button and choosing Mono.

	□ Click OK.

	Figure 18.19 shows the Multichannel Audio pane now has the word None displayed in it. This means the audio will be imported as two independent mono tracks.

[image: Figure 18.19 The Audio tab with a mono configuration.]
Figure 18.19 The Audio tab with a mono configuration.







	□ Click OK

	□ In the Source Browser, make sure the Music bin is selected as the Target Bin.

	□ Click the Import button at bottom right.

	After the music clip has been imported, close the Source Browser and double click the icon for the music clip in the bin. The clip opens in the Source monitor. Look in the Timeline and see how the audio Track Selector panel is displayed (Figure 18.20). The music clip has been split into two separate mono tracks with a single small speaker icon in the bottom right corner of each track selector, indicating they are mono tracks.

[image: Figure 18.20 Mono Track Selector panel.]
Figure 18.20 Mono Track Selector panel.














Linking Audio as Mono or Stereo Tracks

Audio can also be linked to create clips with either mono or stereo tracks. This process is not the same, but very similar, to the steps you followed above.


Linking Audio as a Single Stereo track:


	□ Open the Source Browser and select the Link button.

	□ Click the small gear to the right of the Import button and this time the Link Settings window will open, as shown in Figure 18.21.

[image: Figure 18.21 Link Settings]
Figure 18.21 Link Settings




	□ Use the Edit. button in the Multichannel Audio pane to set linked audio as either mono or stereo tracks.

	□ Click OK

	□ Click the Link button at bottom right of the Source Browser dialog box

	A clip that is linked to the music file will be created in the targeted bin. As with imported media, the track selector in the Timeline will display either two mono tracks or a single stereo track.











Ingesting from Camera Cards

So far, to help you get familiar with using the Source Browser to input media, the media files have been relatively easy to find - a folder with media files inside. But most cameras save media files within a complex folder and file structure that can make locating media files difficult. And some cameras create folder and file structures unique to their own cameras. If you’ve ever seen an AVCHD or BPAV file, you know what this is about.

Figure 18.22 shows the folder structure of the Canon C100 camera, as shown in the Navigation pane. As shown, the camera has multiple folders inside folders - with the root folder labeled as AVCHD. Believe it or not, inside those folders are the clips from the camera. To help you locate media files, the Source Browser has a feature that can search files for you.


[image: Figure 18.22 Cannon C100 camera folder structure and the folders inside of the AVCHD file.]
Figure 18.22 Cannon C100 camera folder structure and the folders inside of the AVCHD file.




To View Complex Structures on a Camera Card as Clips in the Source Browser:


	□ With the top-level folder selected in the Navigation pane, click the Media Folder View button (Figure 18.23)

[image: Figure 18.23 The Media Folder View Button]
Figure 18.23 The Media Folder View Button




	The Source Browser finds all the media files contained inside them and displays them as clips, as seen in Figure 18.24.

	All the sub-folders disappear from the Navigation pane and the media files are now displayed in the File/Folder Contents pane.








[image: Figure 18.24 With the Media Folder View button activated, the Canon C100 AVCHD Folder is now displayed as clips.]
Figure 18.24 With the Media Folder View button activated, the Canon C100 AVCHD Folder is now displayed as clips.








Media Management

The difference between a clip and a media file is important to understand.

A clip is just a small bit of data, or metadata, relating to a linked or imported media file and in particular the location of that media file. A clip is saved within a Media Composer project.

The media file is the actual pictures and sound you work with when editing. When you open and play a clip from a bin, Media Composer locates the media file and shows it to you in the Composer window. A media file is saved on a hard drive.

If Media Composer cannot locate a video file referred by a clip, the Source monitor will display the Media Offline message, as shown in Figure 18.25. Audio-only clips, such as music, do not display the Media Offline message if their corresponding media files cannot be located.


[image: Figure 18.25 Media Offline message is displayed when video media cannot be located.]
Figure 18.25 Media Offline message is displayed when video media cannot be located.




Troubleshooting Offline Media:

If your media is offline, look to see if:


	The hard drive or memory card is disconnected from the computer or not turned on.

	The media files have been moved from the location that they were in when the clip was created.

	The media files have been deleted.

	The media files have been corrupted.

	The media file name has been changed after the clip has been created.








Managing Clips and Bins in a Project

On small projects it may seem unnecessary to save your clips in multiple bins, but it is often surprising how quickly projects can grow in size as you work on them. It is always good practice to start by having at least a bin for sequences and a bin for clips.

The need for additional bins will become apparent as your work on a project progresses. For instance, you might decide that you want to create separate bins for clips related to specific scenes in your film, a bin for music, another for sound effects, and so on.

Clips can easily be dragged between bins or copied and duplicated from one bin to another. You can also change the names of clips in bins to better describe the shot.

In studios and broadcast news stations with a team of editors, there are strict rules about how to name bins and clips. For a professional assistant editor, project organization is a big part of the job. Clear organization makes it easier for everyone to work on a project together, and in the professional world, working together is more common than working alone. It is essential to develop good organizational habits early on by clearly naming bins and keeping clips well-organized within them.




Managing Media Files

Media files are a critical asset in any project. Like anything important, you should take the appropriate measures to protect them.

It is never smart to work with the original media files that are still saved on the device that recorded them (like an SD card). If the device is needed for another job and disconnected from the computer, or the device fails, or the files are corrupted then you have lost your assets and consequently the project is lost.

In this unfortunate scenario, media referred to by your clips will go offline.

The smart way to ingest is listed in the sample workflow below. This is not a rule, just a suggestion to managing your media properly.


A Sample Workflow for Media Ingest:


	□ Insert your SD card into your computer.

	□ Create folders on your computer or an external hard drive to put your footage into.

	A sample folder structure is pictured in Figure 18.26.




	□ Copy over your footage files into the folder you created.

	□ On a separate hard drive, backup your files by copying them over to a “Backup” folder.

	□ Eject the SD Card.

	□ Import or Link your files into Media Composer.




[image: Figure 18.26 A sample folder structure for a Documentary called “Shelter.”]
Figure 18.26 A sample folder structure for a Documentary called “Shelter.”








Lesson 18 Review & Discussion Questions


	What is the difference between Linking and Importing?

	True or false: When linking media, you can remove the original source drive or camera card containing the media and your media will remain online.

	When dragging media files from the computer or hard drive to a Media Composer bin, to link to the files (rather than import them), which modifier key must you press?

	What is the difference between mono and stereo audio tracks? What would be the benefit of using one over the other?

	How would I import music as stereo tracks?

	In the Timeline, how do I check to see if a track is stereo or mono?

	What are the steps to check the frame rate and frame size of your footage, before importing or linking into Media Composer?

	If your media is offline, what are some of the problems should you look for?

	Describe the difference between the icon for a linked clip and an imported clip.

	Why is it important to back up your original source media files?
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